User Guide for
Cisco Unified MeetingPlace
Web Conferencing
Release 6.1
The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as part of UCB’s public domain version of the UNIX operating system. All rights reserved. Copyright © 1981, Regents of the University of California.

Notwithstanding any other warranty herein, all document files and software of these suppliers are provided “as is” with all faults. Cisco and the above-named suppliers disclaim all warranties, expressed or implied, including, without limitation, those of merchantability, fitness for a particular purpose and noninfringement or arising from a course of dealing, usage, or trade practice.

In no event shall Cisco or its suppliers be liable for any indirect, special, consequential, or incidental damages, including, without limitation, lost profits or loss or damage to data arising out of the use or inability to use this manual, even if Cisco or its suppliers have been advised of the possibility of such damages.

Cisco and the Cisco Logo are trademarks of Cisco Systems, Inc. and/or its affiliates in the U.S. and other countries. A listing of Cisco's trademarks can be found at www.cisco.com/go/trademarks. Third party trademarks mentioned are the property of their respective owners. The use of the word partner does not imply a partnership relationship between Cisco and any other company. (1005R)

Any Internet Protocol (IP) addresses and phone numbers used in this document are not intended to be actual addresses and phone numbers. Any examples, command display output, network topology diagrams, and other figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses or phone numbers in illustrative content is unintentional and coincidental.

User Guide for Cisco Unified MeetingPlace Web Conferencing Release 6.1
© 2011 Cisco Systems, Inc. All rights reserved.
# Welcome to Cisco Unified MeetingPlace Web Conferencing

1. **About the Browser Test**
   - Running the Browser Test

2. **About Signing In**
   - Signing In as a Profile User
   - Signing In as a Guest User

3. **About the Cisco Unified MeetingPlace Web Conferencing Home Page**

4. **About Scheduling Meetings**
   - Scheduling Parameters
   - Scheduling Audio Plus Web Meetings
   - Scheduling Video Meetings
   - Scheduling Conference Room-Only Meetings
   - Scheduling Recurring Meetings
   - Scheduling and Attending Immediate Meetings
   - Scheduling Meetings on Behalf of Other Users
   - Scheduling Multiserver Meetings
   - Escalating Meetings from an Internal to an External Server
   - Setting Cisco Unified MeetingPlace Web Conferencing to Allow Guest Access
   - Rescheduling Meetings
   - Updating Multiserver Meetings
   - Deleting Meetings
   - Deleting Multiserver Meetings
   - Copying Meetings

5. **Accessing Cisco WebEx User Documentation**

6. **About Reservationless Meetings**
   - Initiating Reservationless Meetings

7. **About Inviting People to Meetings**
   - Inviting Profile Users or Guests

8. **About Attachments and Recordings**
   - Adding Attachments to Meetings from the Meeting Scheduling Pages
   - Recording Meeting Comments
   - Accessing Attachments from the Meeting Scheduling Pages
   - Accessing Attachments from the Meeting Console
   - Recording Cisco WebEx Meetings
Retrieving Recordings 26
  Retrieving a Recording of a Cisco Unified MeetingPlace Meeting 26
  Retrieving a Recording of a Cisco WebEx Meeting 27

About Meeting Templates 27
  Information Preserved in a Template 28
  Creating a Template 28
  Modifying a Template 29
  Saving a Past Meeting as a Template 30

About the Find Meetings Tab 30
  Find Meetings Parameters 30
  Finding Meetings 31

About Attending Meetings 31
  Attending Meetings from the Web 32
    Attending a Cisco Unified MeetingPlace Meeting from the Web 1-32
    Attending a Cisco WebEx Meeting from the Web 1-33
  Attending Meetings from the Click-to-Attend Link 34
    Attending a Cisco Unified MeetingPlace Meeting from the Click-to-Attend Link 1-34
    Attending a Cisco WebEx Meeting from the Click-to-Attend Link 1-34
  Tips for Attending Webinar Meetings 35
  Attending Multiserver Meetings 35
  Attending Reservationless Meetings 35
  Attending Meetings as a Guest User 36
  Attending Cisco WebEx Meetings 37

About the Meeting Console 37
  Inside the Meeting Console 38
  Meeting Console Tools 38
  Controlling Your Audio and Video in the Meeting Console 39
    Dialing Out to Your Phone or Video Endpoint from the Meeting Console 1-39
    Muting or Unmuting Your Audio 1-39
    Pausing or Restarting Your Video Transmission 1-40
    Changing Your Video Layout 1-40
    Moving to or from an Audio Breakout Room 1-41
  Tips on Viewing Shared Content in the Meeting Console 41
  Meeting Console Layout Controls for Moderators 42

About Meeting Permissions 42
  Changing Audio Permissions for Participants 43
  Changing Meeting Console Permissions for Participants 43

About Menus in the Meeting Console 44
  Using the Meeting Menu 44
Recording Meetings from the Meeting Console 1-45
Setting the Meeting Extension Announcement from the Meeting Console 1-46
Changing Meeting Announcements 1-46
Locking and Unlocking Meetings 1-47
Ending Meetings 1-47
Changing the Room Background 1-47
Leaving Meetings 1-48
Using the View Menu 48
Using the Layouts Menu 49
Using the Tools Menu 49
Using the Help Menu 50

Working with Tools 50
Showing or Hiding a Tool 50
Adding a Tool 51
Moving or Resizing a Tool 51
Renaming or Deleting a Tool 51

About the Share Tool 52
Presenting and Working with Shared Content 52
Sharing Your Screen 53
  Best Practices for Screen Sharing 1-53
  Sharing Your Computer Screen 1-53
  Sharing Control of Your Screen with Another Presenter 1-54
  Requesting Control of a Shared Screen 1-54
  Previewing Your Shared Screen 1-55
Sharing a Document 55
  Types of Documents that Can Be Shared in the Share Tool 1-56
  Sharing a Document from the Meeting Attachments 1-56
  Sharing a Document from Your Computer 1-56
  Turning Off Display Synchronization for Multiframe Documents 1-57
Sharing a Presentation 57
  Using the Presentation Outline Tab 1-58
  Viewing Presentation Slide Notes 1-58
  Searching for Text in a Presentation 1-59
  Presentation Playbar Options 1-59
Sharing a Whiteboard 60
  Creating a Stand-Alone Whiteboard in a Blank Share Tool 1-60
  Adding an Overlay Whiteboard Over a Document or a Shared Screen in a Share Tool 1-60
  Displaying an Existing Whiteboard 1-61
  Clearing a Whiteboard 1-61
  Navigating Between Multiple Whiteboard Pages 1-61
Whiteboard Drawing Tools  1-62

About the Participant List Tool  63
   Attendance Icons in the Participant List  64
   Viewing or Changing Meeting Console Permissions  64
   Dialing Out to Meeting Participants  65
   Audio Breakout Rooms  66
      Moving to or from an Audio Breakout Room (Audience and Presenters)  1-67
      Moving Participants to or from an Audio Breakout Room (Moderators Only)  1-67
   Muting Audio for Participants  67
   Muting Audio for All Participants from the Meeting Console  68
   Placing Participants in the Waiting Room  68
   Merging Two Listings for the Same Participant  69
   Changing Enhanced Rights for Participants  69
   Renaming a Participant  69
   Removing Participants from a Meeting  70
   Changing Participant Status  70
   Displaying Connection Status Indicators  71

About the Chat Tool  71
   Sending a Chat Message  72
   Disabling Private Chat Between Participants (Moderator Only)  72
   Clearing Messages from a Chat Tool  72
   Disabling Chat Notifications  73
   E-Mailing the Chat History  73

About the Note Tool  74
   Creating a Note Tool  74
   Adding a Note to a Note Tool  74
   Creating Multiple Notes in a Note Tool  75
   Editing a Note  75
   Renaming a Note  76
   Deleting a Note  76
   E-Mailing the Contents of a Note Tool  76

About the Poll Tool  77
   Creating a Poll Question  77
   Editing an Existing Poll Question  78
   Selecting a Format for Poll Results  78
   Revealing Results for Polls  79
   Clearing Poll Results  79

About the File Share Tool  79
   Uploading Files to the File Share Tool  80
Welcome to Cisco Unified MeetingPlace Web Conferencing

Published: March 23, 2011

Cisco Unified MeetingPlace—part of the Cisco Unified Communications family of products—is an enterprise-class, rich-media conferencing solution that makes remote meetings as natural and effective as face-to-face meetings. The solution integrates voice, video, and web conferencing with industry-leading setup and control capabilities to meet the needs of organizations looking for a single solution and user environment for all of their conferencing needs. Cisco Unified MeetingPlace Web Conferencing is a core component of the Cisco Unified MeetingPlace solution, and it enables users to share rich content; view participants; manage, record and playback meetings; and easily set up and attend conferences. Depending on system configuration, you might have the option to set up and attend a conference using Cisco WebEx conferencing application.

About the Browser Test

The browser test performs a series of checks to verify whether you can join a web meeting by using your web browser. The browser test also checks your network connection speed and determines whether or not you have installed the Cisco Unified MeetingPlace Add-In, which you need if you want to share content on your computer with other participants.

If this is your first time using Cisco Unified MeetingPlace Web Conferencing, we recommend that you run the browser test.

Note

You do not need to run the browser test to join a Cisco WebEx meeting.

This section contains the following information:

Running the Browser Test, page 1

Running the Browser Test

The browser test only verifies whether you will be able to attend a Cisco Unified MeetingPlace meeting. It does not verify if you will be able to attend a Cisco WebEx meeting.
To Run the Browser Test
Confirm with your Cisco Unified MeetingPlace administrator that your browser version and operating system is supported.

Step 1 Open the web browser and enter the Cisco Unified MeetingPlace Web Conferencing URL in the address field.

Step 2 Press Enter.

Step 3 On the home page, click Run Browser Test.

Step 4 On the Browser Test page, click Start.

Step 5 If Cisco Unified MeetingPlace prompts you to download the correct version of the Adobe Flash Player, follow the displayed instructions.

Step 6 If you see a Download the Add-in button, install the add-in:
   a. Click Download the Add-in.
   b. Click Next.
   c. Click Install.
   d. Click Finish.

You must install the add-in if you plan to share content from your computer during a Cisco Unified MeetingPlace meeting. If you plan to share content from your computer during a Cisco WebEx meeting, you do not have to install the Add-in. To share content during a Cisco WebEx meeting, follow the onscreen instructions in the Cisco WebEx meeting room or see the Cisco WebEx online help. We recommend installing it even if you do not plan to share content from your computer, because it allows you to see notifications when you are viewing shared content full screen.

Step 7 When the test is complete the Show Details button is displayed, click X on the right corner of your browser Window to exit.

About Signing In

If you have a Cisco Unified MeetingPlace profile, sign in by using your user ID and password. This allows you to access the full range of features. If you are using a shared system, you can always choose to sign out after completing your Web Conferencing session if you have any security concerns.

This section contains the following information:
- Signing In as a Profile User, page 2
- Signing In as a Guest User, page 3

Signing In as a Profile User

To Sign In as a Profile User

Step 1 Open your web browser and enter the Cisco Unified MeetingPlace Web Conferencing URL in the address field.

Step 2 Press Enter.
Welcome to Cisco Unified MeetingPlace Web Conferencing

About the Cisco Unified MeetingPlace Web Conferencing Home Page

Step 3  On the Welcome page, click **Sign In**.

Step 4  On the Sign In page, enter your Cisco Unified MeetingPlace user ID and password. Check the **Remember Me** check box to store your sign-in information for future sessions.

Note  Cisco Unified MeetingPlace Web Conferencing does not permit blank passwords, and values are case sensitive.

Step 5  Click **Sign In Now**.

Signing In as a Guest User

Guest users do not have profiles on the Cisco Unified MeetingPlace system. As a guest user, you can attend specific meetings or browse through a list of *public meetings* after you have registered. However, you cannot schedule meetings.

To Sign In as a Guest User

Step 1  Open your web browser and enter the Cisco Unified MeetingPlace Web Conferencing URL in the address field.

Step 2  Press **Enter**.

Step 3  On the Welcome page, click **Attend Meeting**.

Step 4  On the Attend Meeting Sign In page, enter your name in the Guest Name field.

Step 5  If you know the ID of the meeting that you are attending, enter it in the field provided.

Step 6  Click **Find Meeting**.

About the Cisco Unified MeetingPlace Web Conferencing Home Page

The home page is your entry to the Cisco Unified MeetingPlace Web Conferencing features. If you are a profile user, you sign in by clicking **Sign In**.

From the home page you can do the following tasks:

- **Attend Meeting**: Allows you to quickly join a specific meeting after entering its meeting ID. Clicking the Attend Meeting tab automatically brings you to the Attend Meeting page where you can sign in as a profile user or as a guest. (See also the “About Attending Meetings” section on page 31.)

- **Schedule Meeting**: Allows you to specify meeting parameters on the New Meeting page to schedule a future meeting. (See also the “About Scheduling Meetings” section on page 4.)
About Scheduling Meetings

Clicking the Schedule Meeting tab opens the New Meeting scheduling form, which includes all of the basic scheduling parameters for your meeting.

Only users who have signed in by using their Cisco Unified MeetingPlace user ID and password can schedule meetings.

Note
Depending on your user profile settings, you might have the option to choose Cisco WebEx as the conference provider. See Accessing Cisco WebEx User Documentation, page 20.

- Find Meeting: Allows you to search on the Today’s Meetings page for past, future, or current meetings. (See also the “Finding Meetings” section on page 31.)
- Immediate Meeting: Allows you to schedule and attend an immediate meeting. The meeting is automatically scheduled using parameters from the user profile of the scheduler; other than the meeting ID, you cannot specify your own meeting parameters using this scheduling method. (See also the “Scheduling and Attending Immediate Meetings” section on page 13.)

Note
Immediate meetings use Cisco Unified MeetingPlace as the Web conference provider. You cannot select Cisco WebEx as the conference provider for an immediate meeting.

- My Templates: Allows you to create and manage templates that you can use to determine meeting format, layouts, and other settings when creating new meetings. (See also the “About Meeting Templates” section on page 27.)

Note
Depending on your user profile settings, if you select Cisco WebEx as the Web conference provider, you might have the option to select either the Meeting Center or the Sales Center templates.

- Install Cisco Unified Presenter Add-In: Allows you to install an add-in on your computer that lets you share a screen or an application from your desktop. (See also the “Presenting and Working with Shared Content” section on page 52.)

Note
You do not have to install the Cisco Unified Presenter Add-In to share a screen or application during a Cisco WebEx meeting.

- Run Browser Test: Performs a series of checks to verify whether you will be able to join a web meeting by using your web browser. (See also the “About the Browser Test” section on page 1.)

Note
You do not have to run the browser test to attend or schedule a Cisco WebEx meeting.

- My WebEx: After you click this link, you are logged in to the Cisco WebEx portal. You can browse a list of meetings, host a meeting, view or download user documentation and perform other tasks.

Related Topic
This section contains the following information:

- Scheduling Parameters, page 5
- Scheduling Audio Plus Web Meetings, page 8
- Scheduling Video Meetings, page 9
- Scheduling Conference Room-Only Meetings, page 11
- Scheduling Recurring Meetings, page 12
- Scheduling and Attending Immediate Meetings, page 13
- Scheduling Meetings on Behalf of Other Users, page 14
- Scheduling Multiserver Meetings, page 14
- Escalating Meetings from an Internal to an External Server, page 15
- Setting Cisco Unified MeetingPlace Web Conferencing to Allow Guest Access, page 16
- Rescheduling Meetings, page 17
- Updating Multiserver Meetings, page 17
- Deleting Meetings, page 18
- Deleting Multiserver Meetings, page 19
- Copying Meetings, page 19
- Accessing Cisco WebEx User Documentation, page 20

### Scheduling Parameters

Only users who sign in by using their Cisco Unified MeetingPlace profiles can schedule meetings, view a list of meetings, and access system features unavailable to guests.

This section contains three tables that describe the parameters for different types of meetings:

- Parameters That Apply to All Meetings
- Parameters That Apply to Audio Plus Web Meetings
- Parameters That Apply to Video Meetings

**Table 1** describes the parameters that apply to all types of meetings that you schedule by using Cisco Unified MeetingPlace web scheduling, including parameters for meetings that use Cisco WebEx as the conference provider.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject</td>
<td>Enter the subject for your meeting. If no subject is specified, the meeting scheduler’s last name will populate the subject field in meeting confirmation pages.</td>
</tr>
<tr>
<td>Meeting ID</td>
<td>The meeting ID allows the system to uniquely identify a meeting that is occurring at any particular time. The system can automatically assign meeting IDs, or you can assign custom or <em>vanity IDs</em>.</td>
</tr>
<tr>
<td>Note</td>
<td>System administrators can set the Allow Vanity ID parameter to No on the Cisco Unified MeetingPlace Audio Server. If this is the case, you cannot assign vanity IDs when scheduling your meetings.</td>
</tr>
<tr>
<td>Date</td>
<td>The date of your meeting.</td>
</tr>
</tbody>
</table>
Table 1  Parameters That Apply to All Meetings (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recurrence</td>
<td>Click to schedule a recurring meeting. You specify whether the meeting will be held Once, Daily, Bi-Weekly, Weekly, Monthly By Date, Monthly By Day of Week, and Weekdays, and the number of times that you want the recurring meeting to occur.</td>
</tr>
<tr>
<td>Time</td>
<td>The time you want your meeting to start. This is based on your time zone setting.</td>
</tr>
<tr>
<td>Duration</td>
<td>The duration of your meeting in minutes.</td>
</tr>
<tr>
<td>Meeting Template</td>
<td>If your system is configured to use Cisco Unified MeetingPlace, choose a template from the list - Collaborative, Presentation, or Webinar, or a user-defined template. If your system is enabled for Cisco WebEx, the MeetingCenter template is the default template, although this may vary if your system is enabled for Sales Center.</td>
</tr>
<tr>
<td>On Behalf of User</td>
<td>(Optional) The user ID of the person for whom you are scheduling a meeting. This field is available only to users with Attendant or System Manager privileges.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>The time zone for the meeting. You might change the time zone, for example, if you are scheduling a meeting on behalf of another user in a different time zone. This field is available only to users with Attendant or System Manager privileges.</td>
</tr>
<tr>
<td>Password</td>
<td>If you choose to protect a meeting with a password, enter the required password. All invitees must enter this password in order to access your meeting. If you do not require password protection, leave this field blank. Users who dial in to the meeting are prompted to enter the password. Passwords are included on meeting e-mail notifications.</td>
</tr>
<tr>
<td>Billing Code</td>
<td>If your company uses bill-backs, this field contains the number that is used to identify the group or department that should be billed for this meeting.</td>
</tr>
<tr>
<td>Meeting Category</td>
<td>Choose your meeting category from the list of available meeting categories.</td>
</tr>
</tbody>
</table>
| Allow External Web Participants | • If this meeting needs to be available on an external web server, click Yes. External web servers are located outside your organization’s firewall and allow users who are also outside your organization’s firewall to access this meeting. Examples of meetings that may require an external web server include sales meetings with clients or demos to outside organizations.  
  • If this meeting will be attended only by people inside your firewall, click No. This includes remote users accessing your organization’s network through a VPN. Because all of your participants can access your organization’s network, this meeting will be scheduled on an internal web server.  
  Note This parameter is displayed only if your Web conference provider is Cisco Unified MeetingPlace. All Cisco WebEx meetings allow external web participants. |
| Account                    | Optional: This field is only visible if your system is enabled for Cisco WebEx, you choose Cisco WebEx as the Web Conference Provider and you choose Sales Center as the meeting template. Account information is used for conference billing purposes. |
| Opportunity                | Optional: This field is only visible if your system is enabled for Cisco WebEx, you choose Cisco WebEx as the Web Conference Provider and you choose Sales Center as the meeting template. Opportunity information is used for conference billing purposes. |
| Select Account             | Optional: This link is only visible if your system is enabled for Cisco WebEx, you choose Cisco WebEx as the Web Conference Provider and you choose Sales Center as the meeting template. Click to create or select an account. The first time that you schedule a Cisco WebEx Sales Center meeting, you must create at least one account. An account consists of an account name and a parent account name. |
| Select Opportunity         | Optional: This link is only visible if your system is enabled for Cisco WebEx, you choose Cisco WebEx as the Web Conference Provider and you choose Sales Center as the meeting template. Click to create or select an opportunity. You must create an account before you can create or select an opportunity. |
**Table 1  Parameters That Apply to All Meetings (continued)**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Invitee or Team</td>
<td>For each user that you want to invite to this meeting, enter the name or e-mail address of the user. As you enter characters in the field, Cisco Unified MeetingPlace suggests possible matches from the address book of users with Cisco Unified MeetingPlace profiles. If you do not select a profile from the address book, the user will be invited as a guest. After entering the name, click <strong>Add</strong> to add the user to the Invitees table. In the Invitees table, enter an e-mail address for the invitee if none has been entered and choose meeting permissions for the user. Each user must have an e-mail address, and at least one user must have moderator permissions for the meeting. If you choose Cisco WebEx as the Web conference provider you are automatically assigned the privileges of a Host. For more information about adding invitees to a Cisco WebEx meeting, see “Inviting Profile Users or Guests” section on page 22.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Click to schedule your meeting.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Click to cancel the scheduling process.</td>
</tr>
</tbody>
</table>

*Table 2 describes the parameters that appear in the Reserve Audio + Web conferencing section. If your deployment does not include video or if your user profile does not have video scheduling capabilities, you will see all of the parameters in this section by default; otherwise, you may need to check the Reserve Audio + Web conferencing check box to configure these parameters.

**Table 2  Parameters That Apply to Audio Plus Web Meetings**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reserve Audio + Web conferencing</td>
<td>Check this check box to reserve audio ports for non-video callers and to configure web-conferencing parameters.</td>
</tr>
<tr>
<td># of audio callers</td>
<td>The number of callers who will be attending this meeting. If multiple users will be attending the meeting over one phone line (such as in a conference room), count this as one caller.</td>
</tr>
<tr>
<td>Phone Dial-in</td>
<td>Lists the phone numbers associated with each site. If you choose your home site, specify the server on which you want to schedule a meeting by choosing the applicable phone number.</td>
</tr>
</tbody>
</table>
| Site                             | This is an optional parameter as configured by your system administrator and determines where you want to schedule your meeting. It is available only if your system administrator has configured the Cisco Unified MeetingPlace system with **WebConnect**.  
  - To choose your site, select it in the list.  
  - To limit scheduling to one site, check the Try This Site Only check box. |
| Multi-Server                     | Check this check box to schedule this meeting on multiple Cisco Unified MeetingPlace Audio Servers.                                           |
  **Note**                        | This parameter is displayed only if your deployment is configured for multiserver meetings.                                                 |

*Table 3 describes the parameters that apply when you are scheduling a meeting with video. You may need to check the Reserve Video conferencing check box to configure these parameters.

You will not be able to schedule video meetings if you choose Cisco WebEx as the web conference provider.
Welcome to Cisco Unified MeetingPlace Web Conferencing

About Scheduling Meetings

Tip
For more scheduling options, click the Attachments/Recordings and More Options icons. These sections allow you to attach documents and change additional meeting settings.

Scheduling Audio Plus Web Meetings

Some parameters may not display, depending on how your Cisco Unified MeetingPlace system is deployed. For more information, see your system administrator.

To Schedule an Audio Plus Web Meeting

Step 1
Sign in to Cisco Unified MeetingPlace Web Conferencing.

Step 2
On the Welcome page, click Schedule Meeting.

Step 3
(Optional) Enter a subject for your meeting to easily distinguish it for your invitees.

Step 4
Fill in the meeting details, such as the meeting ID (if you wish to define your own), date, time, and length of the meeting. For more information, see Table 1 in the “Scheduling Parameters” section on page 5.

Step 5
To make this meeting available to users outside of your organization’s firewall, for the Allow External Web Participants parameter, click Yes.

Note
This parameter appears only if your deployment is configured for external access.

Table 3
Parameters That Apply to Video Meetings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reserve Video conferencing</td>
<td>Check this check box to reserve ports for video callers (users dialing in from video endpoints and/or video terminals).</td>
</tr>
<tr>
<td></td>
<td>Note This parameter is displayed only if your deployment supports video conferencing and your profile has video-scheduling capabilities; checking the box allows you to configure additional video-conferencing parameters.</td>
</tr>
<tr>
<td># of video callers</td>
<td>The number of callers who will be attending this meeting through a video endpoint and/or reserved video terminal. Include the total number of video terminals that you invite by using the Reserve Video Terminals fields, plus a port for each additional video endpoint that will attend the meeting.</td>
</tr>
<tr>
<td>Reserve Video Terminals</td>
<td>Enter a search string (part or all of a video terminal name) and click the magnifying glass to update the list of video terminals you can invite to your meeting. Leave the search string blank to search for all applicable terminals. To invite a video terminal to the meeting, select a terminal from the directory list and click Add.</td>
</tr>
<tr>
<td></td>
<td>Note The search results may depend on the meeting category you chose for this meeting. If you cannot find a particular video terminal, it may not be available for the selected meeting category.</td>
</tr>
<tr>
<td>Check Availability</td>
<td>Use to check the availability of each of the video terminals you have added to the Invited Terminals list. The availability of each terminal on the day of the meeting will be displayed.</td>
</tr>
</tbody>
</table>
Step 6  Check the **Reserve Audio + Web conferencing** check box to configure audio and web-conferencing parameters. (If you do not have video-scheduling capabilities, this appears as a heading rather than a check box, and the audio and web parameters display by default.) For more information, see Table 2 in the “Scheduling Parameters” section on page 5.

Step 7  Invite profile and guest users in the Invitees section by entering part or all of the user name or e-mail address in the **Add Invitee or Team** field. As you enter characters in the name, Cisco Unified MeetingPlace suggests possible matches from the address book of users with Cisco Unified MeetingPlace profiles. Select a profile from the suggested list.

**Note**  If you do not select a profile from the address book, the user will be invited as a guest.

Step 8  After entering the name, click **Add** to add the user to the Invitees table.

Step 9  In the Invitees table, enter an e-mail address for the invitee if none has been entered and choose meeting permissions for the user. Each user must have an e-mail address, and at least one user must have **Moderator** permissions for the meeting.

Step 10  To customize your meeting, click the **Attachments/Recordings** and **Meeting Options** icons. In these sections, modify your meeting preferences and attach documents for others to review.

Step 11  (Optional) To ensure that guest users can access your meeting and meeting attachments, on the More Options page, confirm that the **Who Can Attend** and **Access MeetingNotes** fields are set to **Anyone**.

Step 12  When you have finished setting options, click **Submit** or **Cancel**. This returns you to basic meeting details scheduling form.

Step 13  To schedule your meeting, click **Schedule**.

**Tips**
- If you have **WebConnect** and the scheduling site is available, a confirmation page appears to confirm that the meeting was successfully scheduled. If the scheduling site is unavailable and the system is configured to warn you of this condition, a warning message appears prompting you to confirm rollover to another scheduling site.
- If you scheduled a meeting that requires the Cisco Unified MeetingPlace system to dial out to all of your invited participants, do not uncheck the **MeetingPlace Calls You** check box that appears on the meeting confirmation window. In effect, unchecking this check box disables the outdial feature and you are not called by the system to join the voice conference.

**Scheduling Video Meetings**

A video meeting is a Cisco Unified MeetingPlace conference with video and audio conferencing enabled from the meeting console. Optionally, you may also reserve audio ports on the Cisco Unified MeetingPlace Audio Server for non-video callers and a web conference.

Your system must have the Cisco Unified MeetingPlace Video Integration installed for the video integration to work. Only users with video-scheduling privileges can schedule video meetings.

**To Schedule a Video Meeting**

Step 1  Sign in to Cisco Unified MeetingPlace Web Conferencing.
Step 2  On the Welcome page, click Schedule Meeting. The New Meeting page appears.

Step 3  (Optional) Enter a subject for your meeting to easily distinguish it for your invitees.

Step 4  Fill in the meeting details, such as the meeting ID (if you wish to define your own), date, time, and length of the meeting. For more information, see Table 1 in the “Scheduling Parameters” section on page 5.

Step 5  In the Meeting Category list, select a category for the meeting. If there are video terminals defined for your deployment, the meeting category you select may control which video terminals you can invite to your meeting.

Step 6  To make this meeting available to users outside of your organization’s firewall, for the Allow External Web Participants parameter, click Yes. To make a video meeting available to video participants outside of your organization’s firewall, the Video Integration software must be installed on the external web server or cluster of servers. If this is not the case, do not click Yes.

**Note** This parameter appears only if your deployment is configured for external access.

Step 7  (Optional) Check the Reserve Audio + Web conferencing check box to configure audio and web-conferencing parameters. For parameter information, see Table 2 in the “Scheduling Parameters” section on page 5.

**Note** If you do not reserve an audio plus web conference, audio for the meeting can be provided only by the video MCU; audio users dialing into the Audio Server will be prevented from joining the meeting.

Step 8  Check the Reserve Video conferencing check box to configure video-conferencing parameters.

Step 9  In the # of video callers field, enter the number of video ports that you want to schedule. Include the total number of video terminals that you plan to invite by using the Reserve Video Terminals fields, plus a port for each additional video endpoint that will attend the meeting.

Step 10  (Optional) Reserve video terminals for the meeting:

a. Enter a search string (part or all of a video terminal name) in the Search Directory field and click the magnifying glass to update the list of video terminals you can invite to your meeting. Leave the search string blank to search for all applicable terminals.

**Note** The search results may depend on the meeting category you selected in Step 5.

b. To invite one or more video terminals to the meeting, select the terminal(s) from the directory list and click Add.

c. To remove one or more invited video terminals, select the terminal(s) from the invited terminals list and click Remove.

d. (Optional) Click Check Availability to see the availability of the invited terminals on the day of the meeting.

Step 11  Invite profile and guest users in the Invitees section by entering part or all of the user name or e-mail address in the Add Invitee or Team field. As you enter characters in the name, Cisco Unified MeetingPlace suggests possible matches from the address book of users with Cisco Unified MeetingPlace profiles. Select a profile from the suggested list.
About Scheduling Meetings

Welcome to Cisco Unified MeetingPlace Web Conferencing

Note
If you do not select a profile from the address book, the user will be invited as a guest.

Step 12 After entering the name, click Add to add the user to the Invitees table.

Step 13 In the Invitees table, enter an e-mail address for the invitee if none has been entered and choose meeting permissions for the user. Each user must have an e-mail address, and at least one user must have Moderator permissions for the meeting.

Step 14 To schedule your meeting, click Schedule.

Tips
- If you schedule a video conference but do not reserve an audio plus web conference, you will still be able to use the web meeting console to join and participate in your meeting, but no phone dial-in number will be provided. Participants will need to join by using the video dial-in number or by having Cisco Unified MeetingPlace dial out to their endpoint or video terminal.
- Rescheduling a meeting with video functionality requires the same steps as rescheduling a Cisco Unified MeetingPlace audio plus web meeting.
- Although you cannot specify meeting console and audio permissions for invited video terminals while scheduling the meeting, as a meeting moderator, you can change these permissions after the terminal joins the meeting by using the Change Permissions icon in the Participant List tool.

Scheduling Conference Room-Only Meetings

To book one or more conference rooms that contain video terminals or to book one or more video terminals without dedicating ports for a Cisco Unified MeetingPlace conference (for example, if you plan to set up a point-to-point video call from one location to another but do not need ports for additional conference participants), users with video-scheduling capabilities may schedule a conference room-only meeting. This causes the video terminal to display as unavailable for the duration of the meeting, so that other users scheduling meetings know that the room will be in use.

To Schedule a Conference Room-Only Meeting

Step 1 Sign in to Cisco Unified MeetingPlace Web Conferencing.

Step 2 On the Welcome page, click Schedule Meeting. The New Meeting page appears.

Step 3 In the Meeting Category list, select a category for the meeting. The meeting category you select may control which video terminals you can invite to your meeting.

Step 4 Uncheck the Reserve Audio + Web conferencing check box if it is checked.

Step 5 Check Reserve Video conferencing to configure video-conferencing parameters.

Step 6 Reserve video terminals for the meeting:

a. Enter a search string (part or all of a video terminal name) in the Search Directory field and click the magnifying glass to update the list of video terminals you can invite to your meeting. Leave the search string blank to search for all applicable terminals.

Note The search results may depend on the meeting category you selected in Step 3.
b. To invite one or more video terminals to the meeting, select the terminal(s) from the directory list and click **Add**.

c. To remove one or more invited video terminals, select the terminal(s) from the invited terminals list and click **Remove**.

d. (Optional) Click **Check Availability** to see the availability of the invited terminals on the day of the meeting.

**Step 7** Click **Meeting Options**.

**Step 8** Scroll down to the Video Conferencing Options section.

**Step 9** In the Service Code list, choose either **Non Video Conference** or **Point to Point**.

**Step 10** To return to the scheduling page, click **Submit**.

**Step 11** To schedule your meeting, click **Schedule**.

---

**Scheduling Recurring Meetings**

Because many meetings occur on an ongoing basis, the system allows you to schedule a variety of recurring meetings.

**To Schedule a Recurring Meeting**

**Step 1** Sign in to Cisco Unified MeetingPlace Web Conferencing.

**Step 2** On the Welcome page, click **Schedule Meeting**.

**Step 3** On the New Meeting page, fill in the meeting details, such as the meeting ID (if you wish to define your own), date, time, and length of the meeting. For more information, see the “**Scheduling Parameters**” section on page 5.

**Step 4** Click **Recurrence**.

**Step 5** In the Frequency section, set the applicable recurrence pattern:

<table>
<thead>
<tr>
<th>Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Once</strong></td>
<td>This is not a recurring meeting.</td>
</tr>
<tr>
<td><strong>Daily</strong></td>
<td>This meeting occurs at the same time every day.</td>
</tr>
<tr>
<td><strong>Bi-Weekly</strong></td>
<td>This meeting occurs every other week at the same time and day of the week.</td>
</tr>
<tr>
<td><strong>Weekly</strong></td>
<td>This meeting occurs once per week at the same time and day of the week.</td>
</tr>
<tr>
<td><strong>Monthly by Date</strong></td>
<td>This meeting occurs once per month on a particular date (for example, the 1st,</td>
</tr>
<tr>
<td></td>
<td>the 15th, the 30th).</td>
</tr>
<tr>
<td><strong>Monthly by Day of Week</strong></td>
<td>This meeting occurs once per month on a particular day of the week (for example,</td>
</tr>
<tr>
<td></td>
<td>the first Monday of the month).</td>
</tr>
</tbody>
</table>

**Note** If you are scheduling a date between the 23rd and the 29th, you will have the option of specifying whether you want this meeting to be scheduled for the last day, that is, the last Monday, or the fourth Monday.
Welcome to Cisco Unified MeetingPlace Web Conferencing

About Scheduling Meetings

If you are scheduling a monthly meeting and want to ensure that your meetings do not occur on a weekend, choose Monthly by Day of Week. The meeting will always occur on the same weekday each month. If you choose Monthly by Date, one of the monthly meetings could fall on a Saturday or Sunday.

Step 6 For # of Occurrences, enter the number of times you want this meeting to be held given the recurring meeting pattern. (For example, a weekly meeting set to occur five times results in a meeting that occurs once per week for five weeks.)

Step 7 To have the system alert you of any scheduling conflicts, check the Report conflicts before committing check box, then click Done to return to the New Meeting page.

Step 8 Complete the meeting information section and invite participants.

Step 9 To schedule the meeting, click Schedule.

Tip If you are scheduling a monthly meeting and want to ensure that your meetings do not occur on a weekend, choose Monthly by Day of Week. The meeting will always occur on the same weekday each month. If you choose Monthly by Date, one of the monthly meetings could fall on a Saturday or Sunday.

Scheduling and Attending Immediate Meetings

An immediate meeting is an impromptu meeting that you want to schedule. The system schedules immediate meetings by using default settings; users have access to the meeting as soon as it is scheduled.

To Schedule and Attend an Immediate Meeting

Step 1 Sign in to Cisco Unified MeetingPlace Web Conferencing.

Step 2 On the Welcome page, enter the meeting ID and click Immediate Meeting. The meeting console launches and immediately begins your meeting.

Step 3 To join the audio or video component or your conference from the meeting console, in the Participant List tool, click the Voice/Video Options icon (phone and video camera), then click Connect Me to join the audio or video components of your conference.

Step 4 On the Connect Me dialog box, choose a connection endpoint. If necessary, enter your phone number or video endpoint address so that the system can connect you.
Welcome to Cisco Unified MeetingPlace Web Conferencing

About Scheduling Meetings

Step 5  Click Connect Me.

If you do not have outdial privileges for an audio meeting, the option to dial your phone number may be disabled. If this is the case, or if you receive an error attempting to outdial, call the phone dial-in number indicated in the meeting console or in the ConnectMe dialog box to join the audio component of your conference.

If you are unable to outdial to an invited video terminal or other video endpoint, call the invited terminal dial-in number or the video dial-in number indicated in the meeting notification or on the Meeting Details page to join the conference.

Tip  Depending on the default settings, video ports may not be automatically reserved for immediate meetings scheduled from the web. If video ports are not reserved, you can still try to join the meeting through your video endpoint as long as there are ports available on the video MCU.

Scheduling Meetings on Behalf of Other Users

Users with Attendant or System Manager privileges can schedule meetings on behalf of other users. System default settings are taken from the profile of the meeting scheduler, but billing information is linked with the user for whom the meeting was scheduled.

You cannot schedule on behalf of inactive users.

To Schedule a Meeting on Behalf of Another User

Step 1  Sign in to Cisco Unified MeetingPlace Web Conferencing.
Step 2  On the Welcome page, click Schedule Meeting.
Step 3  For On Behalf of User, enter the Cisco Unified MeetingPlace user ID of the person for whom you are scheduling.
Step 4  Fill in the meeting details, such as the meeting ID (if you wish to define your own), date, time, length of the meeting, and number of callers.
Step 5  Complete the meeting information section and invite participants.
Step 6  To schedule your meeting, click Schedule.

The person for whom you are scheduling remains the owner of this meeting. Meeting notifications are sent to users from the Cisco Unified MeetingPlace system on behalf of the person for whom you have scheduled.

Scheduling Multiserver Meetings

Multiserver meetings allow users to attend the same meeting but from different Cisco Unified MeetingPlace Audio Servers. When you schedule a multiserver meeting, you designate one Audio Server as the primary server that is responsible for connecting to all secondary Audio Servers.
Before scheduling a multiserver meeting, note the following considerations:

- Multiserver meetings do not span web servers. Therefore, the Web Conferencing component of your meeting is scheduled on the Web Conferencing server associated with the primary Audio Server.
- Video for multiserver meetings does not span multiple sites. Participants will always be able to hear video callers at other sites but may not be able to see them.
- You must have a Cisco Unified MeetingPlace profile and permission from your system administrator to schedule multiserver meetings.

To Schedule a Multiserver Meeting

**Step 1**
Sign in to Cisco Unified MeetingPlace Web Conferencing.

**Step 2**
On the Welcome page, click **Schedule Meeting**.

**Step 3**
Fill in the meeting details, such as the meeting ID (if you wish to define your own), date, time, and length of the meeting.

**Step 4**
Set the multiserver meeting as recurring, if applicable:

a. Click **Recurring**.

b. Choose the recurrence pattern, then click **Done**.

**Step 5**
Check the **Reserve Audio + Web conferencing** check box to configure audio and web-conferencing parameters. (If you do not have video-scheduling capabilities, this appears as a heading rather than a check box, and the audio and web parameters display by default.)

**Step 6**
Configure audio and web parameters, and check the **Multi-Server** check box. For more information, see Table 2 in the “Scheduling Parameters” section on page 5.

**Step 7**
Complete the meeting information section, and invite participants.

**Step 8**
To schedule the meeting on your primary Audio Server, click **Schedule**. The Scheduled Meeting confirmation page appears.

**Step 9**
Click **Secondary Servers**. The Invited Servers page appears.

**Step 10**
Add a secondary server to your meeting:

a. In the Add column, check the check box next to the server that you want to add.

b. In the # of audio callers column, enter the number of ports you want to reserve.

**Step 11**
Click **Add Selected Servers**. The Invited Servers page appears with an updated list of servers that are scheduled for your meeting.

Escalating Meetings from an Internal to an External Server

Internal web servers limit attendance to users inside your organization’s firewall. If you scheduled a meeting on an internal web server but want to open it to a user outside the firewall, escalate the meeting in progress from the internal web server to an external web server. All users currently in attendance are removed from the meeting room once the meeting is escalated; they must rejoin the meeting from the Meeting Details page to connect to the external server. New users attending the meeting are automatically transferred to the external server.
Before you begin, confirm that the following requirements have been met:

- The meeting is scheduled for internal access on a web server that has both internal and external access available.
- You have the proper privileges to enable this feature: you are the meeting scheduler or the contact of the meeting scheduler, or you have System Manager privileges.
- The meeting is currently in progress.
- The meeting was scheduled with a predefined meeting template (Collaborative, Presentation, or Webinar). Meetings scheduled with custom templates cannot be escalated.

⚠️ Caution
When you escalate a meeting, you lose any web recording or polls that you started on the internal server prior to escalating.

📝 Note
Before escalating a meeting, consider warning current meeting participants that they will be removed from the web meeting console and will need to rejoin the meeting.

To Escalate a Meeting from an Internal to an External Server

**Step 1** On the Current Meeting page, for the Allow External Web Participants parameter, click Yes.

**Step 2** Click Update. The meeting ends on the internal web server and the meeting console closes. Participants who joined on the internal server see a message indicating that they have been asked to leave the room.

**Step 3** Click Join to rejoin the meeting on the external web server.

Setting Cisco Unified MeetingPlace Web Conferencing to Allow Guest Access

The meeting scheduler can set these settings.

**To Set Cisco Unified MeetingPlace Web Conferencing to Allow Guest Access**

**Step 1** Sign in to Cisco Unified MeetingPlace Web Conferencing.

**Step 2** On the Welcome page, click Schedule Meeting.

**Step 3** On the New Meeting page, click More Options and set the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Who Can Attend</td>
<td>Anyone</td>
</tr>
<tr>
<td>If you are scheduling a Cisco WebEx meeting, you must set the value to Anyone.</td>
<td></td>
</tr>
<tr>
<td>Who Can Access MeetingNotes</td>
<td>Anyone</td>
</tr>
</tbody>
</table>
Meetings scheduled with these parameters are scheduled as public meetings, which means that they are scheduled without access restrictions.

## Rescheduling Meetings

You can easily change the time, date, or any other details of a meeting you have scheduled. When the meeting is updated, an update notice is sent to your invitees.

Only meeting schedulers, their contacts, and users with System Manager privileges can reschedule meetings.

### To Reschedule a Meeting

1. **Step 1** Sign in to Cisco Unified MeetingPlace Web Conferencing.
2. **Step 2** On the Welcome page, enter the meeting ID of the meeting you want to reschedule, then click **Find Meeting**.
3. **Step 3** On the Find Meeting page, click **Future** and enter the time frame to search, then click **Search**.
4. **Step 4** In the search results, click the meeting ID for your meeting to access the Future Meeting page.
5. **Step 5** On the Future Meeting page, reschedule the meeting by modifying the fields you want to change.
6. **Step 6** (Optional) If this is a recurring meeting, click **Recurrence** to apply scheduling changes to this occurrence of the meeting only or to this and all future occurrences of the recurring meeting series, then click **Done**.
7. **Step 7** When you finish, click **Update**. A new confirmation appears with the updated meeting information.

### Tips

- Changing the meeting category of a video meeting may affect the list of video terminals that you can invite to the meeting. Previously invited terminals may be removed from the list.
- If your deployment supports video conferencing, and your profile has video-scheduling capabilities, you can add video when rescheduling an audio plus web conference by checking the Reserve Video conferencing check box or you can add an audio plus web conference to a video-only conference by checking the Reserve Audio + Web conferencing check box.
- If you are rescheduling a meeting with video callers and you uncheck the Reserve Video conferencing check box, the video conference will be canceled and any previously invited video terminals will no longer be reserved for the meeting.
- When removing invited video terminals from a previously scheduled meeting, the terminal status (displayed after the terminal name in the invited terminals list) changes from [OK] to [To Be Deleted] until you click Update to reschedule your meeting.

## Updating Multiserver Meetings

After you have scheduled a multiserver meeting, you can still make updates, such as adding or deleting secondary servers, and adding more invitees.
You cannot change the date, time, or length of the meeting. If you need to change such information, delete this meeting and schedule a new multiserver meeting with the updated information.

**To Update a Multiserver Meeting**

| Step 1 | Sign in to Cisco Unified MeetingPlace Web Conferencing. |
| Step 2 | On the Welcome page, enter the meeting ID of the meeting you want to update and click Find Meeting. The Find Meeting page appears. Because this is a multiserver meeting, several servers should appear with the same meeting ID. |
| Step 3 | In the Meeting ID column, click the link of the meeting that is scheduled on the primary server. |

**Note** The primary server is identified as (Primary) (Local).

| Step 4 | Add or remove secondary servers, as applicable: |
| a. | On the Options section of the page, click the Secondary Servers icon. The Invited Servers page appears. |
| b. | To add a secondary server, check the Add check box next to the server name, enter the number of ports you want to reserve, and click Add Selected Servers. |
| c. | To remove a secondary server, locate the server in the View section of the page and click Delete. |
| d. | Click Meeting Details to return to the Meeting Information page. |

| Step 5 | (Optional) Make any additional changes to the meeting and click Update. |

**Deleting Meetings**

Only meeting schedulers, their contacts, and system managers can delete meetings. Once a meeting is deleted, a canceled meeting notification is sent to your invitees.

**To Delete a Meeting**

| Step 1 | Sign in to Cisco Unified MeetingPlace Web Conferencing. |
| Step 2 | On the Welcome page, enter the meeting ID of the meeting that you want to delete, then click Find Meeting. |
| Step 3 | On the Find Meeting page, click Future and enter the time frame to search, then click Search. |
| Step 4 | In the search results, click the meeting ID for your meeting to access the Future Meeting page. |
| Step 5 | On the Future Meeting page, click Delete Meeting. When asked to confirm, click OK. |
| Step 6 | If you are deleting a recurring meeting, choose either Delete all meetings going forward in sequence or Delete only selected meeting. |
Deleting Multiserver Meetings

You must remove all secondary servers from your multiserver meeting before you can cancel the scheduled meeting.

**To Delete a Multiserver Meeting**

**Step 1** Sign in to Cisco Unified MeetingPlace Web Conferencing.

**Step 2** On the Welcome page, enter the meeting ID of the meeting you want to update, then click **Find Meeting**. The Find Meeting page appears.

Because this is a multiserver meeting, several servers should appear with the same meeting ID.

**Step 3** On the Meeting ID column, click the link of the meeting that is scheduled on the primary server.

**Note** The primary server is identified as (Primary) (Local).

**Step 4** Delete all secondary servers:

- a. On the Options section of the Meeting Information page, click the **Secondary Servers** icon. The Invited Servers page appears.

- b. On the View section of the page, click **Delete** for all secondary servers.

- c. Click **Meeting Details** to return to the Meeting Information page.

- d. Click the **Delete Meeting** tab.

Copying Meetings

If a meeting that you have scheduled has similar properties to a meeting you want to schedule, use the Copy Meeting button to schedule an identical meeting for another date and time. Any attachments associated with the original meeting are stripped during the copying process. Make sure you reattach or recreate these materials for your new meeting during the scheduling process.

**Note** If you want to set and retain meeting room layout, polls, and shared files for multiple meetings, use meeting templates instead.

**To Copy a Meeting**

**Step 1** Sign in to Cisco Unified MeetingPlace Web Conferencing.

**Step 2** On the Welcome page, enter the meeting ID of the meeting that you want to copy, then click **Find Meeting**. (Note that you can copy only meetings that you have scheduled.)

**Step 3** On the Find Meeting page, click **Future** and enter the time frame to search, then click **Search**.

**Step 4** In the search results, click the meeting ID for your meeting to access the Future Meeting page.

**Step 5** On the Future Meeting page, click **Copy Meeting**. A New Meeting page appears with the copied meeting information.
**About Reservationless Meetings**

A reservationless meeting is a meeting with a preassigned meeting ID that does not require resources to be scheduled in advance. Meeting IDs for reservationless meetings are equal to the scheduler's profile number. Your guests are placed in a waiting room until you sign in to begin the meeting. Guests cannot speak with each other or see each other on their video displays while in the waiting room.

Video ports are not automatically reserved for reservationless meetings. However, participants can still try to join the meeting through a video endpoint as long as there are ports available on the video MCU. Table 4 lists the parameter settings used for reservationless meetings.

---

**Note** Depending on your user profile and other parameters, you might have the option to choose Cisco WebEx as the Web conference provider for a reservationless meeting.
Initiating Reservationless Meetings

Before you begin, confirm that the following requirements have been met:

- Your Cisco Unified MeetingPlace Audio Server must be set to reservationless mode before you can initiate reservationless meetings.
- Your user profile must be set to Use Reservationless.

For more information, see your system administrator.

Note

Video terminals can join reservationless meetings but cannot initiate them.

To Initiate a Reservationless Meeting

Step 1 Sign in to Cisco Unified MeetingPlace Web Conferencing.
About Inviting People to Meetings

During the scheduling process, you can invite profile users, teams, and guest users to your meeting. All invitees receive a notification that contains the meeting time and date, the phone number, and the meeting ID needed to join the meeting.

This section contains the following information:

Inviting Profile Users or Guests, page 22

Inviting Profile Users or Guests

To Invite a Profile User or a Guest

Step 1 On the Welcome page, click Schedule Meeting. The New Meeting page appears.

Step 2 Invite profile and guest users in the Invitees section by entering part or all of the user name or e-mail address in the Add Invitee or Team field. As you enter characters, Cisco Unified MeetingPlace suggests possible matches from the address book of users with Cisco Unified MeetingPlace profiles. Select a profile from the suggested list.

Note If you do not select a profile from the address book, the user will be invited as a guest.

Step 3 After entering the name, click Add to add the user to the Invitees table.

Step 4 In the Invitees table, enter an e-mail address for the invitee if none has been entered. Each user must have an e-mail address.

Step 5 (Optional for meetings where Cisco Unified MeetingPlace is the Web conference provider:) In the Invitees table, change the meeting permissions for the user if desired. At least one user must have Moderator permissions for the meeting.

- If you choose Cisco WebEx as the Web conference provider and select the Meeting Center template, you are automatically given Host privileges, and all invitees, whether they are profiled users or guests, are given Attendee privileges. You cannot edit the privileges.
Welcome to Cisco Unified MeetingPlace Web Conferencing

If you choose Cisco WebEx as the Web conference provider and select the Sales Center template, you are automatically given Host privileges. All invitees who do not have a user profile are given Attendee privileges that cannot be changed. All invitees who have a user profile are assigned as Sales Reps. You can change the privileges from Sales Rep to Attendee. To change the privileges, click Sales Rep and click Attendee.

**Step 6**

Click Schedule to schedule your meeting.

**Tip**

Profiled users must record their name each time they dial in to a Cisco WebEx meeting, even if they have already recorded their name to use with Cisco Unified MeetingPlace.

---

**About Attachments and Recordings**

The Attachments/Recordings page tells you which recordings, documents, or comments are available for a meeting. Attaching a document, presentation, or meeting comment to a meeting allows users to review the attachment before, during, or after the meeting has taken place.

If you schedule a Cisco WebEx meeting and you plan to share attachments and documents, follow the onscreen instructions in the Cisco WebEx meeting room or see the Cisco WebEx online help.

When a meeting is scheduled, invitees receive attachments in their e-mail notification. The system also stores the attachments so that participants can access them from the web or from the meeting console while the meeting is taking place.

This section contains the following information:

- Adding Attachments to Meetings from the Meeting Scheduling Pages, page 23
- Recording Meeting Comments, page 24
- Accessing Attachments from the Meeting Scheduling Pages, page 24
- Accessing Attachments from the Meeting Console, page 25
- Retrieving Recordings, page 26
- Recording Cisco WebEx Meetings, page 25

**Adding Attachments to Meetings from the Meeting Scheduling Pages**

You can add a maximum of 30 attachments per meeting from the meeting scheduling pages. This number is configurable per profile and depends on your system configuration.

You can add a maximum of 256 slides per presentation per meeting. An individual attachment file may not exceed 20 MB in size.

You must schedule a meeting before you can record a meeting comment.

**To Add an Attachment to a Meeting from the Scheduling Pages**

**Step 1**

During the scheduling process, click the Attachments/Recordings icon, then click New Attachment.
Welcome to Cisco Unified MeetingPlace Web Conferencing

About Attachments and Recordings

Step 2  Attach the applicable item:

• To attach a document or presentation, choose File Attachment, then click Browse to choose the document or presentation that you want to submit.

• To attach a previously recorded meeting comment, choose Meeting Comment, then click Browse to choose the meeting comment that you want to submit.

Step 3  Click Add Attachment. The system takes a few moments to attach your file.

Step 4  To finish adding the attachment, click OK.

Step 5  To finish scheduling the meeting, click Schedule or Update.

Recording Meeting Comments

The information in this section applies only to Cisco Unified MeetingPlace meetings.

A meeting comment is the voice equivalent of a document. You can add meeting comments before, during, or after a meeting to record opinions and ideas. However, the meeting must be scheduled before you can record meeting comments from the web.

After you record a meeting comment, the audio file is associated with the meeting and users can access it from the web and by phone.

To Record a Meeting Comment

Step 1  Sign in to Cisco Unified MeetingPlace Web Conferencing.

Step 2  On the Welcome page, enter the meeting ID of the meeting that you want to access, then click Find Meeting.

Step 3  If the meeting is not found, on the Find Meeting page, click Past or Future as applicable and enter the time frame to search, then click Search.

Step 4  In the search results, click the meeting ID for your meeting to access the Meeting Information page.

Step 5  On the Meeting Information page, click the Attachments/Recordings icon and go to the Meeting Comments section.

Step 6  To record a meeting comment or message by phone, click Call Me.

Step 7  Verify your phone number, then click OK. The system calls you at this number if you have outdial privileges.

Step 8  To access MeetingNotes, answer your phone and press 1.

Step 9  To record a meeting comment, press 5.

Step 10  Follow the prompts to record a meeting comment. This comment is posted to the web for others to access.

Accessing Attachments from the Meeting Scheduling Pages

The instructions in this section only apply to attachments associated with Cisco Unified MeetingPlace meetings.
You can access attachments for future or past meetings from the meeting scheduling pages.

**Note**
Meetings and their associated attachments and recordings are purged from the system after a specified amount of time as determined by your system administrator.

### To Access an Attachment from the Meeting Scheduling Pages

**Step 1** Sign in to Cisco Unified MeetingPlace Web Conferencing.

**Step 2** On the Welcome page, enter the meeting ID of the meeting that you want to access, then click **Find Meeting**.

**Step 3** On the Find Meeting page, click **Past** or **Future** as applicable and enter the time frame to search, then click **Search**.

**Step 4** In the search results, click the meeting ID for your meeting to access the Meeting Information page.

**Step 5** On the Meeting Information page, click the **Attachments/Recordings** icon.

**Step 6** On the Attachments/Recordings page, click the attachment file that you want to access.

**Step 7** To return to the Meeting Information page, click **OK**.

### Accessing Attachments from the Meeting Console

To access attachments from the meeting console, the meeting moderator or a presenter must upload the attachment to a File Share tool in the meeting console; you can then download the attachment to your computer to view it.

The instructions in this section only apply to Cisco Unified MeetingPlace meetings.

### To Access an Attachment from the Meeting Console

**Step 1** In the File Share tool, select the file to download.

**Step 2** Click **Save to My Computer**. A browser window opens, with the Save to My Computer dialog box.

**Step 3** Click the **Click to Download** button.

**Step 4** Navigate to the desired location.

**Step 5** Click **Save**.

### Recording Cisco WebEx Meetings

After you join a teleconference, you can use the Cisco WebEx Meeting Manager to connect the Cisco WebEx Network Based Recording (NBR) service to the audio conference.

**Before You Begin**
Log in as a host to a meeting that uses Cisco WebEx as the Web conference provider.
Procedure

Step 1 Click Record this Meeting in the Cisco WebEx Meeting Manager to connect the Cisco WebEx NBR service to the audio conference. **Option:** Click Meeting-> Start Recording to connect the NBR to the audio conference. The WebEx Recorder Setup page appears and the Record MP Teleconferencing Service radio button is selected.

Step 2 Click Next. Account information, such as the audio server dialout number, Subscriber Passcode (MP Meeting ID), and Participant Passcode (Recording ID) is automatically filled in.

Step 3 Click Next. The recording service dials the Cisco Unified MeetingPlace conference telephone number. After the WebEx NBR connection is successfully established, the Connection Established window appears.

Step 4 Click Start Recording. The Recorder Panel appears. Under normal conditions, the Recorder Panel displays Connected for the duration of the recording. The WebEx NBR is recording the audio conference. If the NBR connection terminates, then the Recording Panel displays Error.

Step 5 To stop the recording during the audio conference, press the black square button on the Recorder Panel. This stops recording and disconnects the NBR service from the audio conference. In a typical conference, the recording service stops when the Cisco WebEx Meeting ends.

Retrieving Recordings

Meeting moderators can choose to make a recording of a meeting. Audio-only, web-only, and audio plus web meetings can all be recorded. Participant video in meetings is not recorded.

Meeting recordings are available after the meeting has ended. It may take some time for recordings to appear, depending on the processing load on the Cisco Unified MeetingPlace Web Conferencing server.

For audio plus web meetings, two recordings are created: an audio-only recording and Flash recording (which plays back in Adobe Flash Player on your desktop). The Flash recording gives a synchronized playback of the audio and the meeting console during the meeting. The Flash recording begins when the web-conference portion of the meeting starts; any audio recorded before this point is available only in the audio-only recording.

Retrieving a Recording of a Cisco Unified MeetingPlace Meeting

Procedure

Step 1 Sign in to Cisco Unified MeetingPlace Web Conferencing.

Step 2 On the Welcome page, enter the meeting ID of the meeting that you want to access, then click **Find Meeting**.

Step 3 On the Find Meeting page, click **Past** and enter the time frame to search, then click **Search**.

Step 4 In the search results, click the meeting ID for your meeting to access the Past Meeting page.

Step 5 On the Past Meeting page, click the **Attachments/Recordings** icon.
Step 6  On the Attachments/Recordings page, click the recording file you want to access:

<table>
<thead>
<tr>
<th>Web Recording</th>
<th>Synchronized audio and web recordings (or web-only, if the meeting did not include audio). Adobe Flash Player opens on your desktop allowing you to view this playback.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meeting Recording</td>
<td>Audio-only recordings. You must have the appropriate media player installed (for example, Windows Media Player) to listen to these recordings.</td>
</tr>
</tbody>
</table>

Step 7  If you want to have the system call you so that you can listen to the recording by phone, click Call Me.

Step 8  To return to the Meeting Information page, click OK.

---

**Retrieving a Recording of a Cisco WebEx meeting**

**Procedure**

**Before You Begin**

- Sign in to Cisco Unified MeetingPlace as a profiled user.
- Click My WebEx.

**Procedure**

Step 1  Click My Files.

Step 2  Click My Recordings.

The page displays links and controls that you can use to take actions on recorded meetings. For example, you can view properties of a selected recording, download a recording, and so forth. For more information, see the Cisco WebEx online help or access the Cisco WebEx user documentation.

---

**About Meeting Templates**

The information in this section applies to Cisco Unified MeetingPlace templates only. Meeting templates allow you to specify meeting room formats, add attachments, create polls, and set other meeting parameters that can be applied each time you create a meeting by using the template. The meeting template you select when creating a meeting also dictates the default permissions that meeting invitees are assigned as you add them to the meeting (although you can change these permissions while adding invitees).

Cisco Unified MeetingPlace has three predefined templates to suit different meeting styles. Users with appropriate permissions can select from among these templates or create custom templates. The following predefined templates are available:

- Collaborative—An open forum-style meeting where all participants have Presenter meeting console permissions by default.
- Presentation—A meeting where one or more participants present to an active audience of one or more participants.
- Webinar—A lecture-style meeting where one participant is the moderator, there are one or more presenters, and the remainder of the participants are passive audience members. By default, the audience members have listener audio permissions (audio is turned off) in this type of meeting.

If you see a My Templates link when you sign in to Cisco Unified MeetingPlace, your profile has full meeting console permissions, and you can use these predefined templates or create new ones to use when scheduling meetings. Otherwise, your profile permissions are limited so that the meeting console for meetings that you create will contain only a participant list and associated audio and video controls for the meeting; when scheduling a meeting, you can choose either the Collaborative template or the Webinar template, but the template you choose affects only the audio permissions of attendees.

This section contains the following information:
- Information Preserved in a Template, page 28
- Creating a Template, page 28
- Modifying a Template, page 29
- Saving a Past Meeting as a Template, page 30

**Information Preserved in a Template**

A meeting room converted to a template is a duplicate of the original room. Layouts, tools, and most contents and room information are preserved in the template, including the following:
- Layouts with name, order, and starting (selected) status.
- Tools with name, size, position, and settings for full-screen toggle.
- Tool content.
- Whiteboard overlay contents.
- Poll state (Prepare, Open, Close), questions, answers, and broadcast results.
- Questions and answers, Chat tool link, and status (Open, Answered, All).
- Text in Notes tool.
- Messages to be displayed to users when a meeting is on hold or ended.
- Room background, screen resolution, and bandwidth.
- Presenter Only area status.

Certain information is not saved to the template. Audio conference settings and the content of a Chat tool are not saved to a template.

**Creating a Template**

If your user profile has full meeting console permissions, you can use the My Templates link to create or edit templates.

Note that the custom templates you create are not available for external meetings. If you set the Allow External Web Participants parameter to Yes when scheduling a meeting, you can select only from the predefined templates (Collaborative, Presentation, or Webinar). To use a custom template, you must set Allow External Participants to No. If you later update or reschedule the meeting and set Allow External
Participants to No, the meeting template will be reset to the Collaborative template. Once a meeting scheduled with a custom template begins, you will not be able to escalate the meeting to an external meeting.

**Note**
You cannot create a Cisco WebEx template.

### To Create a Template

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Sign in to Cisco Unified MeetingPlace Web Conferencing.</td>
</tr>
<tr>
<td>2</td>
<td>On the Welcome page, click <strong>My Templates</strong>.</td>
</tr>
<tr>
<td>3</td>
<td>Enter a name for the template in the Template Name field.</td>
</tr>
<tr>
<td>4</td>
<td>For Template Based On, click one of the predefined meeting templates (Collaborative, Presentation, or Webinar). The initial meeting room layout will be based on this template, although you can change the layout later.</td>
</tr>
<tr>
<td>5</td>
<td>Click <strong>Create Template</strong>. The meeting console opens to the Moderator view. From here, you can make changes to the layout, attach files to be shared, and set other defaults that will apply to meetings based on this template.</td>
</tr>
<tr>
<td>6</td>
<td>(Optional) To check or change the meeting room layout for other types of participants, on the View menu in the meeting console, click <strong>Presenter View</strong> or <strong>Audience View</strong>.</td>
</tr>
<tr>
<td>7</td>
<td>When you have completed your changes, close the meeting console window. Your changes are saved automatically.</td>
</tr>
</tbody>
</table>

### Modifying a Template

If your user profile has full meeting console permissions, you can use the My Templates link to rename a template or edit template settings.

**Note**
You cannot modify either Cisco WebEx template.

### To Modify a Template

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Sign in to Cisco Unified MeetingPlace Web Conferencing.</td>
</tr>
<tr>
<td>2</td>
<td>On the Welcome page, click <strong>My Templates</strong>.</td>
</tr>
<tr>
<td>3</td>
<td>To rename the template, click on the template name, type in the new name, and click <strong>OK</strong>.</td>
</tr>
<tr>
<td>4</td>
<td>To modify the meeting room layout or other settings, perform the following sub-steps:</td>
</tr>
<tr>
<td></td>
<td>a. Click the pencil icon in the Edit column of the My Templates table. The meeting console opens to the Moderator view.</td>
</tr>
<tr>
<td></td>
<td>b. Make any desired changes to the Moderator view. To change the meeting room layout for other types of participants, on the View menu in the meeting console, click <strong>Presenter View</strong> or <strong>Audience View</strong>.</td>
</tr>
</tbody>
</table>
When you have completed your changes, close the meeting console window. Your changes are saved automatically.

## Saving a Past Meeting as a Template

If your user profile has full meeting console permissions, you can save a meeting as a template after the meeting ends.

**Note**

You cannot save a past Cisco WebEx meeting as a template.

### Step 1

Sign in to Cisco Unified MeetingPlace Web Conferencing.

### Step 2

On the Welcome page, enter the meeting ID of the meeting that you want to access, then click Attend Meeting. The Past Meeting page displays.

### Step 3

In the Save As Template section, enter a name for the new template, and click **Save Meeting As Template**.

## About the Find Meetings Tab

The Find Meetings feature uses a search engine to locate meetings based on a variety of parameters.

This section contains the following information:

- Find Meetings Parameters, page 30
- Finding Meetings, page 31

## Find Meetings Parameters

*Table 5* describes the parameters that Cisco Unified MeetingPlace Web Conferencing uses to search for meetings.

### Table 5: Parameters for Find Meetings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site to Search</td>
<td>To limit the search to a particular site, choose a site from the list. Search results are limited to this site only.</td>
</tr>
<tr>
<td>Meeting ID</td>
<td>Enter the ID of the meeting that you are searching for. The search engine accepts both numeric and vanity ID forms (for example, 12345 or Sales).</td>
</tr>
<tr>
<td>From - To</td>
<td>The search engine searches for today’s meetings by default. If the meeting that you are searching for is a Past or Future meeting, click the applicable option.</td>
</tr>
</tbody>
</table>
Finding Meetings

Your system administrator may have limited this feature to profile users only. If so, guest users are unable to search for meetings.

To Find a Meeting

| Step 1 | On the Cisco Unified MeetingPlace Web Conferencing home page, click Find Meeting. If you have not signed in already, the Find Meetings sign-in page appears. |
| Step 2 | Enter your Cisco Unified MeetingPlace user ID and password, or guest name in the fields provided. |
| Step 3 | To find a specific meeting, enter the meeting ID and click Search. |
| Step 4 | On the Today’s Meetings page, scroll through the list to locate your meeting. Each meeting is organized according to site, date/time, subject, and meeting ID. If you cannot find your meeting in the Find Meetings results, it may be scheduled as a private meeting. Contact the meeting scheduler. If the meeting you are searching for is a public meeting but it does not appear in the search results, it may have been restricted to appear to invitees only. |
| Step 5 | Click the meeting ID for your meeting to access the Meeting Information page. |
| Step 6 | To browse through past or future meetings, modify the meeting search parameters and click Search. |

About Attending Meetings

Cisco Unified MeetingPlace users attend Cisco Unified MeetingPlace meetings based on their user class and user permissions: profile user or guest user, Speaker or Listener, Presenter, Participant, or Audience. If you are attending a Cisco Unified MeetingPlace web conference for the first time, run the browser test to confirm that you have a supported browser and operating system and the proper security settings. (See the “Running the Browser Test” section on page 1.)
Cisco Unified MeetingPlace profiled users who schedule either a Cisco WebEx Sales Center or Meeting Center meeting are automatically assigned the Host role. Cisco Unified MeetingPlace profiled users who are invited to a Cisco WebEx Meeting Center meeting are automatically assigned the Attendee role. Cisco Unified MeetingPlace profiled users who are invited to a Cisco WebEx Sales Center meeting are automatically assigned the Attendee role, which you can change to the SalesRep role. Non-profiled users who are invited to a Cisco WebEx Sales Center meeting are automatically assigned the Attendee role, which cannot be changed.

If you are attending a meeting through a video endpoint, launch your video endpoint before joining the web meeting. Your video image appears in a separate window on your desktop.

This section contains the following information:

- Attending Meetings from the Web, page 32
- Attending Meetings from the Click-to-Attend Link, page 34
- Tips for Attending Webinar Meetings, page 35
- Attending Multiserver Meetings, page 35
- Attending Reservationless Meetings, page 35
- Attending Meetings as a Guest User, page 36

**Attending Meetings from the Web**

This section explains how to log in to a Cisco Unified MeetingPlace meeting or to a Cisco WebEx meeting. You use the same procedures to log in to both Sales Center or Meeting Center meetings.

**Attending a Cisco Unified MeetingPlace Meeting from the Web**

**Procedure**

**Step 1**
On the Cisco Unified MeetingPlace Web Conferencing home page, enter the meeting ID of the meeting that you want to join, then click **Attend Meeting**.

If you are attending a reservationless meeting, the meeting ID is equal to the profile number of the meeting scheduler.

If this is the first time you are joining a Cisco Unified MeetingPlace web conference using a particular browser, a Security Warning may appear. To prevent this window from appearing in the future, check the **Always Trust Content from Cisco Systems, Inc.** check box and click **Yes**.

If you have signed in previously, you are taken directly into the meeting console to participate in the web conference. If you have not signed in previously, the Attend Meeting Sign In page appears.

**Step 2**
If applicable, on the Attend Meeting Sign In page, enter your Cisco Unified MeetingPlace user ID and password, or a guest name and click **Attend Meeting**.

**Step 3**
If this is a password-protected meeting, enter the password in the field provided, and click **Submit**.

**Step 4**
On the meeting console, in the Participant List tool, click the **Voice/Video Options** icon (phone and video camera), then click **Connect Me** to join the audio or video components of your conference.
Step 5  On the Connect Me window, choose a connection endpoint and enter your phone number or video endpoint address (either for your desktop video endpoint or a room-based video terminal) so that the system can connect you.

Step 6  Click Connect Me.

If you do not have outdial privileges for an audio meeting, the option to dial your phone number may be disabled. If this is the case, or if you receive an error attempting to outdial, call the phone dial-in number indicated in the meeting console or in the Connect window to join the audio component of your conference.

If you are unable to outdial to an invited video terminal or other video endpoint, call the invited terminal dial-in number or the video dial-in number indicated in the meeting notification or on the Meeting Details page to join the conference.

---

Tips

- If you do not know your meeting ID, click Find Meetings to browse for the meeting by date. This feature may not be available for guest users. If it is available, guests must first register before they can search for meetings.
- If you are a guest user and cannot find your meeting, it is possible that it was scheduled as a private meeting. Contact the meeting scheduler to be permitted into the meeting.
- If the meeting is not in progress when you log in, an error message appears. Wait for your scheduled time before attempting to enter the meeting.

---

Attending a Cisco WebEx Meeting from the Web

Use the procedure in this section attend either a Sales Center or Meeting Center meeting.

Procedure

Step 1  On the Cisco Unified MeetingPlace Web Conferencing home page, enter the meeting ID of the meeting that you want to join, then click Attend Meeting.

Step 2  If you are the meeting host, on the Attend Meeting Sign In page, enter your Cisco Unified MeetingPlace user ID and password. If you are a guest, enter a guest name and click Attend Meeting.

Step 3  Click Connect. If prompted, enter a meeting password and click Submit.

After a brief interval, the browser displays the Cisco WebEx meeting room interface.

---

Tips

- If you do not know your meeting ID, click Find Meetings to browse for the meeting by date. This feature might not be available for guest users.
• If you are a guest user and cannot find the Cisco WebEx meeting, it is possible that it was scheduled as a private meeting. Contact the meeting scheduler to join the meeting.

Attending Meetings from the Click-to-Attend Link

The procedure in this section assumes that you have received a meeting notification that includes a link to the Cisco Unified MeetingPlace home page.

If you did not receive such a meeting notification, see the “Attending Meetings from the Web” section on page 32 instead.

Attending a Cisco Unified MeetingPlace Meeting from the Click-to-Attend Link

Procedure

Step 1
Click the click-to-attend link at the bottom of your e-mail notification.

If this is the first time you are joining a Cisco Unified MeetingPlace web conference using a particular browser, a Security Warning appears. To prevent this window from appearing in the future, check the Always Trust Content from Cisco Systems, Inc. check box and click Yes.

If you have signed in previously, you are taken directly into the meeting console to participate in the web conference. If you have not signed in previously, the Attend Meeting Sign In page appears.

Step 2
If applicable, on the Attend Meeting Sign In page, enter your Cisco Unified MeetingPlace user ID and password, or a guest name and click Attend Meeting.

Step 3
If this is a password-protected meeting, enter a password and click Submit.

Step 4
On the meeting console, in the Participant List tool, click the Voice/Video Options icon (phone and video camera), then click Connect Me to join the audio or video components of your conference.

Step 5
On the Connect Me window, choose a connection endpoint. If necessary, enter your phone number or video endpoint address so that the system can connect you.

Step 6
Click Connect Me.

If you do not have outdial privileges for an audio meeting, the option to dial your phone number may be disabled. If this is the case, or if you receive an error attempting to outdial, call the phone dial-in number indicated in the meeting console or in the Connect window to join the audio component of your conference.

If you are unable to outdial to an invited video terminal or other video endpoint, call the invited terminal dial-in number or the video dial-in number indicated in the meeting notification or on the Meeting Details page to join the conference.

Attending a Cisco WebEx Meeting from the Click-to-Attend Link

Procedure

Step 1
Click the click-to-attend link at the bottom of your e-mail notification.

Step 2
Click Attend Meeting.
Step 3  If you are the meeting host, on the Attend Meeting Sign In page, enter your Cisco Unified MeetingPlace user ID and password. If you are a guest, enter a guest name and click Attend Meeting.

Step 4  Click Connect. If prompted, enter a meeting password and click Submit.

After a brief interval, the browser displays the Cisco WebEx interface.

Tips for Attending Webinar Meetings

Webinar meetings are controlled meeting environments in which only the meeting moderator and a few designated participants have the ability to speak and share presentations during the meeting. All other guest and profile users enter with limited abilities. (For more information about permissions, see the “About Meeting Permissions” section on page 42.)

- If you are attending a webinar through a video endpoint, you have limited audio permissions. To speak during webinar meetings, have the system outdial to your phone. The meeting moderator can then grant you speaking abilities during the meeting.
- If you are a moderator or presenter, make sure you have the system outdial to your phone. You do not have speaking abilities if you attend over your video endpoint.
- If you have audio transmission through both your video endpoint and a phone, make sure you mute your video endpoint to eliminate echo.
- If you are attending with Speaker permissions, your speaking ability in a webinar is based on the meeting floor status:
  - If the floor is closed, you are muted.
  - If the floor is open, you are unmuted.
- If you are attending with Listener permissions, the meeting moderator can grant you speaking abilities during the meeting.
- Depending on how the meeting scheduler scheduled the meeting, you might enter a waiting room until the meeting moderator arrives to begin the meeting. You cannot speak with other participants while you are in the waiting room. If you are attending over a video endpoint, your video display is also blocked while you are in the waiting room.

Attending Multiserver Meetings

The web conference component of a multiserver meeting is held on the primary server. The URL for this primary server should be in your meeting notification.

If you did not receive a meeting notification, attend the meeting through the applicable Cisco Unified MeetingPlace web home page by entering the meeting ID and clicking Attend Meeting.

Attending Reservationless Meetings

If you are the meeting moderator and you have a video endpoint available, attend through the web first in order to initiate your reservationless meeting. Then click the Voice/Video Options icon (phone and video camera) in the Participant List tool and click Connect Me to connect to your audio or video components. You cannot initiate your reservationless meeting if you dial directly into your video conference first.
Before you begin, note the following considerations:

- In reservationless meetings, the meeting ID is equal to the profile number of the meeting scheduler.
- Reservationless meetings do not schedule video ports in advance. If you are attempting to attend a reservationless meeting from a video endpoint, the system will allow you to join only if there are video ports available.

**To Attend a Reservationless Meeting**

**Step 1** On the Cisco Unified MeetingPlace Web Conferencing home page, enter the meeting ID, then click **Attend Meeting**. The Sign In page appears.

**Step 2** Sign in as either a profile user or as a guest user.

- If the meeting ID matches a known profile number, you are placed into a waiting room until the meeting organizer arrives to initiate the meeting.
- If the meeting organizer has already arrived, you are immediately connected to the meeting.

**Step 3** When the meeting comes to order, in the Participant List tool, click the **Voice/Video Options** icon (phone and video camera), then click **Connect Me** for connection information to your audio or video components.

---

**Attending Meetings as a Guest User**

Guests are users who have signed in to Cisco Unified MeetingPlace Web Conferencing without a Cisco Unified MeetingPlace profile.

**Tip** If you have a Cisco Unified MeetingPlace profile, always sign in with your profile to access the full range of web features.

**To Attend a Meeting as a Guest User**

**Step 1** On the Cisco Unified MeetingPlace Web Conferencing home page, enter the meeting ID of the meeting that you want to attend, then click **Attend Meeting**.

**Step 2** When prompted, enter your guest name in the field provided, then click **Attend Meeting**.

**Step 3** If this is a password-protected meeting, enter a password, then click **Submit**. The meeting console appears on your desktop.

**Step 4** To join the audio or video components of your conference, in the Participant List tool, click the **Voice/Video Options** icon (phone and video camera), then click **Connect Me**. The Connect Me window appears.

**Step 5** Click your connection endpoint, then enter your phone number or video endpoint address.

**Step 6** Click **Connect Me**.

**Step 7** (Optional) If the system cannot connect you, dial in to the meeting by using the phone number displayed in the meeting console.
Welcome to Cisco Unified MeetingPlace Web Conferencing

About the Meeting Console

The information in this section only applies to Cisco Unified MeetingPlace meetings. For information about the Cisco WebEx interface, click help in the Cisco WebEx meeting.

When you join a Cisco Unified MeetingPlace web conference you enter the meeting console. The meeting console displays a list of meeting participants and provides a variety of interactive meeting management tools. Depending on the type of meeting, the meeting console may also display shared documents and presentations and provide other collaboration tools.

Note the following considerations:

- Meeting console load times vary with individual deployment. Generally speaking, anything under one minute is considered an acceptable meeting console load time.

Tips

- If you do not know your meeting ID, click Find Meetings to browse for the meeting by date. This feature may not be available for guest users. If it is available, guests must first register before they can search for meetings.

- If you are a guest user and cannot find your meeting, it is possible that it was scheduled as a private meeting. Contact the meeting scheduler to be permitted into the meeting.

Attending Cisco WebEx Meetings

Follow the instructions in this section to attend a Cisco WebEx Sales Center or Meeting Center meeting.

To Attend a Cisco WebEx Meeting

Step 1
On the Cisco Unified MeetingPlace Web Conferencing home page, enter the meeting ID of the meeting that you want to join, then click Attend Meeting.

Step 2
If applicable, on the Attend Meeting Sign In page, enter your Cisco Unified MeetingPlace user ID and password, or a guest name and click Attend Meeting.

Step 3
If this is a password-protected meeting, enter the password in the field provided, and click Submit.

Step 4
Click Connect.
After you click Connect, your browser displays the Cisco WebEx meeting room.

Tips

- If you do not know your meeting ID, click Find Meetings to browse for the meeting by date. This feature may not be available for guest users. If it is available, guests must first register before they can search for meetings.

- If you are a guest user and cannot find your meeting, it may have been scheduled as a private meeting. To attend the meeting, contact the meeting scheduler.

If you are a guest user and cannot find your meeting, it may have been scheduled as a private meeting. To attend the meeting, contact the meeting scheduler.
Options in the meeting console are available based on the type of meeting, your user class, your meeting console permission level, and the system configuration.

Screen sharing and file sharing from the desktop are not available on Linux or Unix systems. Users on these systems can share a whiteboard or meeting attachment, view shared files and make annotations, but they cannot share files that reside on their systems with other participants.

This section contains the following information:
- Inside the Meeting Console, page 38
- Meeting Console Tools, page 38
- Controlling Your Audio and Video in the Meeting Console, page 39
- Tips on Viewing Shared Content in the Meeting Console, page 41
- Meeting Console Layout Controls for Moderators, page 42

Inside the Meeting Console

Content in a meeting room is displayed in tools, which are windows that contain various types of media, including slides, whiteboards, shared applications, polls, and messages to meeting participants. The menu bar at the top of the meeting room window displays meeting information and contains controls for managing the room.

The meeting room stage is the area of the presenter’s screen that participants see in a meeting. The stage contains the tools that display the various types of content.

The meeting console has a second display area, the Presenter Only area, which borders the stage and is visible only to moderators and presenters. Moderators can choose to show or hide this area. Moderators and presenters can use the Presenter Only area to prepare content to be shared with audience members or to view confidential content that is not shared with the audience.

Meeting Console Tools

When moderators set up a meeting room, they determine the number, types, size, and position of tools that participants see. The following tools are available:
- Share tool—Displays shared content from the presenter’s computer (including windows, applications, or the entire desktop), documents, or whiteboards.
- Participant List tool—Displays the name, role, and status of each participant, and allows the moderator to change the role or permissions of one or more participants.
- Chat tool—Allows participants to send chat messages to other participants.
- Q & A tool (linked to Chat tool)—Redirects questions from the Chat tool to appropriate presenters.
- Note tool—Displays text messages from moderators or presenters to all participants.
- File Share tool—Allows moderators and presenters to post files that can be downloaded by participants.
- Poll tool—Allows moderators and presenters to conduct polls or ask questions of participants.
- Web Links tool—Lets moderators post a web link and force all participants to browse to that link.
Controlling Your Audio and Video in the Meeting Console

The meeting console contains several options for controlling your phone and video endpoint during the meeting.

This section contains the following information:
- Dialing Out to Your Phone or Video Endpoint from the Meeting Console, page 39
- Muting or Unmuting Your Audio, page 39
- Pausing or Restarting Your Video Transmission, page 40
- Changing Your Video Layout, page 40
- Moving to or from an Audio Breakout Room, page 41

Dialing Out to Your Phone or Video Endpoint from the Meeting Console

Do the following procedure if you joined a web and audio meeting without connecting to the audio portion of the meeting and you later want to dial in to the meeting.

**To Dial Out to Your Phone or Video Endpoint from the Meeting Console**

**Step 1** In the Participant List tool, click the **Voice/Video Options** icon (phone and video camera).

**Step 2** Click **Connect Me**. The Connect Me dialog box appears.

**Step 3** Choose the applicable option:

<table>
<thead>
<tr>
<th>Use my phone number</th>
<th>Use to dial out to a phone. Enter a new phone number to call a number other than the default.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use my video endpoint number</td>
<td>Use to dial out to a video endpoint. Enter a new video endpoint number to call a number other than the default.</td>
</tr>
</tbody>
</table>

**Step 4** Click **Connect Me**.

**Tip** You can also view the audio and video dial-in information or reach the Connect Me dialog box by clicking the phone icon in the upper right corner of the meeting console.

Muting or Unmuting Your Audio

The mute feature allows you to mute your phone line (and video-endpoint microphone, if you are connected with video) so that background noise and phone static is not heard by other meeting participants. This option is available from the meeting console only if your web session is associated with your audio session. The simplest way to ensure that sessions are associated is to sign in to the web conference first, then have the system outdial you from the Current Meeting page or the meeting console.
Tip

To reduce the amount of noise within a meeting, all participants should mute their audio when not speaking.

To Mute or Unmute Your Audio

In the Participant List tool, click the Mute Me icon (loudspeaker with red circle and cross). When you are muted, your updated status is displayed in the Participant List tool, and the icon becomes the Unmute Me icon. Clicking it again unmutes your audio.

Note

Moderators do not see the Mute Me icon in the Participant List tool. To mute yourself if you are a moderator, in the Participant List tool, click the Volume Options icon (loudspeaker with plus symbol), then click Mute Me.

Pausing or Restarting Your Video Transmission

You can stop the transmission of your video image to the meeting without hanging up from the video call by pausing your video. Pausing your video does not affect the transmission of your audio.

If other video participants are watching video in Active Speaker mode and you are the current speaker, the video image freezes at the last image sent.

This option is available from the meeting console only if your web session is associated with your video session. The simplest way to ensure that sessions are associated is to sign in to the web conference first, then have the system outdial you from the Current Meeting page or the meeting console.

To Pause or Restart Your Video Transmission

Step 1
In the Participant List tool, click the Voice/Video Options icon (phone and video camera).

Step 2
Click Pause Video. To play your video again, click Pause Video again.

Changing Your Video Layout

Cisco Unified MeetingPlace Web Conferencing supports two video-display layouts:

<table>
<thead>
<tr>
<th>Continuous Presence</th>
<th>Displays multiple video participants. The current or most recently active speaker is always displayed in one highlighted area of the window; other participants may occupy other areas based on factors such as when they joined the meeting or how recently they have spoken.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Active Speaker Only</td>
<td>Shifts one window to constantly show the current or most recently active speaker.</td>
</tr>
</tbody>
</table>
The Continuous Presence option requires that your video MCU and endpoint can support this view. For more information, see your system administrator.

**To Change Your Video Layout**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>In the Participant List tool, click the <strong>Voice/Video Options</strong> icon (phone and video camera).</td>
</tr>
<tr>
<td>Step 2</td>
<td>Click <strong>Video Layout Options</strong>, then click the desired layout.</td>
</tr>
</tbody>
</table>

### Moving to or from an Audio Breakout Room

Breakout rooms allow you and other participants to break off from the main meeting and discuss different issues in subgroups. Only participants connected to a phone can participate in breakout sessions.

If you are connected to the meeting with a video endpoint, you cannot participate in a breakout session by using the audio and video from your video endpoint. To participate in a breakout session, you must have a separate phone connection to the meeting. In this case, manually mute the audio and pause the video of the video endpoint before moving the phone connection to the breakout session so that participants in the main conference room do not hear and see you on the video endpoint.

**To Move to or from an Audio Breakout Room**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Determine the breakout session that you want to enter (this can be any number from 1 to 9), then tell other participants to meet you in this “room.”</td>
</tr>
<tr>
<td>Step 2</td>
<td>In the Participant List tool, click the <strong>Voice/Video Options</strong> icon (phone and video camera).</td>
</tr>
<tr>
<td>Step 3</td>
<td>Click <strong>Go to Audio Breakout Room</strong>.</td>
</tr>
</tbody>
</table>

**Note** You can access this option only if you are dialed in to the meeting and your phone is associated with your user profile or guest login.

| Step 4 | Click the name of the audio breakout room to attend. Click **Main Conference** to return to the main audio conference room. |

### Tips on Viewing Shared Content in the Meeting Console

When another meeting participant is sharing his or her screen or an application or window on the screen, use the controls at the bottom of the Share tool to assist in viewing the content. Click the Scale to Fit button (window with an arrow) to scale the content being shared to fit to the size of the tool window; or click the Scroll button (window with scroll bar) to enlarge the content and activate a scroll bar so you can scroll up or down and right or left to view hidden areas of the content.

The toolbar may also contain a Full Screen button that allows you to toggle the window to occupy your entire screen, if the presenter has enabled this option.
Meeting Console Layout Controls for Moderators

The Layout menu in the menu bar at the top of the meeting room window and the layout navigation bar at the bottom of the meeting room window are visible only to moderators. A moderator can use either the Layout menu or the navigation bar to switch to a new layout.

By default, a new meeting room contains a number of prebuilt layouts, depending on the meeting template selected for the meeting (for example, the Collaborative template includes Share, Whiteboard, and Share Multiple default layouts). The tools in these layouts are selected and arranged to facilitate sharing of content, discussion of topics, or collaboration with colleagues.

You can switch to another layout by clicking the layout name in the layout navigation bar or the Layout menu. You can also create your own meeting room layouts. When a moderator clicks a different layout on the layout navigation bar, the new layout is displayed on every participant’s screen. In contrast, a moderator in Preparing mode can navigate between meeting room layouts without affecting the participants’ view. This makes it possible for a moderator to edit or prepare meeting room layouts while another participant is presenting.

About Meeting Permissions

Table 6 describes the default meeting permissions with which users enter Cisco Unified MeetingPlace web conferences.

<table>
<thead>
<tr>
<th>Meeting Type</th>
<th>User Type</th>
<th>Default Meeting Permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collaborative</td>
<td>Meeting scheduler and profile users with System Manager privileges</td>
<td>Moderator meeting console permissions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Speaker audio permissions</td>
</tr>
<tr>
<td></td>
<td>All other profile users and guests</td>
<td>Presenter meeting console permissions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Speaker audio permissions</td>
</tr>
<tr>
<td>Presentation</td>
<td>Meeting scheduler and profile users with System Manager privileges</td>
<td>Moderator meeting console permissions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Speaker audio permissions</td>
</tr>
<tr>
<td></td>
<td>All other profile users and guests</td>
<td>Audience meeting console permissions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Speaker audio permissions</td>
</tr>
<tr>
<td>Webinar</td>
<td>Meeting scheduler and profile users with System Manager privileges</td>
<td>Moderator meeting console permissions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Speaker audio permissions</td>
</tr>
<tr>
<td></td>
<td>First two invited profile users</td>
<td>Presenter meeting console permissions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Speaker audio permissions</td>
</tr>
<tr>
<td></td>
<td>All other profile users and guests</td>
<td>Audience meeting console permissions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Listener audio permissions</td>
</tr>
</tbody>
</table>
Note the following considerations:

- When scheduling a meeting by using the Cisco Unified MeetingPlace Web Conferencing Home page, the meeting scheduler can change permissions for profiled users from the default values.
- After a meeting has begun, moderators can change permissions from the default values.
- To have a guest presenter at a webinar, the moderator will need to grant the guest Presenter/Speaker permissions from the meeting console after the meeting has started.
- If a meeting is locked by the moderator, all participants who join after the meeting has been locked will join with Audience meeting console permissions, regardless of the permissions they were assigned when they were invited. When the meeting is unlocked or put in session, these participants will continue to have Audience permissions unless the moderator manually changes their permissions from within the meeting console.

This section contains the following information:

- Changing Audio Permissions for Participants, page 43
- Changing Meeting Console Permissions for Participants, page 43

### Changing Audio Permissions for Participants

The meeting moderator can change the audio permissions for participants to Speaker or Listener. Speakers can speak or listen to the voice component of the meeting; listeners cannot speak.

**To Change Audio Permissions for a Participant**

<table>
<thead>
<tr>
<th>Step 1</th>
<th>In the meeting console Participant List tool, click a participant name. (To change the permissions for multiple participants, hold down the Shift or Control key and click additional participants.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Click the <strong>Change Permissions</strong> icon (person with green arrow).</td>
</tr>
<tr>
<td>Step 3</td>
<td>Choose <strong>Set as Speaker (Voice)</strong> or <strong>Set as Listener (Voice)</strong>.</td>
</tr>
</tbody>
</table>

### Changing Meeting Console Permissions for Participants

The meeting moderator can change meeting console permissions from the default values after a meeting has begun.

Note, however, that if you demote another participant with Moderator permissions to a presenter or audience member, the participant can change his or her permissions back by using the View menu.

**To Change Meeting Console Permissions for a Participant**

<table>
<thead>
<tr>
<th>Step 1</th>
<th>In the meeting console Participant List tool, click a participant name. (To change the permissions for multiple participants, hold down the Shift or Control key and click additional participants.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Click the <strong>Change Permissions</strong> icon (person with green arrow).</td>
</tr>
<tr>
<td>Step 3</td>
<td>Choose <strong>Set as Moderator (Web)</strong>, <strong>Set as Presenter (Web)</strong>, or <strong>Set as Audience (Web)</strong>.</td>
</tr>
</tbody>
</table>
About Menus in the Meeting Console

You can access many in-session features through the menus in the meeting console. These include options that pertain to the user, the meeting, application sharing, and Help.

This section contains the following information:

- Using the Meeting Menu, page 44
- Using the View Menu, page 48
- Using the Layouts Menu, page 49
- Using the Tools Menu, page 49
- Using the Help Menu, page 50

Using the Meeting Menu

Moderators can invite additional participants, record the meeting, and set other options that affect the flow of the meeting for participants by using the Meeting menu. Presenters and audience members can use the Meeting menu to set their connection speed, change their meeting room window to full screen, or exit the meeting. Table 7 describes options available from the menu.

Table 7  Descriptions of Meeting Menu Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invite Participants</td>
<td>Generates a URL that you can send to invite additional meeting participants. Also allows you to compose an e-mail message containing the URL and other meeting information to send to new invitees.</td>
</tr>
<tr>
<td>Record Meeting</td>
<td>Allows you to start recording your meeting, as long as recording space is available. Both the audio conference (if applicable) and the meeting console activity are recorded. To stop recording, choose this option again or click Stop Recording in the pop-up box that appears when you start your recording. Note Continuous meetings cannot be recorded.</td>
</tr>
<tr>
<td>Move Audience/Listeners to Waiting Room</td>
<td>Moves users with Audience meeting console permissions and users with Listener audio permissions to a waiting room (moderators and presenters are not moved). Participants cannot speak with each other while in the waiting room. Video participant displays are also blocked while in the waiting room.</td>
</tr>
<tr>
<td>Announcement Options</td>
<td>Allows you to modify the meeting entry and departure announcement options for participants and the end-of-meeting and meeting extension announcement options. Tip If you are in a large meeting that is set to announce each participant upon entry, choose this option to change the entry announcement to Silent.</td>
</tr>
<tr>
<td>Lock Meeting</td>
<td>Allows you to lock or unlock your meeting. Locking your meeting restricts your meeting from any future access. This setting applies to both the audio conference (if applicable) and the meeting console.</td>
</tr>
<tr>
<td>End Meeting</td>
<td>Allows you to end your meeting and specify a post-meeting message or URL to display to participants when leaving the meeting console.</td>
</tr>
</tbody>
</table>
Recording Meetings from the Meeting Console

The information in this section only applies to Cisco Unified MeetingPlace meetings. For information about recording a Cisco WebEx meeting, see Recording Cisco WebEx Meetings, page 25.

Table 7 Descriptions of Meeting Menu Options (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Optimize Room Bandwidth (available for moderators only) | Allows you to select a meeting room bandwidth level to determine the speed (kilobits per second) at which data from the meeting is sent to participants.  
**Tip** Choose a room bandwidth that matches the connection speed used by participants. If participants are using a variety of connection speeds, choose the lowest speed that participants may be using. For example, if some participants are using modems, choose Modem for room bandwidth to ensure that all participants have a good connection. (To determine the speed of a participant connection, mouse over the participant name in the Participant List tool.) |
| Room Background (available for moderators only) | Allows you to set a picture or animation as the background for the meeting room. You choose the background image from the list of attachments that have been loaded for the meeting (either from the Attachments page in the scheduling interface or from the Sharing tool). Only the meeting moderator can set the room background. |
| Auto-Promote Audience to Presenters (available for moderators only) | Gives Presenter permissions to all meeting participants with Audience permissions. Guests and profile users that enter the meeting room after you select this option will also be automatically promoted to Presenter permissions. |
| Room Screen Resolution (available for moderators only) | Controls the resolution at which the meeting room is displayed for all participants. |
| My Connection Speed | Allows you to choose your connection speed for the meeting based on the type of internet connection you have. This ensures that data from the meeting will be delivered at a speed appropriate for your system. |
| Full Screen | Changes the meeting console to occupy your entire desktop. If you choose this option while it is already selected, the meeting console returns to a window display. |
| Exit Cisco Unified MeetingPlace | Closes the meeting console window without ending the meeting. |

This section contains the following information:

- Recording Meetings from the Meeting Console, page 45
- Setting the Meeting Extension Announcement from the Meeting Console, page 46
- Changing Meeting Announcements, page 46
- Locking and Unlocking Meetings, page 47
- Ending Meetings, page 47
- Changing the Room Background, page 47
- Leaving Meetings, page 48
If your system is configured for both audio and web recording, Cisco Unified MeetingPlace Web Conferencing can record the voice stream and everything that happens in the meeting room, except for activity in the Presenter Only Area. It does not record broadcast prompts, such as “Now joining” or “Now departing,” or video-conferencing displays.

**To Record a Meeting from the Meeting Console**

**Step 1** On the Meeting menu in the meeting console, click **Record Meeting**. The Record Meeting dialog box is displayed. Enter the meeting name in the **Name** field, the meeting ID in the **ID** field and meeting details in the **Summary** field. Click **OK**.

Recording will not start if there is not enough disk space to store the recording.

**Step 2** To stop recording, on the Meeting menu, click **Record Meeting** again.

**Setting the Meeting Extension Announcement from the Meeting Console**

The meeting moderator can configure whether the system announces to participants that the meeting has been automatically extended.

If you have a video-conferencing component to your meeting, the system extends your meeting based on available video capacity. If either existing audio or existing video ports cannot be extended, then the entire meeting will be terminated.

**To Set the Meeting Extension Announcement from the Meeting Console**

**Step 1** On the Meeting menu in the meeting console, click **Announcement Options**.

**Step 2** For Meeting extension, choose **Yes**, then click **OK**.

**Step 3** Close the Announcement Options window.

**Changing Meeting Announcements**

This feature is available only to meeting moderators.

**To Change Meeting Announcements**

**Step 1** On the Meeting menu in the meeting console, click **Announcement Options**.

**Step 2** Modify your announcement settings by choosing options from the applicable lists.

**Step 3** Click **OK**.

**Step 4** Close the window.
Locking and Unlocking Meetings

At any time during a meeting, the meeting moderator can lock it to restrict further access. This feature locks both the audio and web conferences from all users. After a meeting is locked, users can request entry by phone or by attempting to join the meeting from the web.

To Lock or Unlock a Meeting

**Step 1** On the Meeting menu in the meeting console, click **Lock Meeting**. The **Lock Meeting** dialog box is displayed.

**Step 2** (Optional) To allow incoming Web participants to request entry to the meeting, check **Incoming Web participants can request entry**.

**Step 3** To unlock your meeting, on the Meeting menu, click **Unlock Meeting**.

**Step 4** Click **OK**, to confirm your choice. If you chose Lock Meeting, users receive the message “This meeting is currently in session and locked. Entry for incoming participants has been blocked.”

Ending Meetings

This feature is available only to meeting moderators.

To End a Meeting

**Step 1** On the Meeting menu in the meeting console, click **End Meeting**.

**Step 2** (Optional) Edit or replace the message that is displayed to participants when the meeting ends.

**Step 3** (Optional) To have participant browsers redirect to a specific web page after the meeting ends, check **Open this URL for Participants** and enter a URL in the text box.

**Step 4** Click **OK** to confirm your choice. Users receive the message “This meeting has ended. Thank you for attending.” All meeting endpoints (audio, web, video) are disconnected.

Changing the Room Background

The meeting moderator can set a JPEG image (.jpg file extension) or Flash file (.swf file extension) as the meeting console background for all participants.

**Note** Progressive-scan JPEG files are not supported as room backgrounds.

To Change the Room Background

**Step 1** Upload an image or Flash file to the meeting console, either by using the Attachments/Recordings link on the Meeting Details page, or by opening the file in the Share tool.

**Step 2** On the Meeting menu in the meeting console, click **Change Room Background**.

**Step 3** Click **Select Room Background**.
Step 4  In the Browse Content pop-up box, click the **Uploaded Content** button to view the list of available files.

Step 5  Click the name of a file, then click **Open**. The room background updates to display the image.

---

**Leaving Meetings**

Do the following procedure to close the meeting console and leave the meeting. Meetings continue on any media (audio, web, and video) as long as at least two people are still connected to their media endpoints.

**To Leave a Meeting**

Step 1  On the Meeting menu in the meeting console, click **Exit Cisco Unified MeetingPlace**. This disconnects your web session and your video endpoint. It does not disconnect your phone.

Step 2  Close your web browser.

Step 3  To disconnect from the audio portion of the meeting, hang up your phone.

---

**Using the View Menu**

The View menu is available to meeting moderators. **Table 8** describes the options available on the View menu.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Moderator View</td>
<td>Switches between meeting console views, allowing the moderator to see the view that presenters or audience members see.</td>
</tr>
<tr>
<td>Presenter View</td>
<td></td>
</tr>
<tr>
<td>Audience View</td>
<td></td>
</tr>
<tr>
<td>Show Presenter Only Area</td>
<td>Allows you to toggle viewing of the <strong>Presenter Only Area</strong>. The Presenter Only Area has a striped background to distinguish it from the rest of the meeting console.</td>
</tr>
<tr>
<td>Preparing Mode</td>
<td>Allows you to navigate between meeting room layouts without affecting the views of meeting participants. This makes it possible to edit or prepare meeting layouts while another participant is presenting. For example, you enter Preparing Mode, switch to the Whiteboard layout, resize the Whiteboard tool and add a new Poll tool to the console, then switch out of Preparing Mode and use the Whiteboard layout later in the meeting.</td>
</tr>
<tr>
<td>Moderator Cursors</td>
<td>Controls who can see the cursors that represent the mouse movements by each moderator in the meeting console, and when they can be seen. The choices are:</td>
</tr>
<tr>
<td></td>
<td>• Off</td>
</tr>
<tr>
<td></td>
<td>• Show Only to Other Moderators</td>
</tr>
<tr>
<td></td>
<td>• Show to All Participants</td>
</tr>
<tr>
<td></td>
<td>• Show to All Participants when using a Whiteboard</td>
</tr>
</tbody>
</table>
Using the Layouts Menu

The Layouts menu is available to meeting moderators. Table 9 describes the options available on the Layouts menu.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Layout</td>
<td>Creates a new layout. You can create a new blank layout or copy an existing layout.</td>
</tr>
<tr>
<td>Share</td>
<td>Selects the currently active layout.</td>
</tr>
<tr>
<td>Whiteboard</td>
<td>The predefined templates include the following predefined layouts:</td>
</tr>
<tr>
<td>Share Multiple</td>
<td>- Collaborative—Share, Whiteboard, Share Multiple</td>
</tr>
<tr>
<td>Open Polls</td>
<td>- Presentation—Share, Whiteboard, Open Polls, Wrap Up</td>
</tr>
<tr>
<td>Wrap Up</td>
<td>- Webinar—Share, Open Polls, Wrap Up</td>
</tr>
<tr>
<td>[Other Layout Name]</td>
<td>If you have created additional new layouts, you will also see those layouts listed here.</td>
</tr>
<tr>
<td>Organize Layouts</td>
<td>Allows you to rename or delete an existing layout, or change the order in which layouts appear in the layout navigation bar.</td>
</tr>
</tbody>
</table>

Using the Tools Menu

The Tools menu is available to moderators; it lets moderators add tools and content to a layout, and organize and lock existing tools. Table 10 describes the options available on the Tools menu.

---

**Note**  
When you create a new tool, the tool displays in the current layout. If the Presenter Only Area is displayed when you create the tool, the tool is created in this area. To make the tool visible to audience members, drag and drop it out of the Presenter Only Area and onto the stage.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Share</td>
<td>Allows you to show or hide an existing share tool or whiteboard to display in the current layout, to create a new share tool or whiteboard, or to select content to share in the currently active tool.</td>
</tr>
<tr>
<td>Participant List</td>
<td>Allows you to show or hide the participant list in the current layout.</td>
</tr>
<tr>
<td>Chat</td>
<td>Allows you to show or hide an existing chat tool or presenter chat, or to create a new chat tool. The Presenter Only Area must be displayed on your meeting console to toggle the presenter chat.</td>
</tr>
<tr>
<td>Note</td>
<td>Allows you to toggle (show or hide) an existing note tool, presenter notes, or discussion notes, or to create a new note tool. The Presenter Only Area must be displayed on your meeting console to toggle the presenter notes or discussion notes.</td>
</tr>
<tr>
<td>Poll</td>
<td>Allows you to toggle (show or hide) an existing poll tool or to create a new poll tool.</td>
</tr>
<tr>
<td>File Share</td>
<td>Allows you to toggle (show or hide) an existing file share tool or to create a new file share tool.</td>
</tr>
<tr>
<td>Web Links</td>
<td>Allows you to toggle (show or hide) an existing web links tool or to create a new web links tool.</td>
</tr>
<tr>
<td>Q &amp; A</td>
<td>Allows you to toggle (show or hide) the Q &amp; A tool. The Presenter Only Area must be displayed on your meeting console to toggle the Q &amp; A tool.</td>
</tr>
</tbody>
</table>
Using the Help Menu

Table 11 describes the options available on the Help menu.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco Unified MeetingPlace Help</td>
<td>Launches the online Help application.</td>
</tr>
<tr>
<td>Browser Test</td>
<td>Launches the Browser Test page where you can check the compatibility of your web browser and operating system with the meeting console, your browser configuration, and the speed of your network connection.</td>
</tr>
<tr>
<td>About Cisco Unified MeetingPlace</td>
<td>Displays information about your Cisco Unified MeetingPlace environment, including the version of the Cisco Unified Presenter Add-in you are using (if any) and the version of Cisco Unified MeetingPlace Web Conferencing.</td>
</tr>
</tbody>
</table>

Working with Tools

Meeting moderators can show, hide, add, delete, rearrange, and organize tools. For all tools except the Participant List tool, more than one instance of a tool can be displayed in a meeting at one time.

This section contains the following information:

- Showing or Hiding a Tool, page 50
- Adding a Tool, page 51
- Moving or Resizing a Tool, page 51
- Renaming or Deleting a Tool, page 51

Showing or Hiding a Tool

To Show or Hide a Tool

**Step 1**

On the Tools menu in the meeting console, click the name of the tool to show. A check mark appears next to the name of tools that are currently visible in the meeting.

To hide a tool, click the tool name again, or click the **Hide** icon (the minus sign) on the right side of the tool title bar.

**Step 2**

For tools that can have multiple instances (all tools except the Participant List tool), to show or hide a specific instance of the tool, in the Tools menu, click the instance name on the tool submenu.
Adding a Tool

To Add a Tool

Step 1  On the Tools menu in the meeting console, click the name of a tool.
Step 2  On the tool submenu, click New [tool name].

Moving or Resizing a Tool

To Move or Resize a Tool

Step 1  On the Tools menu in the meeting console, click Move And Resize Tools. A check mark appears next to the option when it is selected.
Step 2  To move a tool, drag it by the title bar at the top of the tool. To resize a tool, drag the lower-right corner.

To Display a Tool at Full-Screen Size

Step 1  At the right side of the tool title bar, click the Full Screen button (the screen icon).
Step 2  To restore the tool to its original size, click Full Screen again.

Renaming or Deleting a Tool

To Rename or Delete a Tool

Step 1  On the Tools menu in the meeting console, click Organize Tools.
Step 2  Choose the applicable option:

<table>
<thead>
<tr>
<th>To delete one or more tools</th>
<th>Click the tool(s) in the pane on the left, and click Delete.</th>
</tr>
</thead>
<tbody>
<tr>
<td>To rename a tool</td>
<td>a. Select the tool in the pane on the left, and click Rename.</td>
</tr>
<tr>
<td></td>
<td>b. Enter a new name in the Rename Tool dialog box, and click OK.</td>
</tr>
<tr>
<td>To locate all unused tools</td>
<td>Click Select Unused, and click Delete to delete all unused tools.</td>
</tr>
</tbody>
</table>
Step 3  When you are finished, click Done.
About the Share Tool

As a moderator or presenter, you can use the Share tool to share a variety of content with participants in a meeting, including the following:

- Selected items on your computer screen, including one or more open windows, one or more open applications, or the entire desktop.
- A document, such as a Microsoft PowerPoint presentation, Flash content (SWF files), a JPEG file, or a file in another format.
- A whiteboard with a variety of writing and drawing tools. You can share a stand-alone whiteboard or a whiteboard overlay that appears on top of other shared content.

This section contains the following information:

- Presenting and Working with Shared Content, page 52
- Sharing Your Screen, page 53
- Sharing a Document, page 55
- Sharing a Presentation, page 57
- Sharing a Whiteboard, page 60

Presenting and Working with Shared Content

Presenters and moderators must install the Cisco Unified Presenter Add-in the first time they attempt to upload content or share a screen. The add-in provides support for uploading files to the server and sharing screens during a meeting.

Note: If you have a pop-up blocker enabled in your browser, the dialog box for downloading the add-in will not appear. To correct this problem, temporarily disable the pop-up blocker.

Note the following considerations when presenting or sharing content:

- When you share content in the Share tool, participants see your pointer move in the Share tool window. All activities you perform in a shared window, application, or document are visible to participants.
- Avoid constant scrolling through your application. When you do need to move your document, use the Page Up and Page Down keys on your keyboard. Participants can scroll through the visible portion of your document from their own desktops for better viewing.
- Do not cover your shared application with other windows. If you do, participants will see a box with a cross-hatched pattern in place of the application until the application is uncovered.
- Use simple meeting etiquette by verbalizing your intentions and requests. (For example, let people know that you will be enabling collaboration. Likewise, let the meeting host know that you would like to take control of a document.)
- Web Conferencing does not support the sharing of video applications or streams. If you try to share a video stream from your desktop, participants will see only some of the frames from the video, displayed at the screen-sharing refresh rate. If you try to load a PowerPoint file with video embedded on the slide page in the Share tool, the presentation conversion will fail and you will not be able to display the presentation.
Sharing Your Screen

As a moderator or presenter in a meeting, you can share windows, applications, or your entire desktop with participants in a meeting. You can also allow other participants to take control of your screen.

When you share anything on your computer screen, actions you take in the shared region are visible to all participants in the meeting. Your viewers follow the progress of your pointer as you move it across your screen.

The region or regions that you share must be visible on your desktop in order to be visible in the Share tool to other participants. Overlapping windows on the desktop appear as a blue cross-hatched pattern in the Share tool.

You can also display a whiteboard over a shared screen to enable participants to add annotations.

This section contains the following information:
- Best Practices for Screen Sharing, page 53
- Sharing Your Computer Screen, page 53
- Sharing Control of Your Screen with Another Presenter, page 54
- Requesting Control of a Shared Screen, page 54
- Previewing Your Shared Screen, page 55

Best Practices for Screen Sharing

In order to conserve network bandwidth for large meetings or when there are participants with slow Internet connections, consider the following practices when sharing your screen:

- Whenever possible, avoid sharing the entire screen. Instead, share an individual application or window.
- If you do need to share your entire desktop, we strongly recommend that you do not use any intricate backgrounds as your desktop image. Desktop images with lots of colors inevitably result in wasting valuable bandwidth on rendering nonessential screen information.
- Reduce your screen resolution to 1024 x 768 or less and, if possible, reduce the color quality from millions of colors to 16- or 32-bit color. In general, setting your resolution to 1024 x 768 pixels allows most participants (even notebook users) to optimally view your shared application or document.
- If possible, do not use two computers on the same Internet connection (for example, one computer to share a presentation and another to see the audience view) unless the connection rate is T1 or higher.

Sharing Your Computer Screen

Linux and Unix users cannot share their screens.
To Share Your Computer Screen

Step 1
With a blank Share tool open in a meeting, click My Computer Screen.

Or
Click the Share button on the Share tool control strip, then click My Computer Screen.

The Start Screen Sharing window appears.

Step 2
Choose the applicable option:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Desktop</td>
<td>Use to share your entire desktop. If you have more than one monitor connected to your computer, a desktop appears for each monitor. Choose the desktop that you want to share.</td>
</tr>
<tr>
<td>Windows</td>
<td>Use to share one or more windows that are open on your computer. Choose the window or windows that you want to share.</td>
</tr>
<tr>
<td>Applications</td>
<td>Use to share an application and all its related windows that are open on your computer. Choose the application or applications that you want to share.</td>
</tr>
</tbody>
</table>

Step 3
Click Share to begin sharing.

Step 4
(Optional) To view the application in the meeting console the way other meeting participants are viewing it or to add an overlay whiteboard for annotation, click the Cisco Unified MeetingPlace icon (red bar) in the system tray and choose Pause and Annotate. Click Resume Sharing to exit annotation mode.

Step 5
When you finish sharing, click the Cisco Unified MeetingPlace icon and choose Stop Screen Sharing.

Sharing Control of Your Screen with Another Presenter

While screen sharing, you can pass control of the shared desktop, window, or application to another presenter. The presenter must request control before you can hand over your shared screen to them.

To Share Control of Your Screen with Another Presenter

Step 1
Start sharing your computer screen in a meeting. When another presenter requests control of your screen, you see a request message in the upper-right corner of the meeting room window.

Step 2
Choose the applicable option:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept</td>
<td>Use to grant control of your screen to the requesting participant.</td>
</tr>
<tr>
<td>Decline</td>
<td>Use to deny control of your screen to the participant.</td>
</tr>
</tbody>
</table>

Requesting Control of a Shared Screen

As a moderator or presenter, you can request control of the screen of another presenter or moderator.
To Request Control of a Shared Screen

**Step 1**
Click **Request Control** on the Share tool control strip.

If the request is accepted, a message informs you that you have been granted control of the screen. The Request Control button becomes a Release Control button. You can now take control of the shared screen.

**Step 2**
To return control of the shared screen to the original presenter, click **Release Control** on the Share tool control strip.

Previewing Your Shared Screen

When sharing an application, window, or desktop on your computer, you can select the Preview option to show the same view that participants see in their Share tool.

**To Preview Your Shared Screen**

In the Share tool, in the lower-right corner, click the **More Options** icon (gear with arrow), then click **Preview in Tool While Screen Sharing**.

Or

Click the **Preview** icon (eyeglasses).

Sharing a Document

As a moderator or presenter in a meeting, you can share documents that have been uploaded as meeting attachments, or share documents directly from your computer.

If you turn off sharing, change the content in a Share tool, or close the Share tool, the document is still part of the meeting room and can be displayed again. If you delete a Share tool, the document is deleted from the meeting room. (If you uploaded it as a meeting attachment from the Attachments/Recordings link on the Meeting Details page previously, it is still available there.) To edit a shared document, you must edit the source document and reload it into the meeting.

Documents shared in the Share tool can be viewed but not downloaded by participants. In order to enable participants to download documents, a moderator or presenter must upload the documents to the File Share tool.

This section contains the following information:

- Types of Documents that Can Be Shared in the Share Tool, page 56
- Sharing a Document from the Meeting Attachments, page 56
- Sharing a Document from Your Computer, page 56
- Turning Off Display Synchronization for Multiframe Documents, page 57
Types of Documents that Can Be Shared in the Share Tool

The following document types can be shared in the Share tool, either from meeting attachments or from your computer:

- A single PowerPoint file (.ppt file extension).
- A single file with Flash content (.swf file extension).
- A single JPEG image (.jpg file extension).
- A ZIP file that contains a single PowerPoint file.
- Adobe Presenter content packaged as a ZIP file.

PowerPoint files are converted to presentations. PowerPoint presentations can include animations and audio voiceovers. When you share a presentation, the Share tool displays controls for navigating the presentation. Note the following restrictions when you are uploading a document to share as a presentation in the Share tool:

- Files created in PowerPoint 2007 cannot be converted and shared as presentations in the Share tool. To share a PowerPoint 2007 file, you must share the PowerPoint application from your desktop.
- Files created in versions older than PowerPoint 2000 cannot be converted and shared as presentations in the Share tool. To share an older PowerPoint file, you should open the file in PowerPoint 2000 or later and save the file before uploading it to the Share tool.

Sharing a Document from the Meeting Attachments

A moderator or presenter can load PowerPoint presentations, Flash content (SWF files), JPEG files, or ZIP files from the meeting attachments stored on the server into a Share tool in a meeting.

To Share a Document from the Meeting Attachments

**Step 1** In the Share tool, click **Documents**.
Or
On the menu bar in the meeting console, click **Tools > Share**.
Or
On the control strip at the bottom of the Share tool, click **Share > Documents**.

**Step 2** Click **Select From Attachments**.
The Browse Content window appears.

**Step 3** Click **Uploaded Content**. The content that has been uploaded for the current meeting appears.

**Step 4** Select the document that you want to share, and click **Open**.
The selected document appears in the Share tool. The document name appears in the title bar of the tool.

Sharing a Document from Your Computer

As moderator or presenter, you can load PPT, SWF, JPEG, or ZIP files from your computer into a Share tool. The files are uploaded to the server.
To Share a Document from Your Computer

**Step 1**
In the Share tool, click **Documents**.
Or
On the menu bar in the meeting console, click **Tools > Share**.
Or
On the control strip at the bottom of the Share tool, click **Share > Documents**.

**Step 2**
Click **Select from My Computer** on the pop-up menu. A Browse Content dialog box appears.

**Step 3**
Select the document that you want to share, and click **Open**. The selected document appears in the Share tool. The document name appears in the title bar of the tool. The document is added to the Uploaded Content folder associated with the meeting room.

### Turning Off Display Synchronization for Multiframe Documents

By default, Cisco Unified MeetingPlace synchronizes display of multiframe documents so that participants see the frame that the presenter sees. A moderator or presenter can use the Sync button to turn off synchronization so that viewers can move through presentations at their own pace.

**Note**
The Sync button appears only when you have multiframe content loaded in the Share tool.

**To Turn Off Display Synchronization for Multiframe Documents**

**Step 1**
In the Share tool window, with content loaded, click the **Sync** button (Sync is on by default). Controls for presentation playback appear at the right of the Share tool.

**Step 2**
Click the **Sync** button again to turn off synchronization and allow participants to advance through presentations at their own pace.

### Sharing a Presentation

For moderators or presenters who share a Microsoft PowerPoint presentation in the Share tool, special controls are available for navigating and displaying the presentation. A presentation layout has the following areas:

| Presentation | The main part of the window, which displays the presentation slides. |
**Presentation sidebar**
An area on the right side (default location) of the browser window that shows the name of the presentation, the presenter information, and the Outline, Notes, and Search tabs (if the tabs were included when the Presentation was created).

**Presentation toolbar**
A control bar at the bottom of the presentation that gives you control over the presentation playback, audio, attachments, and screen size. This is visible to moderators only, unless a moderator chooses to display it to participants.

This section contains the following information:

- Using the Presentation Outline Tab, page 58
- Viewing Presentation Slide Notes, page 58
- Searching for Text in a Presentation, page 59
- Presentation Playbar Options, page 59

**Using the Presentation Outline Tab**

Most presentations have an Outline tab on the sidebar. The Outline tab lists the title and duration of each slide. You can use the Outline tab to display information and to move to a specific slide in the presentation. The current slide is highlighted with a glow color, which you can change in the theme. You can choose to display the highlight outline to all participants, or to moderators and presenters only.

**To Use the Presentation Outline Tab**

<table>
<thead>
<tr>
<th>Step 1</th>
<th>To show the sidebar if it is not displayed, click the <strong>Show/Hide Sidebar</strong> icon (box with two panes).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Click the <strong>Outline</strong> tab in the sidebar at the right.</td>
</tr>
<tr>
<td>Step 3</td>
<td>To move to a slide in the presentation, click the slide title in the Outline tab.</td>
</tr>
<tr>
<td>Step 4</td>
<td>To show the slide title, move the pointer over the title.</td>
</tr>
</tbody>
</table>

**Viewing Presentation Slide Notes**

When creating a presentation in PowerPoint, you can enter notes for individual slides. If any slide notes exist, they can be displayed in the presentation. Slide notes appear on the right side of the presentation window. You cannot change the size of the slide Notes tab.

**To View Presentation Slide Notes**

<table>
<thead>
<tr>
<th>Step 1</th>
<th>To show the sidebar if it is not displayed, click the <strong>Show/Hide Sidebar</strong> icon (box with two panes).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Click the <strong>Notes</strong> tab in the sidebar on the right side. The complete notes text is displayed. The text is unformatted and cannot be edited directly on the tab.</td>
</tr>
</tbody>
</table>
Searching for Text in a Presentation

To Search for Text in a Presentation

1. To show the sidebar if it is not displayed, click the **Show/Hide Sidebar** icon (box with two panes).
2. Click the **Search** tab in the sidebar on the right side.
3. Type the text to search for directly into the text box.
4. Click the **Search** button. Search results are displayed below the text box. Click any slide title in the results list to display that slide.

Presentation Playbar Options

If your PowerPoint presentation includes audio or video embedded by using Adobe Presenter, you can control the presentation appearance and playback by using the presentation playbar located at the bottom of the presentation.

To show the presentation playbar if it is not displayed, in the Share tool, click the More Options icon (gear with arrow), then click Show Presentation Playbar.

The following options are available on the playbar:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play/Pause button</td>
<td>Pauses and resumes play of the current slide.</td>
</tr>
<tr>
<td>Back button</td>
<td>Moves to the previous slide in the presentation.</td>
</tr>
<tr>
<td>Forward button</td>
<td>Moves to the next slide in the presentation.</td>
</tr>
<tr>
<td>Slide progress bar</td>
<td>Shows and controls the playback location within the current slide. The position marker moves as the slide plays. You can drag the marker arrow forward or back in the current slide to change your playback location. You can also click a specific location on the progress bar to move the slide marker position and slide playback there.</td>
</tr>
<tr>
<td>Current slide number</td>
<td>Shows the number of the currently displayed slide and the total number of slides (for example, slide 2 of 10).</td>
</tr>
<tr>
<td>Status</td>
<td>Shows the status of the current slide, such as Playing, Stopped, No Audio, or Presentation complete.</td>
</tr>
<tr>
<td>Time</td>
<td>Shows the current slide time and the total slide time as the slide plays (for example, 00.02/00.05).</td>
</tr>
<tr>
<td>Audio volume</td>
<td>Shows the volume level that is set for the slide.</td>
</tr>
<tr>
<td>Attachments</td>
<td>Displays a small window showing any attachments (for example, documents, spreadsheets, images, URLs) that have been added.</td>
</tr>
<tr>
<td>Show/Hide sidebar</td>
<td>Shows or hides the sidebar.</td>
</tr>
</tbody>
</table>
Sharing a Whiteboard

As a moderator or presenter, you can use a whiteboard to create collaborative text, drawings, and other annotations in a meeting. You can use a whiteboard in two different ways in a Share tool:

- A stand-alone whiteboard allows presenters to create content on a white background.
- An overlay whiteboard allows presenters to create content over an existing document in a Share tool, adding annotations to and drawing on the document. You can lay a whiteboard over presentations, JPGs, and SWFs.

If you turn off sharing, change the content in a Share tool, or close the Share tool, the whiteboard is still part of the meeting room and can be displayed again. If you delete a Share tool, the whiteboard is deleted.

This section contains the following information:

- Creating a Stand-Alone Whiteboard in a Blank Share Tool, page 60
- Adding an Overlay Whiteboard Over a Document or a Shared Screen in a Share Tool, page 60
- Displaying an Existing Whiteboard, page 61
- Clearing a Whiteboard, page 61
- Navigating Between Multiple Whiteboard Pages, page 61
- Whiteboard Drawing Tools, page 62

Creating a Stand-Alone Whiteboard in a Blank Share Tool

To Create a Stand-Alone Whiteboard in a Blank Share Tool

**Step 1**
In the Share tool, click **Whiteboards**.

Or

On the menu bar in the meeting console, click **Tools > Share**.

Or

On the control strip at the bottom of the Share tool, click **Share**.

**Step 2**
Click **New Whiteboard**. A blank whiteboard appears in the tool.

Adding an Overlay Whiteboard Over a Document or a Shared Screen in a Share Tool

To Add an Overlay Whiteboard Over a Document or a Shared Screen in a Share Tool

**Step 1**
In a Share tool, display the document.
Step 2  Click the Whiteboard Overlay icon (rectangle with pencil) in the Share tool control strip.
Or
Click the More Options icon (gear with arrow) in the lower-right corner of the Share tool, then click Whiteboard Overlay.
Or
In the upper-right corner of the window of the application you are sharing, click the arrow next to the red Stop Sharing button, then click Pause and Annotate.
Or
If you are sharing your entire desktop, click the Cisco Unified Presenter Add-in icon (red door) in the system tray (Windows) or icon bar (Macintosh), then click Pause and Annotate.

Displaying an Existing Whiteboard

To Display an Existing Whiteboard

Step 1  On the menu bar in the meeting console, click Tools > Share.
Or
On the control strip at the bottom of the Share tool, click Share > Whiteboards.
Step 2  Select the name of the whiteboard that you want to display.

Clearing a Whiteboard

To Clear a Whiteboard

Press Control-D or click Clear. (If you need to undo clearing the whiteboard, press Control-Z.)

Navigating Between Multiple Whiteboard Pages

A stand-alone whiteboard is composed of multiple pages. If you need to present multiple whiteboard pages during a meeting, you can use the forward and back arrow buttons to move between pages.

To Navigate Between Multiple Whiteboard Pages

Step 1  Click the Whiteboard Toolbar button. The page number and next and previous buttons appear in the toolbar.
Step 2  Choose the applicable option:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right-pointing arrow</td>
<td>To display the next page.</td>
</tr>
<tr>
<td>Left-pointing arrow</td>
<td>To display the previous page.</td>
</tr>
</tbody>
</table>

### Whiteboard Drawing Tools

Table 12 lists the tools that are available to create text and drawings on the whiteboard. To view the tools, click the Whiteboard Tools icon (box with pencil) in the lower right corner of the whiteboard tool.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Icon Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Selection tool" /></td>
<td>Selection tool</td>
<td>Selects a shape or area of the whiteboard. Click a shape to select it. Drag on the whiteboard or content to create a selection rectangle that selects all the shapes within the rectangle. The selection rectangle has eight control points for resizing the selected shape or shapes. Shift-drag a corner control point to maintain the aspect ratio when you resize. Select and drag a shape to move it. To add a shape to the selection, Shift-click the shape.</td>
</tr>
<tr>
<td><img src="image" alt="Pencil tool" /></td>
<td>Pencil tool</td>
<td>Creates a free-form line. You can customize stroke color and stroke weight by using the color picker and stroke weight pop-up menu at the lower part of the Whiteboard tool.</td>
</tr>
<tr>
<td><img src="image" alt="Marker tool" /></td>
<td>Marker tool</td>
<td>Creates a free-form thick marker line. You can customize stroke color and stroke weight by using the color picker and stroke weight pop-up menu at the lower part of the Whiteboard tool.</td>
</tr>
<tr>
<td><img src="image" alt="Line tool" /></td>
<td>Line tool</td>
<td>Draws a straight line between two points. You can customize stroke color and stroke weight by using the color picker and line width pop-up menu at the lower part of the Whiteboard tool. You can create arrows by using the arrow buttons at the lower part of the Whiteboard tool. Holding down the Shift key while drawing makes the line snap every 45 degrees.</td>
</tr>
<tr>
<td><img src="image" alt="Rectangle tool" /></td>
<td>Rectangle tool</td>
<td>Creates square and rectangle shapes. You can customize stroke color, fill color, and stroke weight by using the color picker and the stroke weight pop-up menu. You can use No Fill as a setting for stroke color and fill color; however, you cannot use No Fill for both stroke color and fill color. Drag to expand the shape. Hold down the Shift key while drawing to make the rectangle a square.</td>
</tr>
<tr>
<td><img src="image" alt="Ellipse tool" /></td>
<td>Ellipse tool</td>
<td>Creates circle and ellipse shapes. You can customize stroke color, fill color, and stroke weight by using the color picker and stroke weight pop-up menu. Drag to expand the shape. Hold down the Shift key while drawing to make the ellipse a circle.</td>
</tr>
<tr>
<td><img src="image" alt="Text tool" /></td>
<td>Text tool</td>
<td>Creates a floating multiline text field. You can customize fill color, font face, and font size by using the color picker, font pop-up menu, and font size pop-up menu. Drag to create a text area where you can type.</td>
</tr>
<tr>
<td><img src="image" alt="Stamper tool" /></td>
<td>Stamper tool</td>
<td>Leaves a check mark, arrow, star, or cross on the screen. A check mark is the default stamp. You can change the stamp image by clicking the arrow, star, check mark, and cross buttons. You can customize image color and shape size by using the color picker and size pop-up menu.</td>
</tr>
</tbody>
</table>
### About the Participant List Tool

The Participant List tool displays the name, role, and status of each participant who is logged in to a meeting, and indicates who is currently speaking. Participants can communicate with presenters by displaying their participant status next to their name (for example, “I have a question,” “Go faster,” or “Go slower”).

When a meeting includes audio or video, participants can dial out to enter the phone or video conference, set video options, move to a breakout room, and mute their phone or pause their video.

The meeting moderator can use the Participant List tool to manage meeting attendance, change participant permissions, move selected participants to a breakout room, and mute and unmute participants.

Profile users who logged in to Cisco Unified MeetingPlace Web Conferencing are listed by their full name in the Participant List tool, as it is registered in Cisco Unified MeetingPlace. If a participant is logged in to a meeting as a guest, the name in the Participant List tool is the name that the guest entered at login followed by “(Guest).” Participants who joined the meeting over the phone with no associated web session are listed as “Guest User (<Caller ID>.)”

This section contains the following information:

- Attendance Icons in the Participant List, page 64
- Viewing or Changing Meeting Console Permissions, page 64
- Dialing Out to Meeting Participants, page 65
- Audio Breakout Rooms, page 66
- Muting Audio for Participants, page 67
- Muting Audio for All Participants from the Meeting Console, page 68
- Placing Participants in the Waiting Room, page 68
- Merging Two Listings for the Same Participant, page 69
- Changing Enhanced Rights for Participants, page 69
- Renaming a Participant, page 69

---

<table>
<thead>
<tr>
<th>Icon</th>
<th>Icon Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="" alt="Undo Icon" /></td>
<td>Undo</td>
<td>Undoes the previous action. You can undo the following actions: drawing a shape, moving a shape, resizing a shape, clearing the whiteboard, and changing a shape’s property. There is no limit to the number of times that you can perform this operation in the tool.</td>
</tr>
<tr>
<td><img src="" alt="Redo Icon" /></td>
<td>Redo</td>
<td>Repeats the previous action.</td>
</tr>
<tr>
<td><img src="" alt="Clear Icon" /></td>
<td>Clear</td>
<td>Deletes everything on the whiteboard.</td>
</tr>
<tr>
<td><img src="" alt="Print Icon" /></td>
<td>Print</td>
<td>Prints the contents of a whiteboard. If you have Adobe Acrobat Professional installed, you can print the whiteboard contents to a PDF file for archiving.</td>
</tr>
</tbody>
</table>
About the Participant List Tool

- Removing Participants from a Meeting, page 70
- Changing Participant Status, page 70
- Displaying Connection Status Indicators, page 71

Attendance Icons in the Participant List

Table 13 describes the icons that are displayed in the Participant List tool.

Table 13 Descriptions of Attendance Icons on the Participants Tab

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="icon" alt="Moderator" /></td>
<td>Indicates that the participant is connected to the web conference with Moderator permissions.</td>
</tr>
<tr>
<td><img src="icon" alt="Presenter" /></td>
<td>Indicates that the participant is connected to the web conference with Presenter permissions.</td>
</tr>
<tr>
<td><img src="icon" alt="Audience" /></td>
<td>Indicates that the participant is connected to the web conference with Audience permissions.</td>
</tr>
<tr>
<td><img src="icon" alt="Phone" /></td>
<td>When followed by a participant name or guest dial-in information, indicates that the participant is connected to the conference only over the phone. (Either the participant has not logged in to the web conference, or the web login for the participant is listed separately; in the latter case, the moderator can manually merge the two entries.) When followed by “Remote Server (&lt;Server name&gt;),” indicates that the Cisco Unified MeetingPlace Audio Server is connected to a multiserver meeting.</td>
</tr>
<tr>
<td><img src="icon" alt="Audio" /></td>
<td>Indicates that the participant is connected to a video endpoint.</td>
</tr>
<tr>
<td><img src="icon" alt="Microphone" /></td>
<td>Indicates that the participant is connected to an audio endpoint. The audio endpoint can be either a phone or a video endpoint that is configured with a microphone.</td>
</tr>
<tr>
<td><img src="icon" alt="Mute" /></td>
<td>Indicates that the audio endpoint is muted. The audio endpoint may be a phone or a video endpoint that is configured with a microphone.</td>
</tr>
<tr>
<td><img src="icon" alt="Listener" /></td>
<td>Indicates that the participant is connected to the audio conference as a listener. In webinar meetings, listeners do not have the ability to speak without permission from the meeting host.</td>
</tr>
<tr>
<td><img src="icon" alt="Waiting Room" /></td>
<td>Indicates that the participant has been placed in the waiting room, and cannot hear other participants.</td>
</tr>
</tbody>
</table>

Viewing or Changing Meeting Console Permissions

A moderator can change the permissions of any participant in the Participant List tool, promoting and demoting participants as necessary.

As a moderator, you can also change your own permissions. You can demote yourself to a presenter or audience member, so that you can see what participants with other permissions are seeing in the meeting room. Although you can demote yourself in the Participant List tool, you cannot promote yourself there; instead, you must use the View menu (for example, if you have demoted yourself to Audience, on the View menu, click Presenter View or Moderator View to promote yourself to one of these roles).

This section contains three procedures:
- To View Information about a Participant
- To Change the Meeting Console Permissions of One or More Participants (Moderator Only)
- To Change Your Meeting Console Permissions (Moderator Only)
To View Information about a Participant

Move the pointer over each name to view the full name, meeting role, audio and video-conference status, connection status, and enhanced rights (if any) for the participant.

To Change the Meeting Console Permissions of One or More Participants (Moderator Only)

**Step 1**  
In the Participant List tool, click the name of the participant whose permissions you want to change. (To change the permissions for multiple participants, hold down the Shift or Control key and click additional participants.)

**Step 2**  
Click the **Change Permissions** icon (person with green arrow) in the lower-left corner of the Participant List tool.

**Step 3**  
On the pop-up menu, click the role to give to the selected participant: **Moderator**, **Presenter**, or **Audience**.  
The icon of the participant changes on all participant screens, and participant names are resorted in the list according to role.

To Change Your Meeting Console Permissions (Moderator Only)

**Step 1**  
To change your web permissions, in the menu bar at the top of the meeting room window, click **View**.

**Step 2**  
Click the applicable view: **Moderator View**, **Presenter View**, or **Audience View**.

Dialing Out to Meeting Participants

A meeting moderator can dial out to a web conference participant from the meeting console to add the participant to the audio portion of the meeting, or add a new participant to the meeting by dialing out to him or her.

This section contains two procedures:

* To Dial Out to a Current Meeting Participant (Moderator Only)
* To Dial Out to a New Participant (Moderator Only)

To Dial Out to a Current Meeting Participant (Moderator Only)

**Step 1**  
In the Participant List tool, click the name of the participant.

**Step 2**  
Click the **Voice/Video Options** icon (phone and video camera).

**Step 3**  
Click **Connect Selected User**. The Connect Selected User dialog box appears.
Step 4 Choose the applicable option:

<table>
<thead>
<tr>
<th>Use Phone Number</th>
<th>To dial out to a phone. Enter a new phone number to call a number other than the default.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Video Endpoint Number</td>
<td>To dial out to a video endpoint. Enter a new video endpoint number to call a number other than the default.</td>
</tr>
</tbody>
</table>

Step 5 Click Connect Now.

To Dial Out to a New Participant (Moderator Only)

Step 1 In the Participant List tool, click the Voice/Video Options icon (phone and video camera).
Step 2 Click Connect New User. The Connect New User dialog box appears.
Step 3 Choose the applicable option:

<table>
<thead>
<tr>
<th>Use Phone Number</th>
<th>To dial out to a phone. Enter a new phone number to call a number other than the default.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Video Endpoint Number</td>
<td>To dial out to a video endpoint. Enter a new video endpoint number to call a number other than the default.</td>
</tr>
</tbody>
</table>

Step 4 Click Connect Now.

Audio Breakout Rooms

You can move to a breakout room at any time to have a separate audio conversation with other meeting participants. There are nine breakout rooms (numbered one through nine) available for use at any time after callers have joined the audio portion of the meeting. Moderators can move participants to breakout rooms and between breakout rooms.

Participants who take part in an audio conference but do not join the web-based portion of a meeting can participate in audio breakout rooms by using their phone keypads. Likewise, participants who take part in a meeting by web only (and not by phone) cannot enter audio breakout rooms.

A participant can be in only one audio conference room at a time. By default, all participants are placed in the main audio conference room when they join the meeting. When participants enter a breakout room, the Participant List tool lists the breakout room and groups their names underneath the name of the room.

Note Audio in breakout rooms is not included in meeting recordings.

This section contains the following information:
- Moving to or from an Audio Breakout Room (Audience and Presenters), page 67
- Moving Participants to or from an Audio Breakout Room (Moderators Only), page 67
Moving to or from an Audio Breakout Room (Audience and Presenters)

**To Move to or from an Audio Breakout Room (Audience and Presenters)**

**Step 1** Determine the breakout session that you want to enter (this can be any number from 1 to 9), then tell other participants to meet you in this “room.”

**Step 2** In the Participant List tool, click the Voice/Video Options icon (phone and video camera).

**Step 3** Click **Go to Audio Breakout Room**.

**Note** You can only access this option if you are dialed in to the meeting and your phone is associated with your user profile or guest login.

**Step 4** Click the name of the audio breakout room to attend. Click **Main Room** to return to the main audio conference room.

Moving Participants to or from an Audio Breakout Room (Moderators Only)

If you are a meeting moderator, you can move to a breakout room yourself or send other participants to a breakout room.

**To Move Participants to or from an Audio Breakout Room (Moderators Only)**

**Step 1** In the Participant List tool, click the name of a participant. (To move multiple participants, hold down the Shift or Control key and click additional participants.)

**Step 2** Click the Voice/Video Options icon (phone and video camera).

**Step 3** Click **Move Selected to Audio Breakout Room**.

**Step 4** Choose the applicable option:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Name of Audio Breakout Room&gt;</td>
<td>To move the participant(s) to the breakout room.</td>
</tr>
<tr>
<td>Main Conference</td>
<td>To return the participant(s) to the main audio conference room.</td>
</tr>
<tr>
<td>Return All to Main Audio Room</td>
<td>To move all participants to the main audio conference room.</td>
</tr>
</tbody>
</table>

Muting Audio for Participants

To identify where background noise may be coming from, refer to the Speaking section of the Participant List tool to see who (other than the speaker) appears. The meeting moderator can mute the audio (the phone line, or the audio associated with a video endpoint) of other participants.
To Mute the Audio for Participants (Moderator Only)

Step 1  In the Participant List tool, click the name of a participant. (To mute multiple participants, hold down the Shift or Control key and click additional participants.)
Step 2  Click the Volume Options icon (loudspeaker with plus symbol).
Step 3  Click Mute Selected User.

Muting Audio for All Participants from the Meeting Console

As the moderator, you can mute the audio of all participants simultaneously from the meeting console. Note the following considerations:

- The Mute All feature does not change the audio permissions of meeting participants. Users can unmute themselves at any time by phone or from the web.
- Users entering the meeting after you have invoked the Mute All feature are automatically muted upon entrance.
- This feature does not affect users who are in a breakout session when the feature is invoked. However, such users are muted when they return to the main meeting.
- This feature does not affect users on remote servers.

To Mute the Audio for All Participants from the Meeting Console

Step 1  In the Participant List tool, click the Volume Options icon (loudspeaker with plus symbol).
Step 2  Click Mute All. This mutes all audio except your own.

Placing Participants in the Waiting Room

As the moderator, you can place individual meeting participants in the waiting room. Callers cannot hear each other in the waiting room, and video callers cannot see each other.

To Place Participants in the Waiting Room (Moderator Only)

Step 1  In the Participant List tool, click the name of a participant. (To place multiple participants in the waiting room, hold down the Shift or Control key and click additional participants.)
Step 2  Click the Hold icon (hand).

Tip  To place all participants who are not moderators or presenters in the waiting room at once, on the Meeting menu, click Move Audience/Listeners to Waiting Room.
Merging Two Listings for the Same Participant

If a participant logs into a web meeting and then dials into an audio conference, the two entries are automatically merged and only one name appears for the user. However, if a participant calls in to Cisco Unified MeetingPlace with an unrecognized phone number and then logs in to the meeting on the web, the participant may appear twice on the list, once as “Guest User (<caller ID>),” and once as the profile name or guest name entered while logging in to the web conference. If a moderator knows that a participant is listed twice, the moderator can use the Merge Users feature to combine the two listings into one.

To Merge Two Listings for the Same Participant (Moderator Only)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>In the Participant List tool, click one of the listings for the participant.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Press Ctrl, then click the other listing.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Click the Merge Users icon (two green arrows) at the bottom of the tool.</td>
</tr>
</tbody>
</table>

Changing Enhanced Rights for Participants

A moderator can change the rights of a participant to give the participant control over selected tools. This is a way of enhancing the rights of a participant without promoting the participant to have Presenter or Moderator permissions.

To Change Enhanced Rights for Participants (Moderator Only)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>In the Participant List tool, click the name of a participant. (To change the rights for multiple participants, hold down the Shift or Control key and click additional participants.)</td>
</tr>
<tr>
<td>Step 2</td>
<td>Click the More Options icon (gear with arrow) in the lower-right corner of the Participant List tool. A pop-up menu appears with a list of the available tool options.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Click Change Enhanced Participant Rights.</td>
</tr>
<tr>
<td>Step 4</td>
<td>In the dialog box, select the tools that you want the participant to control.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Click OK. The user has full functionality for all instances of the selected tool types.</td>
</tr>
</tbody>
</table>

Renaming a Participant

A moderator can change the name displayed for a participant in the Participant List tool.

To Rename a Participant

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>In the Participant List tool, click the name of a participant.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Click the More Options icon (gear with arrow) in the lower-right corner of the Participant List tool. A pop-up menu appears with a list of the available tool options.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Click Rename Selected Participant. The Rename Participant window opens.</td>
</tr>
</tbody>
</table>
Step 4 Edit or enter a new name for the participant. You can also enter or edit the participant phone number or video endpoint number.

Step 5 Click OK.

Removing Participants from a Meeting

A moderator can remove a participant from a meeting. The web session and associated voice and video sessions (if applicable) for the participant terminate; the meeting room closes and is replaced with a message indicating that the user has been asked to leave, and the user hears an announcement indicating that he or she has been disconnected from the meeting.

To Remove Participants from a Meeting (Moderator Only)

Step 1 In the Participant List tool, click the name of the participant to remove. (To remove multiple participants, hold down the Shift or Control key and click additional participants.)

Step 2 Click the More Options icon (gear with arrow) in the lower-right corner of the Participant List tool. A pop-up menu appears with a list of the available tool options.

Step 3 Click Remove Selected User.

Changing Participant Status

By default, participant status is blank. However, participants can change their own status to indicate that they have a question or an issue with the presentation. When a participant selects a status, an icon appears to the right of the participant name. Participants can change or clear their status at any time during a meeting. The moderator can clear the status of another participant (for example, if the presenter has addressed the question or issue).

This section contains two procedures:

- To Change or Clear Your Status
- To Clear Participant Status (Moderator Only)

To Change or Clear Your Status

Step 1 In the Participant List tool, click the My Status bar. A pop-up menu appears with a list of the available status settings.

Step 2 Click the name of the status that you want to show to other participants. To clear your status, click Clear My Status.

To Clear Participant Status (Moderator Only)

Step 1 In the Participant List tool, click the name of a participant. (To clear the status of multiple participants, hold down the Shift or Control key and click additional participants.)
Step 2 In the lower-right corner, click the More Options icon (gear with arrow).

Step 3 Click Clear User Status.

Displaying Connection Status Indicators

A group of bars, similar to the bars indicating signal strength on a cell phone, can be displayed next to each name in the Participant List tool to indicate the connection status of the participant. When the connection falls below the current meeting room bandwidth, the number of bars in the icon decreases.

A moderator can configure the network connection status indicators to be on or off at any time during a meeting. By default, they are off.

To Display the Connection Status Indicators (Moderator Only)

Step 1 In the Participant List tool, in the lower-right corner, click the More Options icon (gear with arrow).

Step 2 Click Show Connection Status.

About the Chat Tool

The Chat tool in the meeting console allows you to exchange text messages with other participants.

As a presenter, you can use more than one Chat tool simultaneously. If the moderator has enabled the Presenter Only Area, this area includes a Presenter Chat tool that you can use to chat “offstage” with other presenters.

In the Chat tool, messages appear as they are submitted, and they are listed sequentially in the tool. Presenters can allow participants to conduct private chats, clear a chat, or turn off chat notifications. Chat tool content is persistent, and will remain in a meeting room until you delete it. If you want to preserve Chat tool content for future use, you can e-mail it.

When you receive a chat message from a meeting participant, your Chat tool shows the sender name and the message. If the message was sent to everyone, the sender name is followed by the message. If the message was sent only to you, the sender name is followed by “(privately).” If the message was sent only to the presenters, the sender name is followed by “(presenters).”

When a Chat tool is linked to a Q & A tool, broadcast chat messages are available only to users with Moderator or Presenter permissions. Users with Audience permissions can only submit questions.

This section contains the following information:

- Sending a Chat Message, page 72
- Disabling Private Chat Between Participants (Moderator Only), page 72
- Clearing Messages from a Chat Tool, page 72
- Disabling Chat Notifications, page 73
- E-Mailing the Chat History, page 73
Sending a Chat Message

You can use the Chat tool to compose a chat message and address it to a specific participant, to all presenters at the meeting, or to all participants (participants, presenters, and moderators).

When you receive a chat message from a meeting participant, your Chat tool shows the sender’s name and the message. If the message was sent to everyone, the sender’s name is followed by the message. If the message was sent only to you, the sender’s name is followed by “(privately).” If the message was sent only to the presenters, the sender’s name is followed by “(presenters).”

To Send a Chat Message

Step 1
In the Chat tool, in the To field, choose the applicable option for the message recipient(s): name of a participant, Presenters, or Everyone.

Step 2
Click the text box in the Chat tool.

Step 3
Enter your message.

Step 4
Click the Send Message icon (black arrow) next to the text box.
Or
Press Enter.

Your name appears in the Chat tool, followed by the recipient(s) you selected and your message.

Disabling Private Chat Between Participants (Moderator Only)

By default, two participants can chat privately. When Enable Private Chat for Audience is selected, participants can send messages to individual participants as well as to presenters and to all participants. As a moderator, you can disable this option and prevent private chat.

To Disable Private Chat Between Participants (Moderator Only)

Step 1
In the Chat tool, in the lower-right corner, click the More Options icon (gear with arrow).

Step 2
Click Enable Private Chat for Audience to disable the option. The check mark disappears when the option is disabled.

Note
This option is not available if the Chat tool is linked to a Q & A tool.

Clearing Messages from a Chat Tool

When an empty Chat tool is required in a meeting, a moderator or presenter can clear all messages for all participants.
To Clear Messages from a Chat Tool

Step 1  In the Chat tool, in the lower-right corner, click the More Options icon (gear with arrow).
Step 2  Click Clear Chat. All text is removed from the Chat tools of all participants.

Disabling Chat Notifications

If you are a moderator or presenter and you are using the Cisco Unified Presenter Add-in, chat notifications let you communicate with your audience while you are presenting and the meeting window is minimized or maximized to full screen, concealing the Chat tool. If a participant sends you a message while you are presenting in full-screen or screen-sharing mode, a notification appears in the lower-right corner of the screen. You can see the name of the sender and the first few words of the message in the notification window.

By default, chat notifications are enabled. If you do not want notifications to be shown while you are presenting, you can disable them.

To Disable Chat Notifications

Step 1  In the Chat tool, in the lower-right corner, click the More Options icon (gear with arrow).
Step 2  Click Disable Chat Notifications.

E-Mailing the Chat History

The meeting moderator can e-mail the chat history.

To E-Mail the Chat History

Step 1  In the Chat tool, click the More Options icon (gear with arrow).
Step 2  Click E-Mail Chat History. A new message appears in your default e-mail client, with the subject “Chat History” and the contents of the Chat tool in the message body.

Note  The Cisco Unified Presenter Add-in must be installed to use this option.

Step 3  Edit the note if necessary, address the message to recipients, and send.
About the Note Tool

As a moderator or presenter, you can use a Note tool to take meeting notes that all participants can see. Unlike a chat message in a Chat tool, the text note in a Note tool is created and displayed only by presenters. It remains visible in a Note tool throughout the meeting or until a presenter edits the note or displays a different note. A moderator can remove the Note tool from view or switch to a different room layout that does not contain that Note tool.

You can use the Note tool in several ways:

- Create a single, persistent note that is visible to participants during the entire meeting.
- Create multiple notes in a single tool.
- Create multiple Note tools to display different notes.

You can also e-mail the contents of a note tool.

This section contains the following information:

- Creating a Note Tool, page 74
- Adding a Note to a Note Tool, page 74
- Creating Multiple Notes in a Note Tool, page 75
- Editing a Note, page 75
- Renaming a Note, page 76
- Deleting a Note, page 76
- E-Mailing the Contents of a Note Tool, page 76

Creating a Note Tool

A moderator can create and display multiple Note tools, each with its own text. You can use different Note tools for different layouts and meetings. When you create a Note tool, it is assigned a default name, such as Note 1 or Note 2. You can rename the Note tool after it is created.

To Create a Note tool

On the Tools menu in the meeting console, click Note > New Note Tool.

Or

In the Note tool, click the More Options icon (gear with arrow), then click New Note.

A new Note tool appears. You can move, resize, and rename the tool.

Adding a Note to a Note Tool

A moderator or presenter can add or change text in any Note tool.
To Add a Note to a Note Tool

- **Step 1**: Click anywhere inside the Note tool.
- **Step 2**: Type the text that you want to appear in the Note tool. Meeting participants immediately see the new text.

Creating Multiple Notes in a Note Tool

A moderator or presenter can create more than one note in a Note tool, and choose which note to display. This section contains two procedures:
- To Create Multiple Notes in a Note Tool
- To Select a Note to Display in a Note Tool

To Create Multiple Notes in a Note Tool

- **Step 1**: In the Note tool, in the lower-right corner, click the More Options icon (gear with arrow).
- **Step 2**: Click New Note.

To Select a Note to Display in a Note Tool

- **Step 1**: In the Note tool, in the lower-right corner, click the More Options icon (gear with arrow).
- **Step 2**: Click Select Note.
- **Step 3**: Click the name of the note that you want to display.

Editing a Note

A moderator or presenter can edit the text in a Note tool. All the text in a tool uses the same formatting. All editing changes are immediately visible to participants.

To Edit a Note

- **Step 1**: Click anywhere inside the Note tool containing the text that you want to edit.
- **Step 2**: Modify the text.
- **Step 3**: To change the size of the text, click the More Options icon (gear with arrow), then click Text Size and choose a size.
- **Step 4**: To change the alignment of the text, click the More Options icon (gear with arrow), then click Text Alignment and choose an option: Left, Center, or Right.
Renaming a Note

When a moderator or presenter creates a note, it is assigned a default name, such as Note 1 or Note 2. If you are a moderator, you can rename a note.

To Rename a Note

Step 1 Double-click the name and enter a new one.
Or
Use the Organize Tools dialog box:
   a. On the Tools menu in the meeting console, click Organize Tools. The Organize Tools dialog box appears.
   b. Select the name of the Note tool that you want to change.
   c. Click Rename. The Rename Tool dialog box appears.
   d. Enter the new name.
   e. Click OK. The new name appears in the Organize Tools dialog box.
   f. Click Done.

Deleting a Note

To Delete a Note

Step 1 On the Tools menu in the meeting console, click Organize Tools. The Organize Tools dialog box appears.
Step 2 Select the name of the note that you want to delete.
Step 3 Click Delete.
Step 4 Click Done.

E-Mailing the Contents of a Note Tool

The meeting moderator can e-mail the contents of a note.

To E-Mail the Contents of a Note Tool

Step 1 In the Note tool, click the More Options icon (gear with arrow).
Step 2 Click E-Mail Note. A new message appears in your default e-mail client, with the subject “Note” and the contents of the Note tool in the message body.

Note The Cisco Unified Presenter Add-in must be installed to use this option.
Step 3 Edit the note if necessary, address the message to recipients, and send.

About the Poll Tool

Moderators can use the Poll tool to create questions, or polls, for participants and to view the results. Both moderators and presenters can edit existing poll questions, open or close polls, and broadcast poll results to participants. Moderators and presenters can also cast votes.

This section contains the following information:
- Creating a Poll Question, page 77
- Editing an Existing Poll Question, page 78
- Selecting a Format for Poll Results, page 78
- Revealing Results for Polls, page 79
- Clearing Poll Results, page 79

Creating a Poll Question

To poll participants, a moderator must create a new Poll tool. Once the Poll tool is created, the moderator or a presenter can create and edit the poll question.

Meetings that were created by using the Presentation or Webinar templates (or a template derived from one of these templates) have an Open Poll layout that includes multiple Poll tool windows.

Tip
If you are creating a poll question during a meeting and you do not want audience members to see a blank Poll tool window while you prepare the question, either switch to Preparing mode or move the Poll tool to the Presenter Only Area. After you open the poll, switch out of Preparing mode or move the Poll tool back onto the stage.

To Create a Poll Question

Step 1 On the Tools menu in the meeting console, click Poll > New Poll Tool. A Poll tool opens in Prepare mode.

Step 2 On the Question menu, choose the applicable option:

<table>
<thead>
<tr>
<th>Multiple Choice</th>
<th>To allow respondents to select only one from the list of answers.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiple Answer</td>
<td>To allow respondents to select any or all that apply from the list of answers.</td>
</tr>
</tbody>
</table>

Step 3 Enter the text of the question in the Question text box.

Step 4 To enable voting, click Open Poll.
About the Poll Tool

Step 5 To allow all participants to see the current voting results, check **Broadcast Results**.

---

**Note** This option does not appear while the poll is in Prepare mode.

---

**Tip** The moderator or presenters can add additional questions to a single Poll tool by clicking New Poll in the More Options menu of the Poll tool. To move quickly between questions in the tool, in the More Options menu, click Select Poll, then click the name of the question to move to.

---

Editing an Existing Poll Question

Moderators and presenters can edit existing polls. When a poll question is in Prepare mode, multiple moderators and presenters can edit it at the same time.

---

**Caution** Editing a poll after it has been opened for voting will delete any results already received.

---

**To Edit an Existing Poll Question**

**Step 1** If the Poll tool is hidden, on the Tools menu in the meeting console, click **Poll**, then click the name of the poll.

**Step 2** In the Poll tool, click **Prepare**.

**Step 3** Edit your poll, survey, or question. The updated question appears.

**Step 4** To restart voting on the poll question, click **Open Poll**.

---

Selecting a Format for Poll Results

Moderators and presenters can select the format in which poll results are displayed.

**To Select a Format for Poll Results**

**Step 1** If the Poll tool is currently hidden, on the Tools menu in the meeting console, click **Poll**, then click the name of the poll.

**Step 2** Click the **More Options** icon (gear with arrow).

**Step 3** Click **Results Settings**, then choose the applicable option: **Show as %**, **Show as Numbers**, or **Show as Both**.
Step 4 To see how individual respondents answered, click the **Show Individual Votes** button (displayed as the number of poll respondents over the number of meeting participants, for example, 9/10). This affects only your Poll tool display; it does not show on the Poll tool of other moderators, presenters, or audience members.

### Revealing Results for Polls

All moderators and presenters can see poll voting results by default. Any moderator or presenter can make results of an individual poll available to audience members.

**To Reveal Results for a Poll**

**Step 1** If the Poll tool is hidden, on the Tools menu in the meeting console, click **Poll**, then click the name of the poll.

**Step 2** In the Poll tool, click **Broadcast Results**. The results are immediately displayed to audience members.

### Clearing Poll Results

A moderator or presenter can clear all previous voting results for a poll.

**To Clear Poll Results**

**Step 1** In the Poll tool, click the **More Options** icon (gear with arrow).

**Step 2** Click **Clear All Answers**.

### About the File Share Tool

Moderators and presenters can upload files to share with meeting participants either from their computers or from the meeting attachments. Meeting participants with audience permissions cannot upload files; however, the moderator can change the status of a participant to allow him or her to upload files.

This section contains the following information:

- Uploading Files to the File Share Tool, page 80
- Downloading Files from the File Share Tool, page 80
- Renaming Files in the File Share Tool, page 81
- Removing Files from the File Share Tool, page 81
Uploading Files to the File Share Tool

You can upload a file either from the meeting attachments or from your computer. This section contains two procedures:

- To Upload a File from the Meeting Attachments
- To Upload a File from Your Computer

To Upload a File from the Meeting Attachments

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In the File Share tool, click <strong>Upload File</strong>.</td>
</tr>
<tr>
<td>2</td>
<td>Click <strong>Add From Attachments</strong>.</td>
</tr>
<tr>
<td>3</td>
<td>Navigate to the folder that contains the file.</td>
</tr>
<tr>
<td>4</td>
<td>Click the filename and click <strong>Open</strong>. The filename appears in the File Share tool.</td>
</tr>
</tbody>
</table>

To Upload a File from Your Computer

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In the File Share tool, click <strong>Upload File</strong>.</td>
</tr>
<tr>
<td>2</td>
<td>Click <strong>Add from My Computer</strong>. A Browse Content window appears.</td>
</tr>
<tr>
<td>3</td>
<td>Browse to the folder that contains the file.</td>
</tr>
<tr>
<td>4</td>
<td>Click the filename and click <strong>Open</strong>. The filename appears in the File Share tool.</td>
</tr>
</tbody>
</table>

Downloading Files from the File Share Tool

You can save a file that another meeting participant has shared to your computer hard disk. Users with appropriate permissions can access files that were uploaded to the File Share tool after the meeting by using the Attachments/Recordings link on the Meeting Details page.

To Download a File from the File Share Tool

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In the File Share tool, select the file to download.</td>
</tr>
<tr>
<td>2</td>
<td>Click <strong>Save to My Computer</strong>. A browser window opens, with the Save to My Computer dialog box.</td>
</tr>
<tr>
<td>3</td>
<td>Click the <strong>Click to Download</strong> button.</td>
</tr>
<tr>
<td>4</td>
<td>Browse to the desired location.</td>
</tr>
<tr>
<td>5</td>
<td>Click <strong>Save</strong>.</td>
</tr>
<tr>
<td>6</td>
<td>Close the Save to My Computer browser window to return to the meeting console window.</td>
</tr>
</tbody>
</table>
Renaming Files in the File Share Tool

Renaming a file changes only the label that appears in the File Share tool; it doesn’t change the actual filename.

To Rename a File in the File Share Tool

---

| Step 1 | In the File Share tool, select the file that you want to rename. |
| Step 2 | In the lower-right corner, click the More Options icon (gear with arrow). |
| Step 3 | Click Rename Selected. |
| Step 4 | Type the new name in the Name text box and click OK. |

Removing Files from the File Share Tool

To Remove a File from the File Share Tool

---

| Step 1 | In the File Share tool, select the file that you want to remove. |
| Step 2 | In the lower-right corner, click the More Options icon (gear with arrow). |
| Step 3 | Click Remove Selected. The filename disappears from the list of files. |

About the Web Links Tool

During meetings, moderators or presenters may want participants to view websites. You can use the Web Links tool to force participant browsers to open a designated URL.

This section contains the following information:

- Adding New Web Links, page 81
- Displaying Web Links to All Participants, page 82
- Renaming Web Links, page 82
- Removing Web Links, page 82

Adding New Web Links

To Add a New Web Link

---

| Step 1 | In the lower-right corner, click the More Options icon (gear with arrow). |
| Step 2 | Select Add Link. |
| Step 3 | Type the URL name and URL path in the text boxes. |
Welcome to Cisco Unified MeetingPlace Web Conferencing

About the Q & A Tool

If you are a moderator or presenter, the Q & A tool gives you additional control for managing questions and answers during a meeting. Using this tool, you can redirect a question to the appropriate presenter and place questions in a queue until you are ready to answer them.

The Q & A tool is linked to the Chat tool. When a participant asks a question in the Chat tool, a presenter can answer in the linked Q & A tool. When a presenter answers a question, the question and answer appear as pairs in the Chat tool.

Displaying Web Links to All Participants

To Display a Web Link to All Participants

Step 1  Select a link in the Web Links tool, or enter a URL in the Browse To text box.
Step 2  Click Browse To. Meeting participants browse to the link.

Renaming Web Links

To Rename a Web Link

Step 1  Select a URL name in the Web Links tool.
Step 2  In the lower-right corner, click the More Options icon (gear with arrow).
Step 3  Click Rename Selected Link.
Step 4  Type the new name in the URL Name text box.
Step 5  Click OK. The new URL name appears in the Web Links tool.

Removing Web Links

To Remove a Web Link

Step 1  Select a link in the Web Links tool.
Step 2  In the lower-right corner, click the More Options icon (gear with arrow).
Step 3  Click Remove Selected. The link disappears from the Web Links tool.
To manage your queue of questions, you can apply a filter, so that you see certain questions while hiding others. You can select and edit a question, enter your reply, and send the answer either to all participants or to only the sender.

You might use the Q & A tool in the following situations:

- During a product launch with more than 100 participants, questions are added to a queue on the Q & A tool while the speaker presents. After completing the presentation, the speaker reviews the messages, applies a filter, and begins answering the questions.
- A meeting moderator answers logistical questions but forwards technical inquiries to an engineer, who is presenting.
- A meeting moderator returns certain replies to the sender only. Replies that are relevant to all participants are sent to everyone in the meeting.

This section contains the following information:

- Adding a Q & A Tool and Linking It to a Chat Tool, page 83
- Submitting a Question in the Chat Tool, page 83
- Answering a Question by Using the Q & A Tool, page 84

## Adding a Q & A Tool and Linking It to a Chat Tool

If you are a moderator or presenter, you can add a Q & A tool to a meeting room with an existing Chat tool. You must create a link between the two tools. After the two tools are linked, “(Q & A)” is added to the name of the Chat tool. In Q & A mode, participants can send messages only to the presenters. There can be only one Q & A tool in a meeting room.

### To Add a Q & A Tool and Link It to a Chat Tool

**Step 1** On the Tools menu in the meeting console, click **Q & A**.

**Step 2** In the Q & A tool, click the name of the Chat tool that you want to link to.

**Step 3** Click **Link**. The Chat tool is linked to the Q & A tool and “(Q & A)” is displayed in the Chat tool title bar.

## Submitting a Question in the Chat Tool

Once the Chat tool is linked to a Q & A tool, participants can submit questions in the Chat tool.

### To Submit a Question in the Chat Tool

**Step 1** On the pop-up menu at the bottom of the Chat tool, click **Submit Question** (this option is available only if a Q & A tool is linked to the Chat tool).

**Step 2** Enter your message in the text box.
Step 3  Click the **Send Message** icon (arrow).

Or

Press **Enter**.

---

### Answering a Question by Using the Q & A Tool

If you are a moderator or presenter, you can apply a filter to the queue of messages to quickly find the questions that you want to answer.

**To Answer a Question by Using the Q & A Tool**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In the Incoming Messages list, click a question. The question is highlighted, and a duplicate of the question appears in the Preview pane so that you can edit it if necessary.</td>
</tr>
<tr>
<td>2</td>
<td>(Optional) In the Preview pane, edit the question.</td>
</tr>
<tr>
<td>3</td>
<td>Enter your answer in the text box at the bottom of the tool.</td>
</tr>
<tr>
<td>4</td>
<td>Choose the applicable option in the lower-right corner of the Q &amp; A tool:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Answer Question to Everyone</th>
<th>Sends the answer to all meeting participants.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Answer Question to Submitter Only</td>
<td>Sends the answer only to the participant who sent the question.</td>
</tr>
</tbody>
</table>

When a question is sent, it is deleted from the Incoming Messages list and appears in the Chat tool as a question-and-answer pair in the Answered Questions list.

---

### Reasons You May Be Removed from a Web Conference

Under the following circumstances, the system removes users from web conferences under the following circumstances:

- You are in the meeting console and initiate a web browser session from another application (for example by clicking a link in Microsoft Word or Microsoft Outlook). Unless your web browser is configured otherwise, the link will replace your meeting console link, thus removing you from the web conference. Do not click links in other applications while you are in a web conference.
- You are on a slow connection and are falling too far behind in the web conference.

This section contains the following information:

Checking Your Connection Speed, page 84

---

### Checking Your Connection Speed

Run the browser test to report the speed of your connection with the Cisco Unified MeetingPlace server.
To Check Your Connection Speed

Step 1  On the Help menu in the meeting console, click Browser Test.
Step 2  Click Start. The browser test reports the speed that your connection supports (modem, DSL/Cable, or LAN).
Step 3  For more details about the speed of your connection, click Show Details.
Step 4  Close the browser test window.

About the More Options Page

Note Parameters in this section affect your particular meeting. To set general meeting preferences, see the “About the Meeting Preferences Page” section on page 94.

When you are scheduling or modifying a meeting from the Cisco Unified MeetingPlace Web Conferencing Home page, you can use the More Options link on the Meeting Details page to modify your meeting preferences, the meeting security settings, and the types of information that you wish to appear on notifications. These settings apply to the meeting you are currently scheduling. Defaults are based on system and profile settings.

This section contains the following information:
- Updating Additional General Meeting Options for a Meeting, page 85
- Updating Audio Conferencing Options for a Meeting, page 86
- Updating Video Conferencing Options for a Meeting, page 88
- Updating Notification Options for a Meeting, page 89
- Enabling Guest Outdial from the Web, page 90
- Recording Meetings Automatically, page 90
- Setting the Meeting Extension Announcement from the Meeting Scheduling Pages, page 91

Updating Additional General Meeting Options for a Meeting

The New Meeting scheduling page includes the most commonly accessed settings for creating meetings. However, there are additional options that you may want to configure on the More Options page.

To Update Additional General Meeting Options for a Meeting

Step 1  On the New Meeting scheduling page, click the More Options icon. The More Options page appears.
Step 2  Use Table 14 below to modify options for the meeting.
Step 3  When you finish updating options, click Submit.
About the More Options Page

To Update Audio Conferencing Options for a Meeting

<table>
<thead>
<tr>
<th>Step 1</th>
<th>On the New Meeting scheduling page, click the More Options icon. The More Options page appears.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Scroll down to the Audio conferencing options section.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Use Table 15 below to modify options for the meeting.</td>
</tr>
<tr>
<td>Step 4</td>
<td>When you finish updating options, click Submit.</td>
</tr>
</tbody>
</table>

**Table 14 Descriptions of Additional General Meeting Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meeting Description</td>
<td>(Optional) Enter a meeting description.</td>
</tr>
</tbody>
</table>
| Who can attend       | Choose an option from the list to indicate who can attend the meeting:  
  • Anyone—The meeting is unrestricted. Both profile users and guest users can attend.  
  • MeetingPlace Profile Users—All components of the meeting (audio, web, and video) are restricted to profile users who sign in by using their Cisco Unified MeetingPlace user ID and password. Users attending over a video endpoint must sign in to the web conference first, then connect to the video conference by using the Connect button.  
  • Invited Profile Users—All components of the meeting (audio, web, and video) are restricted to profile users who were invited to attend. All invited users must sign in by using their Cisco Unified MeetingPlace user ID and password. Users attending over a video endpoint must sign in to the web conference first, then connect to the video conference by using the Connect button. |
| Note                 | If you schedule a Cisco WebEx meeting you must set the parameter to Anyone.                                                                                                                                  |
| Allow guest outdial  | Choose Yes to allow guest users to use the outdial feature. With outdialing, the system calls users and automatically connects them to the audio and video components of the meeting. Otherwise, choose No. |
| List meeting publicly| If you want this meeting listed when users search by using the Find Meetings search engine, check this check box. If you want this meeting listed only for the meeting scheduler and invitees, uncheck this check box. |
### Table 15 Descriptions of Audio Conferencing Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Entry announcement</strong></td>
<td>Choose an option from the list to indicate how you want participants to be announced when they enter the meeting:</td>
</tr>
<tr>
<td></td>
<td>- Beep Only—A short beep is emitted during the meeting to indicate that someone has entered the meeting.</td>
</tr>
<tr>
<td></td>
<td>- Beep + Name—After a short beep, the participant’s recorded name is announced.</td>
</tr>
<tr>
<td></td>
<td>If you do not hear a participant’s name upon entry, the participant probably did not record a name before entering the meeting. Identify the participant before the meeting begins.</td>
</tr>
<tr>
<td></td>
<td>- Silent—There is no indication that someone has entered the meeting.</td>
</tr>
<tr>
<td><strong>Exit announcement</strong></td>
<td>Choose an option from the list to indicate how you want participants to be announced when they depart from the meeting:</td>
</tr>
<tr>
<td></td>
<td>- Beep Only—A short beep is emitted during the meeting to indicate that someone has departed the meeting.</td>
</tr>
<tr>
<td></td>
<td>- Beep + Name—After a short beep, the participant’s recorded name is announced.</td>
</tr>
<tr>
<td></td>
<td>If you do not hear a participant’s name upon departure, the participant probably did not record a name before entering the meeting. Identify the participant before the meeting begins.</td>
</tr>
<tr>
<td></td>
<td>- Silent—There is no indication that someone has departed the meeting.</td>
</tr>
<tr>
<td><strong>End of meeting</strong></td>
<td>Choose Yes if you want the system to warn you when the meeting is about to end. Otherwise, choose No.</td>
</tr>
<tr>
<td><strong>Entry announcement in</strong></td>
<td>Choose what users will hear when a new participant joins the meeting breakout.</td>
</tr>
<tr>
<td><strong>breakouts</strong></td>
<td>- Beep Only—A short beep is emitted during the meeting to indicate that someone has entered the meeting breakout.</td>
</tr>
<tr>
<td></td>
<td>- Beep + Name—After a short beep, the recorded name of the participant is announced.</td>
</tr>
<tr>
<td></td>
<td>If you do not hear the name of a participant upon entry, the participant probably did not record a name before entering the meeting breakout. Identify the participant before the meeting breakout begins.</td>
</tr>
<tr>
<td></td>
<td>- Silent—There is no indication that someone has entered the meeting breakout.</td>
</tr>
<tr>
<td><strong>Reservationless</strong></td>
<td>The parameter is available only if the administrator has set your user profile setting “Able to record meetings” to Yes.</td>
</tr>
<tr>
<td><strong>announcement</strong></td>
<td>Indicates whether you want to reserve recording resources for this meeting. Doing so will take away one recording resource from the system pool of 100 maximum concurrent recording resources available. If set to No, you may still start recording anytime during the meeting only if resources are available, at which time that one resource will also be used.</td>
</tr>
<tr>
<td><strong>Meeting extension</strong></td>
<td>Choose Yes if you want the system to inform you that the meeting has been extended. Otherwise, choose No.</td>
</tr>
</tbody>
</table>
About the More Options Page

Updating Video Conferencing Options for a Meeting

To Update Video Conferencing Options for a Meeting

Step 1 On the New Meeting scheduling page, click the More Options icon. The More Options page appears.

Step 2 Scroll down to the Video Conferencing Options section.

Step 3 Use Table 16 below to modify options for the meeting.

Step 4 When you finish updating options, click Submit.

Table 15 Descriptions of Audio Conferencing Options (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically start recording</td>
<td>Cisco Unified MeetingPlace meetings only: Choose Yes if you want the system to automatically record the audio and Web interface of your meeting. Otherwise, choose No.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> If you schedule a Cisco WebEx meeting and you set the parameter to Yes, Cisco Unified MeetingPlace automatically starts to record the audio segment of the meeting after the first invitee dials in. To record the Cisco WebEx meeting interface, log in to the Cisco WebEx meeting and follow the onscreen instructions to start recording.</td>
</tr>
<tr>
<td>Access meeting Attachments/Recordings</td>
<td>Choose an option from the list to indicate who can access the recordings and attachments associated with the meeting:</td>
</tr>
<tr>
<td></td>
<td>• None—MeetingNotes access is completely restricted. No one can access the recordings and attachments associated with the meeting.</td>
</tr>
<tr>
<td></td>
<td>• Anyone—MeetingNotes access is completely unrestricted. Anyone, including guest users, can access recordings and attachments associated with the meeting.</td>
</tr>
<tr>
<td></td>
<td>• MeetingPlace Profile Users—MeetingNotes access is accessible to any user who signs in by using a Cisco Unified MeetingPlace user ID and password.</td>
</tr>
<tr>
<td></td>
<td>• Invited Profile Users—MeetingNotes access is restricted to profile users who were invited to the meeting. All invited profile users must sign in by using a Cisco Unified MeetingPlace user ID and password.</td>
</tr>
<tr>
<td>Meeting Language</td>
<td>Cisco Unified MeetingPlace meetings only: Choose your meeting language from the list of available languages. This option affects the voice prompts users hear when they attend the meeting.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> Cisco WebEx meetings are available in English only.</td>
</tr>
</tbody>
</table>
Table 16  Descriptions of Video Conferencing Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outdial All Terminals at Meeting Time</td>
<td>Check the check box to have Cisco Unified MeetingPlace dial out to all invited video terminals at the start of the meeting. When a user at the video terminal answers the call, the terminal is automatically connected to the meeting.</td>
</tr>
<tr>
<td>Admit Unresolved PSTN/ISDN Calls</td>
<td>Uncheck the check box to allow only invited ISDN and PSTN terminals to attend the meeting. Check the check box to allow any ISDN and PSTN terminals to attend the meeting, if there are available resources. Access for IP terminals is not affected by this setting. Note: We do not recommend that you uncheck the check box. Instead, use the Who can attend field to control access to the meeting.</td>
</tr>
<tr>
<td>Require All Video Terminals to Be Available</td>
<td>If checked, scheduling the meeting will fail if any invited video terminal is unavailable during the scheduled meeting time. Uncheck the check box to allow double-booking of a terminal.</td>
</tr>
<tr>
<td>Service Code</td>
<td>From the list, choose the applicable service code for the meeting. Service codes may be added by the system administrator to provide a predefined set of attributes such as video bandwidth and layout. Two predefined service codes (Point to Point and Non Video Conference) are available for scheduling a meeting specifically to reserve one or more video terminals (or the meeting rooms associated with the terminals). When you use either of these codes, the invited video terminals will be reserved for the duration of the meeting, but no video conference ports will be reserved for the meeting. Invitees will receive a meeting notification with no video dial-in information and no click-to-attend link.</td>
</tr>
</tbody>
</table>

Table 17  Descriptions of Notification Options

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled for meeting</td>
<td>Choose Yes to have the system send notifications for the meeting. Otherwise, choose No.</td>
</tr>
<tr>
<td>Include attachments</td>
<td>Choose Yes to include your attachments with notifications. Otherwise, choose No.</td>
</tr>
</tbody>
</table>

Updating Notification Options for a Meeting

To Update Notification Options for a Meeting

**Step 1** On the New Meeting scheduling page, click the More Options icon. The More Options page appears.

**Step 2** Scroll down to the Notification option section.

**Step 3** Use Table 17 below to modify options for the meeting.

**Step 4** When you finish updating options, click Submit.
About the More Options Page

To Enable Guest Outdial from the Web

When guest users join a meeting from the web, both the Meeting Information page and the meeting console display the phone number they must dial to join the audio or video components of the meeting. To simplify the attend process, set up your meetings with guest outdial, so that guest users can click Connect to have the system connect them to the audio or video components of the meeting.

**To Enable Guest Outdial from the Web**

1. **Step 1** On the New Meeting scheduling page, click the More Options icon.
2. **Step 2** Set Allow Guest Outdial to **Yes** and click Submit.
   - If the option is read only, your profile does not allow you to schedule guest outdial meetings.
3. **Step 3** To finish scheduling your meeting, click Schedule.

**Tip**

Rather than setting this option for every meeting, update it in your Meeting Preferences. For more information, see the “Updating Your Outdial Settings” section on page 98.

Recording Meetings Automatically

You can configure Cisco Unified MeetingPlace Web Conferencing to automatically record your meetings.

Note the following considerations:

- If you are recording an audio plus web meeting, the synchronized Flash recording begins when the web conference portion of the meeting starts; any audio recorded before this point is available only in the audio-only recording.
- The system does not record the video display component of meetings. It does record the audio transmitting from a video endpoint.

**To Record a Meeting Automatically**

1. **Step 1** Sign in to Cisco Unified MeetingPlace Web Conferencing.

---

**Table 17: Descriptions of Notification Options (continued)**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send if meeting changes</td>
<td>Choose Yes to have the system send notifications if the meeting is updated or rescheduled. Otherwise, choose No.</td>
</tr>
<tr>
<td>Include participant list</td>
<td>Choose Yes to include invitee names in notifications. Otherwise, choose No.</td>
</tr>
</tbody>
</table>

**Note** A list of invited *video terminals* will always show up in the notification, regardless of how this option is set.
Step 2 On the Welcome page, click Schedule Meeting.
Step 3 On the New Meeting page, fill in the meeting details.
Step 4 Click the More Options icon.
Step 5 For Automatically start recording, choose Yes. This initiates the recording after the second person enters the meeting.
Step 6 To return to the New Meeting page and finish scheduling your meeting, click Submit, then click Schedule.

Tip
As long as disk space is available, profile users can start recording at any time from the meeting console even if Automatically Start Recording is set to No.

Setting the Meeting Extension Announcement from the Meeting Scheduling Pages

Cisco Unified MeetingPlace can automatically extend your meetings according to the meeting extension option on the Cisco Unified MeetingPlace Audio Server. Turn the announcement of automatic meeting extension on or off by completing the following procedure.

To Set the Meeting Extension Announcement from the Meeting Scheduling Pages

Step 1 Sign in to Cisco Unified MeetingPlace Web Conferencing.
Step 2 On the Welcome page, click Schedule Meeting.
Step 3 On the New Meeting page, click the More Options icon.
Step 4 On the More Options page, scroll down to Meeting extension and choose Yes or No.

About the Account Basics Page

The Account Basics page displays information about your user account. Most of the information was set up by your system administrator when your account was created.

This section contains the following information:

- Updating Your Personal Information, page 92
- Changing Your Cisco Unified MeetingPlace Passwords, page 92
- Updating Your Attend Settings, page 93
- Updating Your Receiving Notifications Settings, page 94
Updating Your Personal Information

To Update Your Personal Information

Step 1  Sign in to Cisco Unified MeetingPlace Web Conferencing.
Step 2  On the Welcome page, click the Account link. The Account Basics page appears.
Step 3  Use Table 18 below to modify personal information in your account.
Step 4  When you finish updating information, click Submit.

Table 18  Descriptions of Personal Information Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>Your first name.</td>
</tr>
<tr>
<td>Last Name</td>
<td>Your last name.</td>
</tr>
<tr>
<td>User ID</td>
<td>The ID you need to enter when signing in to Cisco Unified MeetingPlace from the web. Your user ID is case sensitive and can be a combination of alphanumeric characters</td>
</tr>
<tr>
<td>Profile Number</td>
<td>The number you use to log in to Cisco Unified MeetingPlace by phone.</td>
</tr>
<tr>
<td>Change Passwords</td>
<td>Click to change your password. You can update your user ID password and your profile password.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>The time zone used to configure your scheduling and notification activities. To change it, choose a different time zone from the list.</td>
</tr>
<tr>
<td>Language</td>
<td>The language used as part of your conferencing environment. This is the language you will see as your default language when you sign in to Cisco Unified MeetingPlace Web Conferencing. To change your default language, choose a different language from the list.</td>
</tr>
<tr>
<td>Billing Code</td>
<td>The billing code used by your organization for meetings you hold on Cisco Unified MeetingPlace.</td>
</tr>
<tr>
<td>Use Abbreviated Prompts</td>
<td>Choose Yes to have Cisco Unified MeetingPlace use abbreviated prompts during your meetings. Abbreviated prompts may be convenient if you are a regular user. Otherwise, choose No.</td>
</tr>
<tr>
<td>User ID of Contact</td>
<td>If you have an assigned contact or attendant who can schedule meetings on your behalf, enter that person’s user ID here.</td>
</tr>
</tbody>
</table>

Changing Your Cisco Unified MeetingPlace Passwords

To Change Your Cisco Unified MeetingPlace Passwords

Step 1  Sign in to Cisco Unified MeetingPlace Web Conferencing.
Step 2  On the Welcome page, click the Account link.
Step 3  On the Account Basics page, click Change Password.
Step 4 On the Change Passwords page, update the applicable password:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID Password</td>
<td>Allows you to use the Cisco Unified MeetingPlace web interface. Enter your old password, new password, and new password again to confirm.</td>
</tr>
<tr>
<td>Profile Password</td>
<td>Allows you to use the Cisco Unified MeetingPlace phone interface. Enter your new password and your new password again to confirm.</td>
</tr>
</tbody>
</table>

Step 5 Click Submit.

Updating Your Attend Settings

To Update Your Attend Settings

Step 1 Sign in to Cisco Unified MeetingPlace Web Conferencing.
Step 2 On the Welcome page, click the Account link. The Account Basics page appears.
Step 3 Scroll down to the Attend Settings section.
Step 4 Use Table 19 below to modify settings.
Step 5 When you finish updating settings, click Submit.

Table 19 Descriptions of Attend Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone Number</td>
<td>Your main phone number. The system uses this number to call you at the start of meetings you have been invited to.</td>
</tr>
<tr>
<td></td>
<td>This parameter requires that your Method of Attending parameter is set to Find Me or Call Me.</td>
</tr>
<tr>
<td>Alternate Phone Number</td>
<td>An alternate number used to reach you, such as a mobile phone number. The system uses this number when it receives no answer from your main phone number.</td>
</tr>
<tr>
<td></td>
<td>This parameter requires that your Method of Attending parameter is set to Find Me.</td>
</tr>
<tr>
<td>Video Endpoint Address</td>
<td>The default address used to connect your video endpoint.</td>
</tr>
<tr>
<td></td>
<td>This setting requires previous configuration of your video endpoint.</td>
</tr>
<tr>
<td>Video Endpoint Bandwidth</td>
<td>The default bandwidth used during your Cisco Unified MeetingPlace video conferences.</td>
</tr>
<tr>
<td></td>
<td>This setting requires previous configuration of your video endpoint.</td>
</tr>
<tr>
<td>Pager Type</td>
<td>The type of pager service you use.</td>
</tr>
<tr>
<td>Pager Number</td>
<td>Your pager number. When a meeting you have been invited to is about to begin, the system uses this number to page you with the phone number and ID of the meeting.</td>
</tr>
<tr>
<td></td>
<td>This parameter requires that the Method of Attending parameter is set to Page Me.</td>
</tr>
</tbody>
</table>
Table 19  Descriptions of Attend Settings (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Method of Attending</td>
<td>Your preferred method of joining a meeting: I'll Call In, Call Me, Page Me, Can't Attend, or Find Me. If this parameter is set to Find Me, the system dials up to three different phone numbers (main, alternate and pager numbers) when trying to reach you. Specify the order in which you want the system to dial these numbers by setting the Ways to Find Me parameter.</td>
</tr>
<tr>
<td>Ways to Find Me</td>
<td>Determines the order in which the system should dial your main, alternate, and pager numbers in an attempt to reach you.</td>
</tr>
</tbody>
</table>

Updating Your Receiving Notifications Settings

To Update Your Receiving Notifications Settings

Step 1  Sign in to Cisco Unified MeetingPlace Web Conferencing.
Step 2  On the Welcome page, click the Account link.
Step 3  Scroll down to the Receiving Notifications section.
Step 4  Use Table 20 below to modify settings.
Step 5  When you finish updating settings, click Submit.

Table 20  Descriptions of Receiving Notifications Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-mail Address</td>
<td>Your e-mail address. This setting can either be your full Internet e-mail address (for example, <a href="mailto:UserName@CompanyName.com">UserName@CompanyName.com</a>) or your e-mail alias (for example, John Smith).</td>
</tr>
<tr>
<td>Internet E-mail Address</td>
<td>Your full Internet e-mail address (for example, <a href="mailto:UserName@CompanyName.com">UserName@CompanyName.com</a>).</td>
</tr>
<tr>
<td>Primary Notification</td>
<td>Your preferred method for receiving notifications: Group Default, None, or E-Mail.</td>
</tr>
<tr>
<td>Alternate Delivery Mechanism</td>
<td>Your alternate method for receiving notifications: Group Default, None, or E-Mail.</td>
</tr>
</tbody>
</table>

About the Meeting Preferences Page

The Meeting Preferences page displays the business rules that govern how your meetings are scheduled and run. Most of the information was set up by your system administrator when your account was created.

This section contains the following information:

- Updating Your General Meeting Preferences, page 95
- Updating Your Meeting Security Settings, page 96
- Updating Your MeetingNotes Settings, page 97
- Updating Your Outdial Settings, page 98
Updating Your General Meeting Preferences

To Update Your General Meeting Preferences

- **Step 1**: Sign in to Cisco Unified MeetingPlace Web Conferencing.
- **Step 2**: On the Welcome page, click the **Account** link.
- **Step 3**: On the Account Basics page, click **Meeting Preferences**.
- **Step 4**: Use **Table 21** below to modify settings.
- **Step 5**: When you finish updating settings, click **Submit**.

### Table 21  Descriptions of Meeting Preferences

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Conference Provider</td>
<td>You only see this field when your user profile allows you to select either Cisco WebEx and Cisco Unified MeetingPlace as the Web conference provider and the Cisco WebEx gateway is running.</td>
</tr>
<tr>
<td>Entry Announcement</td>
<td>Choose an option from the list. This is what users hear when a new participant enters the meeting.</td>
</tr>
<tr>
<td>Departure Announcement</td>
<td>Choose an option from the list. This is what users hear when a participant leaves the meeting.</td>
</tr>
<tr>
<td>End of Meeting Announcement</td>
<td>Choose Yes if you want the system to announce that your meeting is ending. Otherwise, choose No or Group Default.</td>
</tr>
<tr>
<td>Entry announcement in breakouts</td>
<td>Choose what users will hear when a new participant joins the meeting breakout.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Beep Only</strong>—A short beep is emitted during the meeting to indicate that someone has entered the meeting breakout.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Beep + Name</strong>—After a short beep, the recorded name of the participant is announced.</td>
</tr>
<tr>
<td></td>
<td>If you do not hear the name of a participant upon entry, the participant probably did not record a name before entering the meeting. Identify the participant before the meeting breakout begins.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Silent</strong>—There is no indication that someone has entered the meeting breakout.</td>
</tr>
<tr>
<td>Reservationless announcement</td>
<td>Choose Yes if you want the system to announce when your meeting is extended. Otherwise, choose No or Group Default.</td>
</tr>
<tr>
<td>Meeting Extension Announcements</td>
<td>Choose Yes if you want the system to announce when your meeting is extended. Otherwise, choose No or Group Default.</td>
</tr>
<tr>
<td>Screened Entry</td>
<td>Choose Yes if you want to be able to screen users who enter your meetings. Screened entry requires the system to contact you before allowing a user to enter.</td>
</tr>
<tr>
<td></td>
<td>Otherwise, choose No or Group Default.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> You will not be able to allow entry of screened users if you join the meeting with a video endpoint.</td>
</tr>
</tbody>
</table>
About the Meeting Preferences Page

Welcome to Cisco Unified MeetingPlace Web Conferencing

Table 21 Descriptions of Meeting Preferences (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Skip Meeting-Entry Options</td>
<td>Choose Yes to skip all meeting and entry announcement options. Otherwise, choose No or Group Default.</td>
</tr>
<tr>
<td>Disable Roll Call</td>
<td>Choose Yes to disable the roll call feature. This prevents users from getting a list of other participants in the meeting. Otherwise, choose No or Group Default.</td>
</tr>
<tr>
<td>Default Meeting Category</td>
<td>Choose the default category for your meeting. This is usually chosen by your system administrator as Group Default.</td>
</tr>
</tbody>
</table>

Updating Your Meeting Security Settings

To Update Your Meeting Security Settings

Step 1 Sign in to Cisco Unified MeetingPlace Web Conferencing.
Step 2 On the Welcome page, click the Account link.
Step 3 On the Account Basics page, click Meeting Preferences.
Step 4 Scroll down to the Meeting Security section.
Step 5 Use Table 22 below to modify settings.
Step 6 When you finish updating settings, click Submit.

Table 22 Descriptions of Meeting Security Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow external web participants</td>
<td>Choose Yes to schedule your meetings on an external web server. This makes your meetings accessible to users attending over the Internet (outside the private corporate network). Choose No to schedule your meetings on an internal web server. This makes your meetings accessible only to users from inside the private corporate network. Note: This parameter is displayed only if your Cisco Unified MeetingPlace deployment is configured with an external site. If your deployment has only an internal site, this parameter is hidden from the New Meeting scheduling page.</td>
</tr>
<tr>
<td>Allow 3rd Party Initiator</td>
<td>Allows a 3rd party to initiate a meeting</td>
</tr>
<tr>
<td>Password Required</td>
<td>Choose Yes to require a password for all of your meetings. If you choose Yes, you will have to enter a password when you schedule meetings. Otherwise, choose No or Group Default.</td>
</tr>
</tbody>
</table>
**About the Meeting Preferences Page**

**Table 22  Descriptions of Meeting Security Settings (continued)**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publicly Listed Meeting</td>
<td>Choose Yes to have your meetings displayed on the Find Meetings page when users search for public meetings. Choose No to have your meetings displayed only to meeting invitees.</td>
</tr>
</tbody>
</table>
| Who Can Attend Meeting     | To determine who can attend your meetings, choose an option from the list:  
  - Anyone—This meeting is unrestricted. Both profile users and guest users can attend.  
  - MeetingPlace Profile Users—All components of this meeting (audio, web, and video) are restricted to profile users who sign in by using their Cisco Unified MeetingPlace user ID and password. Users attending over a video endpoint must sign in to the web conference first, then connect to the video conference by using the Connect button.  
  - Invited Profile Users—All components of this meeting (audio, web, and video) are restricted to profile users who were invited to attend. All invited profile users must sign in by using their Cisco Unified MeetingPlace user ID and password. Users attending over a video endpoint must sign in to the web conference first, then connect to the video conference by using the Connect button.  

**Updating Your MeetingNotes Settings**

**To Update Your MeetingNotes Settings**

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Sign in to Cisco Unified MeetingPlace Web Conferencing.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>On the Welcome page, click the <strong>Account</strong> link.</td>
</tr>
<tr>
<td>Step 3</td>
<td>On the Account Basics page, click <strong>Meeting Preferences</strong>.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Scroll down to the MeetingNotes section.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Use <strong>Table 23</strong> below to modify settings.</td>
</tr>
<tr>
<td>Step 6</td>
<td>When you finish updating settings, click <strong>Submit</strong>.</td>
</tr>
</tbody>
</table>

**Table 23  Descriptions of MeetingNotes Settings**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reserve resources for recording</td>
<td>Choose Yes to automatically reserve recording space for your meeting. This does not automatically record your meeting. Otherwise, choose No or Group Default.</td>
</tr>
<tr>
<td>Auto-start Recording</td>
<td>Choose Yes to automatically have the system record your meetings. You can choose to manually stop recording from the meeting console. Otherwise, choose No or Group Default.</td>
</tr>
</tbody>
</table>
### About the Meeting Preferences Page

To update your outdial settings:

1. Sign in to Cisco Unified MeetingPlace Web Conferencing.
2. On the Welcome page, click the **Account** link.
3. On the Account Basics page, click **Meeting Preferences**.
4. Scroll down to the Outdial Settings section.
5. Use **Table 24** below to modify settings.
6. When you finish updating settings, click **Submit**.

#### Table 24 Descriptions of Outdial Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ask for Profile Password</td>
<td>Choose Yes to have the system prompt users for their profile password when outdialing. Otherwise, choose No or Group Default.</td>
</tr>
<tr>
<td>Allow Guest Outdial</td>
<td>Choose Yes to allow guest users to use the outdial feature. Otherwise, choose No or Group Default. If this parameter is read only, your profile does not have permission to allow guest outdial.</td>
</tr>
</tbody>
</table>
### Updating Your Notification Options

**To Update Your Notification Options**

1. Sign in to Cisco Unified MeetingPlace Web Conferencing.
2. On the Welcome page, click the **Account** link.
3. On the Account Basics page, click **Meeting Preferences**.
4. Scroll down to the Notification Options section.
5. Use Table 23 below to modify settings.
6. When you finish updating settings, click **Submit**.

### Table 25 Description of Notification Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send for This Meeting</td>
<td>Choose Yes to have the system send invitees notifications for your meetings.</td>
</tr>
<tr>
<td></td>
<td>Otherwise, choose No or Group Default.</td>
</tr>
<tr>
<td>Include Attachments</td>
<td>Choose Yes to have the system include attachments with your notifications.</td>
</tr>
<tr>
<td></td>
<td>Otherwise, choose No or Group Default.</td>
</tr>
<tr>
<td>Notification Priority</td>
<td>To indicate the importance of meeting notifications, choose from the list.</td>
</tr>
<tr>
<td>Send if Meeting Changes</td>
<td>Choose Yes to have the system send your invitees updated notifications if information for your meetings changes.</td>
</tr>
<tr>
<td></td>
<td>Otherwise, choose No or Group Default.</td>
</tr>
<tr>
<td>Include Participant List</td>
<td>Choose Yes to include the list of participants with your meeting notifications.</td>
</tr>
<tr>
<td></td>
<td>Otherwise, choose No or Group Default.</td>
</tr>
<tr>
<td>Include Meeting Password</td>
<td>Choose Yes to include the meeting password with your notifications.</td>
</tr>
<tr>
<td></td>
<td>Otherwise, choose No or Group Default.</td>
</tr>
</tbody>
</table>

### Meeting Troubleshooting Tips

This section contains the following information:

- Meeting Access Issues, page 99
- Problems Running a Meeting, page 100
- Content Issues, page 101

### Meeting Access Issues

First, check the following items to help resolve meeting access issues:

- Are you connected to the Internet?
- Are you accessing the correct URL?
Meeting Troubleshooting Tips

- Have you registered for the event or seminar?
- Did you change your password recently?

Then, try the following actions:
- Try accessing the meeting as a registered user or guest.
- Disable popup blocker software.
- Clear the your web browser cache.
- Try connecting from another computer.

**Problem** I don’t have a username or password to get into a meeting.

**Solution** Contact your administrator to request a user ID or password. Some meetings allow guest logins; other meetings may allow guests, but only with the approval of the host/moderator, which may take a few minutes.

**Problem** My password does not work.

**Solution** Contact your account administrator to verify access for the account.

**Problem** I have logged in, and nothing is happening.

**Solution** When you log in as a guest you may need approval. An approval message will be presented to the host. If the request is declined, entrance to the meeting is not possible and a message stating that the request was declined is displayed. Contact the meeting presenter or organizer if you should have access.

### Problems Running a Meeting

**Problem** I am supposed to be a presenter, but I logged in as a participant.

**Solution** If you are logged in as a guest, exit the meeting and log in as a profile user. If you are designated as a presenter for the meeting, you may need to log in with your user profile account to receive the proper permissions. If after logging in as a profile user you still do not have presenter permissions, contact the meeting moderator or the Cisco Unified MeetingPlace administrator.

**Problem** Participants are not seeing my actions.

**Solution** Check the participant list to make sure that you are a presenter. Presenters are listed with a presenter icon (person in front of a presentation board) at the beginning of each name. Also make sure you are not in Preparing mode, because actions are not visible to participants in this mode. Send a message to the host asking for presenter status or try logging in as a registered user.

Be aware that participant requests may not be seen by the presenter. Moderator and presenters should pay attention to the status and menu bars, and choose to accept sign-in requests.

**Problem** I cannot share my screen.

**Solution** You must download the Cisco Unified Presenter Add-in to have this ability. Be sure to click Install when prompted to download the Cisco Unified Presenter Add-in.

**Problem** Participants cannot see the application I am sharing.

**Solution** The shared application must be visible on your screen at all times. If an unshared application is open and covering the shared application on the screen of the sharing presenter, meeting participants will not see portions of the shared application covered by the unshared application but will instead see a blue-checkered pattern.
Content Issues

**Problem**  Content is not appearing in the meeting.

**Solution**  You may not have uploaded the content into the meeting room. In the center of the Share tool, click Documents. Click either Select from Attachments or Select from My Computer. Browse to the file that you want to display in the room, click the file, and press Enter.

**Problem**  Unable to show content such as Word documents and Excel spreadsheets, or web pages.

**Solution**  Confirm that you are a host or presenter and have the Cisco Unified Presenter Add-in installed. Presenters must share their screen in order to show this type of content.

To share web pages, use the Web Links tool, which will allow all participants to launch the web page in a separate browser window.
### GLOSSARY

**A**

**annotate**
Adding text or graphics to a document or presentation in a real-time, interactive manner. This feature is available in Cisco Unified MeetingPlace Web Conferencing subject to permissions.

**attachment**
Additional information that’s associated with a meeting. Users with the appropriate permissions may associate information with a meeting anytime before, during, or after the meeting.

**attendant**
A class of user. Attendants are profile users who have permanent permissions to schedule meetings for all users in their organization. Unless invited with a different permission, attendants have Moderator permissions for all meetings by default. *See also help desk*

**audience**
A user with the Audience permissions, the lowest data permissions level. Audiences may view shared content, whiteboards, and notes, download files shared in the File Share tool, and answer polls within the meeting. They cannot share content, annotate on a whiteboard, upload files via the File Share tool, or modify notes.

**Audio Server**
*See Cisco Unified MeetingPlace Audio Server.*

**authentication**
The process of checking a user’s identification information with a directory to confirm the user’s identity.

**B**

**bandwidth**
The information-carrying capacity of a communications channel measured in bits-per-second for digital systems or in megaHertz (MHz) for analog systems.

**blast outdial**
An automated outdial to all meeting participants at the time of the meeting. Users can schedule meetings to enable blast outdial. *See also outdial.*

**breakout session**
An opportunity for two or more meeting participants to communicate privately outside of the main meeting. Cisco Unified MeetingPlace currently supports nine simultaneous audio only breakout sessions.

**C**

**chat**
Real-time text messaging communication between two or more users by computer. Chat is available as part of the meeting room.

**Cisco Unified MeetingPlace**
An integrated rich-media conferencing solution that allows users in different locations to communicate and share information.
Cisco Unified MeetingPlace Audio Server

The Cisco audio bridge used to provide the audio portion of a meeting to interactive participants.

Cisco Unified MeetingPlace site

All the servers, regardless of number or type, at one physical location.

Cisco Unified MeetingPlace Video Integration

An optional integration application that integrates video as part of the meeting experience.

Cisco Unified MeetingPlace Web Conferencing

An optional application that allows users to schedule conferences, present or share documents and applications, or review recorded meetings from a web browser, such as Microsoft Internet Explorer or Mozilla Firefox.

class-of-service privileges

User permissions, such as scheduling, outdialing, and recording, that depend on the participant’s user class. See also user class.

Click-to-Attend (CTA)

A customized hyperlink in the body of meeting notifications that connects users directly to their meeting. The Click-to-Attend is based on the IP address of the web conferencing server hosting the meeting.

client software

Application software that requests services from other software to complete its tasks. Typically, software on one computer that interacts with software on another computer.

cluster

A group of servers that perform the same function and conceptually operate as a single unit. Load balancing is used among the members of a cluster to optimize the performance of the system.

CODEC

COder-DECoder. A device that encodes or decodes a signal and used typically for converting analog to digital or compressing digital information into more efficient formats. In IP, codec refers to any technology for compressing and decompressing data.

collaborate

The act of allowing other meeting participants to remotely control the shared application.

Collaborative meeting template

A meeting template used to create an open forum-style meeting where all participants have presenter permissions by default. The meeting room layout for collaborative meetings includes tools for sharing and collaborating.

conference organizer

The owner of a meeting. A conference organizer has the Moderator permissions for the duration of the meeting. (This permissions level is irrevocable for the duration of the meeting.) See also moderator.

continuous meeting

A type of meeting that is always in session and available to participants. Resources are reserved 24 hours a day, 7 days a week.

D

domain name

The portion of a symbolic name that corresponds to the network number in the IP address. In the symbolic name name@mycompany.com, the domain name is mycompany.com.
Glossary

E

encryption A security process for reducing the potential for unauthorized usage. Typically used for data transmitted over a public network. The original data, or plain data, is converted into a coded equivalent called ciphered data by an encryption algorithm. The cipher data is decoded (decrypted) at the receiving end and then reverted to plain data.

entry/departure announcement A name or sound that announces the arrival or departure of a meeting participant.

Ethernet A LAN that connects devices like computers, printers, and terminals. Ethernet operates over twisted-pair or coaxial cable at speeds at 10 or 100 Mbps.

external site A group of servers that are outside the corporate firewall. See also site.

external user A user who accesses a meeting from outside the private corporate network.

F

firewall A hardware and software tool that separates the internal corporate network from the external Internet.

G

group See user group.

groupware Software applications that facilitate shared work over long distances on documents and information. Groupware supports e-mail and calendaring. Examples of groupware are Microsoft Outlook and Lotus Notes.

guard time The amount of time before a meeting begins during which users may begin attending the meeting. The admin setting for guard times ensure that meetings are not scheduled back to back or overlapping with the same meeting ID.

guest profile A user profile that includes default permissions that define what a guest is allowed to do.

guest user A user who has no information stored in the system and uses a default set of permissions based on the guest profile.

H

help desk The location that users can access during a meeting should they need assistance. See also attendant, zero out.

host The web conference participant who is supplying the source application that is being shared or shown to other meeting participants.
HTML

HyperText Markup Language. The authoring language used to create hypertext documents for the World Wide Web. Like the Standard Generalized Markup Language (SGML), on which it is based, HTML identifies the types of information in a document rather than the exact way it is to be presented. The presentation is left to the software that converts the contents to a suitable format for viewing.

HTTP

HyperText Transfer Protocol. The application protocol for moving hypertext files across the Internet. This protocol requires an HTTP client program on one end of a connection and an HTTP server program on the other.

Hypertext Markup Language

See HTML.

Hypertext Transfer Protocol

See HTTP.

I

immediate meeting

A meeting that starts as soon as it is scheduled.

in-session meeting features

Features that can be accessed only during a meeting.

integration application

An application that connects the core application components of Cisco Unified MeetingPlace to existing applications. Microsoft Outlook, Lotus Notes, Directory Services, H.323/SIP, and Instant Messaging are examples of applications for which a gateway exists.

internal user

A user accessing a meeting from inside the private corporate network.

intranet

A private network that uses Internet software and standards. An intranet is based on TCP/IP protocols belonging to an organization (usually a corporation), and accessible only by the organization’s members, employees, or others with authorization. An intranet’s web sites look and act just like any other web sites, but the intranet is surrounded by a firewall that protects it from unauthorized access.

invitee

Someone who is invited to a Cisco Unified MeetingPlace meeting.

IP address

An address that uniquely identifies each host on a network or Internet.

J

Java

An object-oriented programming language developed by Sun Microsystems, Inc. used to create applets (small applications) that can be distributed over the World Wide Web. Java programs run inside a Java-enabled web browser; otherwise they run inside a Java Virtual Machine (JVM).

JavaScript

A programming language used to effect changes in web pages. JavaScript reduces the need for access back to the web server.
### Glossary

**LAN**
Local Area Network. A digital network that operates in a limited geographical area, usually a single company location or campus. Communication within a LAN is not usually subjected to external regulations.

**latency**
The time between initiating a request for data and the beginning of the actual data transfer. Network latency is the delay introduced when a packet is momentarily stored, analyzed, and then forwarded.

**layout**
The arrangement of tool windows in a meeting. Layouts can contain multiple tools of different types and/or multiple instances of the same tool. Meeting moderators can define multiple layouts for a meeting, and move between them by using the Layouts menu or the layout toolbar below the stage.

**listener**
A user with the Listener permissions, the lowest audio permissions level. Listeners may not speak during meetings.

**load balancing**
Distributing performance among two or more servers to maximize performance, throughput, and availability.

**Local Area Network** *See LAN.*

**locked meeting**
A meeting in a state of restricted access; users or guests who wish to join the meeting must wait for the approval of the moderator to enter the meeting room.

**logging**
The process of saving information about application activities.

### M

**MCU**
Multipoint Conferencing Unit. (Also *Multipoint Control Unit.*) A bridging or switching device that supports video conferencing.

**meeting console**
The web interface used to control a Cisco Unified MeetingPlace meeting.

**meeting frequency**
The interval of time over which a recurring meeting repeats. *See also* recurring meeting.

**meeting ID**
A unique number that identifies specific meetings. *See also* vanity ID.

**Meeting Details page**
A web page that provides information about a particular meeting, such as the date, start time, and meeting type. The Meeting Details page also contains links to attachments associated with the meeting.

**meeting message**
A prerecorded message that is presented to users when they enter a meeting.

**meeting password**
A string of numbers that are required before a user may enter a meeting. A meeting password is necessary only for a meeting scheduled to require one. Meeting passwords add a level of security to meetings.

**meeting preferences**
Default settings for the optional parameters that determine meeting behavior. Each user profile has default meeting preferences associated with it. Users can override their default meeting preferences for individual meetings.

**meeting room**
A virtual environment in which a meeting is held. *See also* meeting console.
MeetingTime  A Windows-based software application that allows select users to access advanced Cisco Unified MeetingPlace functions and system administration tools.

moderator  A user with the Moderator permissions. Moderator permissions are a temporary set of permissions available in session that allow the moderator to control the meeting. For example, moderators may eject users from a meeting and change participant permissions. Moderators may also promote and demote other participants to moderator status.

MP3  MPEG-1 Audio layer-3. A standard technology and format for compressing a sound sequence into a very small file while preserving the original level of sound quality when played. See also WAV, WMA.

MPV  The native format for recording audio during a Cisco Unified MeetingPlace meeting. MPV files can be converted into WAV files and other common formats, such as RealAudio, WMA, and MP3, for playback. See also MP3, WMA.

Multipoint Conferencing Unit See MCU.

multiserver meeting  A type of meeting that allows users in different locations to dial into their local Cisco Unified MeetingPlace servers. This allows the corporation to reduce network costs, as only the servers are making the WAN connections.

multi-site system  A Cisco Unified MeetingPlace system with servers in multiple physical locations.

mute/unmute  An in-session feature that allows participants who are not speaking to mute their phone lines. Muting prevents outside noise from disturbing the meeting. Users must unmute their lines to be heard again.

N

notification  A message that notifies conference organizers and invitees of details about a meeting.

O

option key  An alphanumeric string used to activate optional features within the product.

outdial  A feature that enables the system to initiate an audio connection with a person currently not in the meeting.

P

participant  A user who is in a Cisco Unified MeetingPlace meeting.

permissions  A set of business logic that enables increased meeting control and structure by limiting certain Cisco Unified MeetingPlace features to specific user access groups.

platform  The hardware on which the software runs.
poll

A Cisco Unified MeetingPlace Web Conferencing feature that enables users with the Moderator or Presenter permissions to create multiple choice or multiple-answer questions to gather ideas, opinions, and other feedback from meeting participants. See also moderator, presenter.

port

The connection between Cisco Unified MeetingPlace Audio Server hardware and the telephone and/or IP network.

port group

A configuration parameter used to define signaling information for multiple ports simultaneously.

Preparing mode

Allows a moderator to navigate between meeting room layouts without affecting the views of meeting participants. This makes it possible to edit or prepare meeting layouts while another participant is presenting. See also layout.

presentation

A web conferencing mode. Microsoft PowerPoint files (.ppt) are attached to the meeting, either before or during the meeting, and shared by a presenter during the web conference.

Presentation meeting template

A meeting template used to create a meeting where one or more participants present to an audience of one or more participants.

presenter

A user with the Presenter permissions, a web permission level that allows users a specific set of functions within the meeting room. Presenters can share presentations and applications, access and modify slides, and modify polls. Presenters also have access to the Presenter Only Area. See also Presenter Only Area.

Presenter Only Area

An “offstage” area of the meeting console screen where moderators and presenters can place tools so that audience members can not see them. Only other moderators or presenters can see tools placed in this area. Presenters can use these tools to privately exchange notes, text messages, and so on, or to prepare new content before making it available for viewing. Any tool in a meeting can be placed in the Presenter Only Area. See also stage.

private meeting

A meeting scheduled with restrictions, which prevent it from being publicly accessible. To attend or search for a private meeting, users must know its meeting ID.

profile

A collection of information that uniquely identifies a Cisco Unified MeetingPlace user. It contains such information as the user's ID, permissions, and preferences for setting up meetings.

profile number

A number, up to 17 digits, used to identify users over the telephone. Profile numbers have corresponding numeric passwords (profile passwords) that are independent of the alphanumeric passwords associated with the user ID for web access.

profile user

A user with a Cisco Unified MeetingPlace account. User profiles are created by a system manager. During profile creation, a user can receive different levels of service for billing and security considerations. See also guest user, user class, user group.

proxy server

A server that acts as a surrogate for another server. Proxies are used typically to prevent the client application from knowing the exact name or address of the server.

public meeting

A meeting that is scheduled without access restrictions. Public meetings are searchable and accessible from the Find Meetings page. Any user with access to Cisco Unified MeetingPlace Web Conferencing can search for and attend a public meeting. See also private meeting.
**R**

**recording**
An optional in-session feature that enables participants to capture the audio and/or web components of a meeting for streamed playback at a later time.

**recurring meeting**
A series of regularly scheduled meetings.

**reservationless meeting**
A special case of the immediate meeting. Each profile user is assigned a unique ID, which is the same for all reservationless meetings.

**Reserve All Ports meeting**
A special administrative meeting that books all audio resources and prevents others from booking audio resources during that time. Useful for blocking out time for upgrades or maintenance of the Cisco Unified MeetingPlace Audio Server.

**rich-media conferencing**
The ability to meet simultaneously with one or more participants over a range of interfaces, such as PSTN telephone, IP telephone, web, instant messenger, video.

**roll call**
A Cisco Unified MeetingPlace Audio Server in-session feature that enables participants to hear a list of other participants currently in the meeting.

**Roster-only meeting template**
A meeting template used to create a meeting with only a participant list and audio and video controls. This is essentially an audio-only meeting, using the web-based meeting room to provide visual controls for the audio discussion.

**run time**
The actual duration of a meeting.

---

**S**

**scheduler**
Any user who is scheduling or has scheduled a meeting.

**Secure sockets layer**
See SSL.

**session**
Information associated with a client that is connected to a server.

**session profile**
Information stored as a set of attributes and describing objects.

**site**
A logical collection of Cisco Unified MeetingPlace servers that represent a complete system, typically identified by geography.

**site contact**
Customer personnel with sufficient information to support the Cisco Unified MeetingPlace installation who is allowed to contact Cisco for support.

**speaker**
A user with the Speaker audio permissions. Speakers may listen and speak during a meeting. See also listener.

**SSL**
Secure Socket Layer. A protocol developed by Netscape for transmitting private documents through the Internet. SSL uses a public key to encrypt data that's transferred over the SSL connection.

**stage**
The area of the screen that participants see in a meeting. See also Presenter Only Area.

**standalone system**
One or more Cisco Unified MeetingPlace servers (of any type) that are connected to provide a complete multi-media solution.
system
One or more Cisco Unified MeetingPlace servers (of any type) that are connected.

system manager
A user class. The system manager is usually the person in an organization responsible for setting up and maintaining Cisco Unified MeetingPlace. System managers have access to all the information in the Cisco Unified MeetingPlace database, including system configuration information and information about the user community. Unless invited with a different permission, system managers have Moderator permissions for all meetings by default.

TCP/IP
Transmission Control Protocol/Internet Protocol. An open network standard that defines how devices from different manufacturers communicate with each other over interconnected networks. TCP/IP protocols are the foundation of the Internet.

time zone
The temporal equivalent of a geographical location in terms of Greenwich Mean Time (GMT). In Cisco Unified MeetingPlace each profile has a time zone setting, which should be set to reflect the office location where the user regularly does business.

touch-tone interface
Any prompts or actions related to the telephone.

Transmission Control Protocol/Internet Protocol
See TCP/IP.

UL
Software licenses that allow users to access a particular feature or function.

user
A person interacting with the Cisco Unified MeetingPlace system.

user class
The level of system-related permissions available to a user.

user group
A group of profile users with common attributes. By defining user groups, system managers reduce the time required to set up and maintain individual user profiles.

user ID
A unique alphanumeric string of up to 17 characters given to all profile users. MeetingTime references users by their user IDs in all its screens and reports.

user license
See UL.

vanity ID
A custom meeting ID, containing any combination of text and numbers, that users enter when they schedule meetings. See also meeting ID.

video terminal
A video endpoint with a Cisco Unified MeetingPlace profile that can be reserved for specific meeting times, for example, a conference room video system.
### Virtual Private Network
*See VPN.*

### Voice over Internet protocol
*See VoIP.*

### voice prompts
Audio prompts over the telephone requesting touch-tone or spoken input from users.

### VoIP
Voice over Internet Protocol. A set of facilities for managing the delivery of voice information using IP. Voice information is sent in digital form in discrete packets over the Internet instead of in analog form over PSTN. A major advantage of VoIP is that it avoids the tolls charged by ordinary telephone service.

### VPN
Virtual Private Network. A restricted network that uses public wires to connect nodes. A VPN encapsulates, or “tunnels,” private data cheaply, reliably, and securely through a public network, usually the Internet.

## W

### waiting room
A virtual “room” where participants wait for the meeting to begin. In reservationless meetings, all participants are placed into a waiting room until the meeting organizer logs in to begin the meeting.

### WAN
Wide Area Network. A data network typically extending a LAN outside a building or beyond a campus, over IXC or LEC lines to link to other LANs at remote sites. Typically created by using bridges or routers to connect geographically separated LANs.

### WAV
Wave file format. A digitized audio file format for Microsoft Windows that stores sounds as waveforms. A Wave file uses the .wav filename extension.

### WebConnect
An optional application that allows multiple Cisco Unified MeetingPlace web servers to share the load for a single address. With WebConnect, scheduling information is rolled on to other sites in a user’s rollover map in the case of site unavailability.

### Webinar meeting template
A meeting template used to create a lecture-style meeting where one participant is the moderator, there are one or more presenters, and the remainder of the participants are audience members. The audience is muted by default in this type of meeting.

### Web Link
A meeting console tool that provides the ability to distribute a web page to all participants in a web conference.

### whiteboard
A web conferencing mode. A blank page that can be used for spontaneous interactive collaboration.

### Wide Area Network
*See WAN.*

### Windows Media Audio
*See WMA.*

### WMA
Windows Media Audio file format. Audio compression technology from Microsoft. A Windows Media Audio file uses the .wma filename extension. *See also* MP3, WAV.
Z

zero out The ability for audio users who need assistance to press #0 on their touch-tone telephones to access the help desk.